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Harga Rp. 4.800,- (Pulau Jawa), Rp. 5.300,- (Luar Jawa)
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PCplus
TABLOID KOMPUTER

EDITORIAL ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

SOFTWARE DAN
PROGRAM ULANG TAHUN

Terus terang saja, sebagai
pengajar bidang komputer saya
membutuhkan referensi
software-software yang
beredar, baik dari lokal maupun
dari luar. Oleh karena itu, saya
mengusulkan, bagaimana kalau
PCplus mengulas berbagai
software untuk seluruh
kalangan, dengan pembagian
kebutuhan, seperti membahas
singkat software untuk desain
Web, di mana bisa dibeli, situs
apa yang bisa dihubungi,
berapa harganya, cocoknya
untuk kalangan apa, apa
kelebihan dan kekurangannya,
dapat dibeli di mana saja, dan
lain sebagainya. Maklum,
mencari dan membeli software
original tidaklah semudah
membeli dan mencari software
bajakan.

Berikutnya, PCplus punya
hajatan apalagi untuk
menyambut ultahmu? Kalau
bisa acaranya sedikit heboh,
dengan beragam hadiah yang
wah, seperti bagi-bagi software

original gitu. Terus, sekadar
usulan (tapi wajib), bagaimana
plusSoftware-nya dijadikan
artikel bundelan dalam bentuk
CD, sehingga kita bisa
memanfaatkannya tanpa harus
bersatu dengan kumpulan artikel
lainnya. Dan agar lebih maksimal,
sisipkan juga gambar latihan
sesuai dengan gambar yang
dijadikan contoh pada artikel
plusSoftware.

Terakhir, untuk hajatan
tahun depan, acara apalagi yang
akan dibuat setelah acara
Workshop Merakit PC sukses
total? Saya usulkan acaranya
lebih memfokuskan pada
pensosialisasian program Linux,
sehingga PCplus dapat
membuktikan bahwa
mempelajari Linux sama
mudahnya merakit PC, yang
pada awalnya masih dianggap
sulit namun pada prakteknya
mudah.

R. Agung Dwi Haryuna
greathar@plasa.com

Red: Usulannya boleh juga Mas

Agung. Untuk ultah, kita punya
banyak program. Apa saja
programnya? Simak saja PCplus!
Bundel CD yang tematis untuk saat
ini belum bisa kami realisasikan,
Mas. Workshop PCplus kini juga
sudah mulai masuk ke seputar Linux.
Bahkan, dalam rangka ulang tahun
PCplus yang ke-3, kita menggelar
workshop Linux di 3 kota. Tentu
saja, kota-kota lain juga bakal
menyusul.

SULIT MENDAPATKAN
BUKU

Salam Mas Redaksi. Kenalin,
saya Gorcen dari Jakarta. Saya
tertarik dan berminat pada buku
"Langkah Mudah Merakit PC"
yang sering ditawarkan di tabloid
ini kepada mereka yang ingin
merakit PCnya. Tapi Mas, saya
susah sekali mendapatkannya.
Bisakah saya mendapatkan
informasi tempat di mana saya
dapat membelinya? Saya sudah
ke mall-mall tapi tidak
mendapatkannya. Mohon
dibantu ya Mas, makasih atas
bantuannya.

Gorcen
gorcen_2@yahoo.com

Red: Gorcen, coba cari buku
tersebut di Toko Buku Gramedia
terdekat dari tempat tinggal Anda.
Kalau masih kesulitan juga, silakan
hubungi sirkulasi@e-pcplus.com
atau
langganan@infokomputer.com.
Kami melayani penjualan
langsung, tentu saja biayanya
ditambah ongkos kirim ke alamat
Anda.

KOMUNITAS LINUX DAN
SOURCE CODE VIRUS

Bravo PC+ semoga sukses
selalu, kita langsung saja ke
pokok permasalahan.

1. Saya ingin menanyakan
tentang komunitas Linux,
sebab saya tertarik sekali
tentang Linux dan rencananya
saya ingin beralih ke Linux.
Tetapi saya tidak dapat
menemukan software
instalannya. Rencananya, saya
mau pakai Linux
Mandrex (kalo nggak salah).
Pertanyaannya, di situs mana
saya dapat menemukan
komunitas Linux tersebut.

2. Saya ada tugas dari kampus
tentang Turbo Assembler,
bagian saya disuruh membuat
virus serta serumnya. Ada
yang dapat membantu saya
tidak? Kalau ada tolong kirim
source code-nya ke e-mail
saya.

3. Buat produsen-produsen
elektronik terutama
komputer, tolong dong
adakan pameran di daerah
saya. Saya tinggal di daerah
Palembang. Jika bisa buat
juga seminar tentang segala

jenis software. Mudah-
mudahan peminatnya banyak.

Terima kasih buat PC+ serta
teman-teman yang mau
membantu saya. Salam kenal
buat semuanya!

Ferdian
mobiledian@plasa.com

Red: Cobalah berkunjung ke
www.linux.or.id. Yang bener Linux
Mandrake, bukan Mandrex. Buat
pembaca yang lain, ada yang bisa
membantu kawan Ferdian? Tentang
pameran komputer, adakah
produsen atau organizer pameran
yang mau merespon?

HARGA MICROSOFT DAN
DETEKSI KEASLIAN

Dear PCplus. Menanggapi &
mengomentari pertanyaan
saudara Tjeng Yusup, saya pernah
juga mengalami kasus serupa.
Selain saya kesulitan
mendapatkan price list-nya,
setelah saya membelipun saya
kesulitan juga untuk mengecek
keaslian produk, karena bukti
yang didapat adalah sertifikat –di
mana tetap ada kemungkinan
aspal (produk beragam dari user
biasa sampai corporate). Mohon
bantuan PCplus donk, bagaimana
caranya saya bisa memverifikasi
keaslian produk-produk saya?
Atas bantuannya, saya ucapkan
terima kasih. Sukses selalu untuk
PCplus.

Eko Ariawan
ekoariawan@hotmail.com

Red: Suara Anda kami muat di sini
mewakili beberapa e-mail lain dari
pembaca yang mengungkapkan
keluhan senada. Halo Microsoft,
bagaimana menjawab pertanyaan
para pembaca PCplus? Produkmu
memang sudah termasyhur, tapi
produkmu yang asli ternyata belum
banyak orang tahu. Beri dong
pedoman singkatnya biar semua
orang tahu!

HAPUSKAN PLUSPONSEL
Halo PCplus! Langsung aja

ya. Saya adalah pembaca setia
kamu. Saya cuma mau
menyarankan, alangkah lebih
baik apabila rubrik plusPONSEL
diganti dengan rubrik
plusGAME (game-game PC
teranyar saat ini). Karena saya
juga sudah sering membaca
surat pembaca lain untuk
meniadakan rubrik plusPonsel.
Segitu saja saran saya kali ini.
Semoga PCplus makin maju!
Sukses!

Yudo Batara
yudobatara@hotmail.com

Red: Ya ya ya, kami akan upayakan
untuk mengurangi halaman
plusPonsel, Bung Yudo. Thanks atas
saran Anda.

PEMROGRAMAN PASCAL
Langsung saja. Saya adalah

penggemar barumu. Saya punya
usul, gimana kalo PCplus
menampilkan rubrik baru yang
isinya mengenai bahasa
pemrograman Turbo Pascal.
Mungkin bagi sebagian orang
Pascal dianggap sebagai
compiler yang udah kuno.
Mungkin yang kini sedang
gencar dipelajari adalah Visual
Basic (VB) Namun, betapapun
kunonya Pascal ini, saya ingin
sekali mempelajarinya. Dan
yang lebih penting, di kota saya
sulit sekali untuk mendapatkan
buku tentang Pascal. Jadi, saya
mohon kesediaan PCplus untuk
sekiranya dapat menerbitkan
rubrik Pascal. Yah, paling tidak
source code program yang
dibuat dari kompiler Pascal, jadi
tidak perlu dari yang dasar
sekali. Sebelumnya saya
ucapkan terima kasih yang
sebesar-besarnya apabila e-mail
saya ini bisa dimuat di PCplus.
Thanks.

Erlina Made Wulandari
li_na_chayank@yahoo.com

Red: Maaf sekali Mbak Erlina,
untuk saat ini permintaan tersebut
sulit kami realisasikan. Tetapi bila
Anda membutuhkan informasi
lebih banyak tentang
pemrograman Pascal, Anda bisa
menghubungi yahya@e-
pcplus.com.

CD LINUX RED HAT
Salam kenal. Saya mau usul

nich, kan PC+ sedang hangat-
hangatnya membahas masalah
Linux. Gimana kalo PC+
membundel CD Linux Red Hat
yang sedang dibahas tersebut
bersama Tabloid PCplus. Karena
kalo hanya membaca saja tetapi
tidak langsung
memraktekkannya sama aja
bohong, apalagi di daerah saya
di Palembang susah sekali
mendapatkan software Linux
tersebut.

Jadi saya mohon PCplus
bersedia membundel 3 CD Red
Hat tersebut bersama Tabloid
PCplus. Gitu aja dech usulan
saya, atas perhatiannya saya
ucapkan terima kasih. Jaya
selalu PCplus.

Hamdi Azis
Palembang

hamdiazis@hotmail.com

Red: Kami sedang menyiapkan
programnya dan mengurus segala
sesuatunya. Mudah-mudahan di
hari ulang tahun PCplus,
permintaan Anda sudah bisa
terealisasikan. Catatan dari kami,
CD tersebut kemungkinan besar
tidak disatukan dengan PCplus
karena kesulitan teknis, tetapi akan
disebarluaskan melalui workshop-
workshop.

Internet Sebagai Medium
Internet memang bukan lagi semata-mata merupakan alat atau

fungsi. Pada dirinya ada pesona, keindahan, juga hidup itu sendiri. Ada
yang menggantungkan hidup dari sana. Ada yang mencari hidup di sana.
Tapi ada pula yang menemukan hidup di sana. Itu sudah terbukti pada
salah satu kru Redaksi PCplus, Muhammad Firman.

Banyak orang bilang cinta susah ditemukan di Internet, chatting itu
bullshit dan obrolan kepalsuan, dan segala macam konotasi buruk
lainnya. Tapi tidak bagi Firman. Memang, kisah dan perjalanan cinta
Firman melalui dunia maya juga tidak terlalu linear selayaknya orang yang
menemukan jodoh melalui Internet: ngobrol sana-sini, jatuh hati, kopi
darat, makin jatuh hati, lalu menikah. Firman dan pasangannya, Duis

Haryani, menempuh jalan yang
sedikit kombinatif, karena mereka
berdua bertemu secara tidak
langsung atau dari chatting,
melainkan dari teman chatting
Firman, yang tak lain adalah teman
akrab Duis.

Ringkas cerita, mereka berdua
pun saling jatuh hati. Tentu saja
kami masih ingat bagaimana
Firman bersusah payah untuk
ngapel dan setor muka ke Bandung
(di mana Duis kuliah) sehabis
deadline di PCplus atau pas Jumat
malam, atau pas Firman sedang
bertugas ke Bandung. Mereka pun

kemudian memutuskan untuk menikah. Kami semua di PCplus
merayakannya dalam sebuah pesta pernikahan di Tasikmalaya, 7
September lalu.

Internet juga kian luas fungsinya. Di plusFokus kali ini, Anda bisa
mendapati bagaimana melalui jaringan Internet sebuah kamera bisa
difungsikan untuk berbagai macam keperluan, mulai dari sekadar
chatting biasa yang juga pernah diulas di PCplus, sampai untuk keperluan
mengawasi pengasuhan anak atau untuk keperluan security. Di rubrik
tersebut, kami tonjolkan pernak-pernik software dan jenis-jenis
sambungan yang bisa kita gunakan untuk keperluan-keperluan tersebut.

Pendek dan singkat kata, selamat menikmati sajian kami. Buat
Firman dan Duis, selamat juga menikmati sajian masing-masing, selamat
menikmati hidup baru yang tak lagi maya!

Salam hangat dari Palmerah
Redaksi

ALEX/PCplus
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Akses Informasi via SMS 3690. Hanya berkirim SMS ke nomor 3690, para
pengguna seluler dapat mengakses informasi dengan cepat, mudah, dan terhubung langsung dengan
tempat dan orang yang dikehendaki. Layanan informasi ini merupakan hasil kerja sama PT Infomedia
Nusantara dengan provider seluler IM3 dan Satelindo.

Dengan biaya Rp 1.000,- per SMS, para pengguna seluler kartu Mentari, Matrix, dan Indosat M3 bisa
mendapat beragam informasi mulai dari hotel, restoran, rumah sakit sampai perusahaan. Bahkan juga
informasi alamat keluarga dan rekan bisnis. Layanan info via SMS 3690 telah terjangkau di 18 kota besar di
Indonesia meliputi wilayah Jabotabek, Depok, Surabaya, Gresik, Sidoarjo, Medan, Bandung, Semarang,
Denpasar, Yogyakarta, Batam, Padang, Palembang, Bukit Tinggi, dan Makasar. (raa)

PT. IBM Indonesia-Universitas Bina Nusantara
Luncurkan Program EXITE. Program yang merupakan kepanjangan dari
EXploring Interest in Technology and Engineering ini dilatarbelakangi oleh kurangnya profesional wanita
di bidang engineering dan teknologi. Program yang digelar pada tanggal tanggal 8-11 September ini
diikuti oleh para pelajar putri dari SMUN 1,  SMUN 8, SMUN 68, SMUN 70 dan SMUN 78 Jakarta.
Tujuannya adalah untuk menumbuhkan minat para remaja putri untuk meniti karier di kedua bidang
tersebut. Peserta program harus memenuhi kriteria dasar pemilihan, yaitu siswi kelas satu SMU yang
memiliki keterampilan dasar komputer dan bahasa Inggris serta berminat tinggi pada matematika, iptek,
dan teknologi. Program ini dilanjutkan dengan program bimbingan selama satu tahun (e-Mentoring)

yang akan dilakukan secara sukarela oleh para karyawan IBM melalui korespondensi dengan e-mail atau
fasilitas instant messaging (MentorPlace). Aktivitas yang akan dilakukan dalam program tersebut antara
lain adalah membongkar pasang komputer, membangun situs-situs Web, membuat es krim dengan liquid
nitrogen dan menyiapkan presentasi Web. (raa)

Hacker New York Times Bersedia Menyerahkan Diri.
Seorang hacker berusia 22 tahun yang telah sering membobol jaringan perusahaan-perusahaan besar
mengatakan bahwa ia bersedia menyerahkan diri pada pihak kepolisian federal atas tindak kejahatan
komputer yang telah dilakukannya, termasuk kejahatan menyusup ke jaringan The New York Times
setahun yang lalu. Adrian Lamo tidak menyatakan letak keberadaannya pada saat melakukan
wawancara dengan Reuters, Sabtu, 6 September lalu.  Tetapi ia berjanji akan bersiap meyerahkan diri ke
kantor kepolisian federal di Sacramento, California, daerah yang dekat dengan tempat tinggal orang
tuanya. Lamo mengaku pernah menyusup ke situsYahoo, Google, dan beberapa perusahaan lain. (raa)

Google Rayakan Ulang Tahunnya yang Kelima. Salah satu
situs pencarian terbesar di dunia, Google, merayakan ulang tahunnya yang kelima. Kini Google telah
diakses oleh jutaan orang dengan 80 bahasa yang berbeda setiap harinya. Search engine ini lahir pada
tanggal 7 September 1998 di Menlo Park, California. Pada awalnya Google hanya memiliki empat
karyawan dan sistem search-nya hanya menangani 10.000 pertanyaan per harinya. Sekarang Google
menangani hampir 200 juta pertanyaan setiap harinya dan telah berkembang sangat fantastis. (raa)

Asia Netcom, Provider Layanan
IPL bagi Time dotcom. Ini merupakan kerja
sama perusahaan tersebut dengan Time dotcom untuk menyediakan
koneksi jaringan berkapasitas tinggi bagi para end user di Malaysia.
Asia Netcom terpilih sebagai salah satu provider penting bagi
International Private Line (IPL) Time dotcom. Layanan Private Line
yang diberikan oleh Asia Netcom berdasarkan pada jaringan antar
kota yang menyediakan koneksi door-to-door yang sama baik
seperti koneksi POP (Point of Present) yang fleksibel. (raa)

Demontrasi Parhelia dan
Millenium P750.  Demo Parhelia dan Millennium
P750  tersebut berlangsung pada acara Comex 2003, pameran
komputer dan IT terbesar di Singapura. Acara yang digelar pada
tanggal 4-7 September ini memamerkan Parhelia versi AEC-VIZ(v2.6)
dengan desain handal bagi para profesional. Versi ini menawarkan
kemampuan multi display, pembuatan catatan untuk model 3D dan
navigasi model 3D yang kompleks.  Semua kelebihan tersebut
disediakan oleh kartu grafis Matrox untuk menunjang kerja para
pengguna Autodesk“AutoCAD“. (raa)

CA Raih Peringkat Pertama
Pendapatan Software
Perusahaan. Perusahaan dengan nama lengkap Com-
puter Associates International ini mengumumkan bahwa laporan
IDC telah menempatkan di tempat pertama dalam pasar peranti
lunak pengelola sistem dan storage untuk perusahaan di dunia.
Menurut laporan tersebut, CA mengungguli perusahaan lainnya
dalam pendapatan dan pangsa pasar. Laporan yang berjudul
“Worldwide Enterprise System and Storage Management Software
Forecast and Analysis Summary, 2003-2007” menyebutkan bahwa
Linux dan Windows yang menjadi perhatian CA selama ini
merupakan platform utama untuk pertumbuhan pasar. Kali ini CA
berhasil mengungguli perusahaan kompetitornya, termasuk IBM,
EMC, Veritas, Hewlett-Packard, dan BMC. Menurut Hee Keen Keong,
Technology Strategist CA, perusahaannya berkomitmen untuk
menyediakan software yang dapat meningkatkan efisiensi dan
mengurangi biaya perusahaan. CA akan terus berinovasi dan
memberi kualitas pengelolaan on-demand computing yang berjalan
di atas Linux atau platform populer lainnya. (raa)

BSA Dukung Penerapan UU Hak
Cipta. Salah satu bentuk dukungan dari Business Software
Alliance (BSA) terhadap implementasi UU Hak Cipta baru, yaitu UU
No. 19/2002 adalah mengadakan program pendidikan bagi para
pengguna dengan tujuan komersial untuk membantu mereka
memahami UU tersebut. UU ini menyatakan bahwa penggunaan
software bajakan dan tanpa lisensi dalam operasi bisnis merupakan
suatu tidak pidana dengan ancaman hukuman denda hingga Rp 500
juta dan/atau penjara paling lama 5 tahun. Dirjen Hak Kekayaan
Intelektual, Departemen Kehakiman dan HAM serta pihak POLRI
bertanggungjawab atas pelaksanaan UU tersebut. (raa)

Acer Luncurkan Produk Baru.
Peluncuran dilakukan pada tanggal 2 dan 3 September lalu,
bertempat di Sol Elite Marbella. Dalam kesempatan itu, Acer
memerkenalkan produk Aspire terbarunya yang diberi nama RC500
dan RC900. RC500 dan RC900 ini bukan hanya sekadar PC standar
yang menggunakan prosesor terbaru, tetapi dilengkapi juga dengan
mode hiburan. Seseorang bisa menggunakan mode hiburan ini
layaknya menggunakan peralatan audio video rumahan biasa,
tanpa harus bisa mengoperasikan PC. Terdapat 5 mode hiburan
yang bisa dipilih yaitu Video, TV, Music, FM radio, dan Picture.
Untuk memudahkan penggunaan mode hiburan, RC500 dan RC900
ini dilengkapi juga dengan super dial dan remote control.
Perbedaan utama antara RC500 dan RC900 terletak pada ukuran
fisiknya, di mana RC500 memiliki ukuran yang lebih tipis. (cgs)
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Gamer Indonesia Akan Berpartisipasi di World Cyber
Game 2003. Keinginan para gamer Indonesia untuk melebarkan sayapnya di dunia internasional
terkabul. Olimpiade game internasional, World Cyber Game 2003 International yang akan diadakan di
Korea Selatan dan melibatkan hingga 55 negara bisa diikuti para gamer Indonesia. Syaratnya,
memenangkan babak penyisihan atau ‘Preliminary’ di negaranya masing-masing.

Indonesian Gamer, badan yang mengayomi komunitas gamer Indonesia ditunjuk kembali oleh
Samsung Electronics Indonesia untuk menyelenggarakan World Cyber Game Indonesian Preliminary.
Majalah CHIP dan LEVEL tetap terlibat sebagai penyelenggara, sedangkan Intel Indonesia, ASUS Astrindo,
dan Corsair Memory menjadi co-sponsornya.

Game-game yang dipertandingkan mencakup game populer. Untuk kategori baru yaitu console, game
Halo dari X-Box yang akan dipertandingkan. Indonesia sendiri rencananya akan mengirimkan wakilnya da-
lam tiga pertandingan game PC, yaitu Half Life: Counter Strike, Starcraft: Brood War, dan Warcraft 3.
Babak penyisihan di Indonesia yang diikuti oleh 2000 orang ini telah berlangsung di Jakarta, Bandung, Jog-
jakarta, Bali, Medan, Solo dan Surabaya. Pemenang grandfinal WCG Indonesia Preliminary yang diadakan
tanggal 2-7 September mendatang akan mengikuti WCG 2003 di Korea Selatan bulan Oktober nanti. (raa)

Pengamanan Proaktif Untuk Hindari Malware. Virus SoBig.F
telah menyebabkan banyak perusahaan menghentikan operasinya lantaran terganggunya jaringan dan
komputer-komputer mereka. SoBig.F ini menyerang bak seorang penyusup yang mencari celah untuk
masuk ke rumah orang lain. Walau serangannya telah mereda, masih banyak jenis virus dan worm lain yang
menunggu kesempatan buat menyerang.

SoBig menggunakan taktik ‘social engineering’ yang secara acak memilih satu alamat e-mail di
komputer yang telah terinfeksi dan kemudian mengirimkan pesan melalui alamat tersebut, yang biasanya
telah dikenal oleh si penerima. Banyaknya pilihan software pencegahan bisa membingungkan banyak
perusahaan, mana yang terbaik untuk melindungi komputer mereka. Menurut Computer Associates
International Inc., proses pengamanan yang terbaik bagi perusahaan harus melibatkan individu, kebijakan,
dan teknologi. Teknologi antivirus memang bertujuan untuk menghentikan worm yang ada, namun
teknologi secanggih apapun dapat kalah jika tidak ada pemahaman dari para penggunanya. (raa)

Ericsson Adakan Roadshow Mobile Internet.  Acara yang
digelar pada tanggal 2-5 September lalu di beberapa universitas di Indonesia, khususnya pulau Jawa ini
merupakan kelanjutan kegiatan Ericsson dalam proses pendidikan dan sosialisasi di bidang Internet
bergerak (Mobile Internet). Ponsel sebagai alat komunikasi bicara kini telah berkembang fungsinya
sebagai media pengiriman pesan berupa SMS, gambar, ringtone, dan foto, bahkan untuk browsing
Internet yang termasuk dalam layanan Multimedia Messaging Service (MMS). Melihat hal ini, operator
pun mulai meningkatkan jasa layanan mereka dengan menawarkan berbagai keunikan masing-masing
sedangkan para pengembang lokal terus mengembangkan kreativitasnya untuk menciptakan aplikasi
menarik bagi dunia Mobile Internet. (raa)

SAP Indonesia Umumkan Kerja
Samanya dengan IBM Indonesia
dan IMC Consulting Company. Kerja
sama ini untuk mengimplementasi myFOODSolution berbasis
mySAP All-in-One sebagai solusi bisnis bagi Belfoods Indonesia.
myFOODSolution merupakan solusi yang khusus dikembangkan
untuk industri makanan dan minuman dan telah mencakup proses
bisnis yang dirancang secara spesifik bagi perusahaan di Indonesia.

PT Belfoods Indonesia selaku produsen dan distributor
makanan yang besar membutuhkan sebuah solusi ERP (Enterprise
Resource Planning) untuk mendukung perkembangan bisnisnya.
myFOODSolution berbasis mySAP All-in-One yang ditawarkan oleh
IMC Consulting Alliance menjanjikan kemudahan aplikasi, open
platform dengan sistem terbuka berstandar industri dan
dilengkapi dengan tenaga ahli berpengalaman. Sedang IBM
menawarkan solusi perangkat keras IBM eServer p615 dan p630
serta produk storage IBM FasT600 dan LTO 3580 untuk
menjalankan aplikasi myFOODSolution. Melalui myFOODSolution,
PT Belfoods Indonesia berharap dapat meningkatkan
penjualannya, mempersingkat proses order-to-cash, meningkatkan
akurasi perencanaan dan proses pemesanan sekaligus menurunkan
biaya operasionalnya. (raa)
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Keping
Memori Utama

Cakrawala Gintings
cakra@e-pcplus.com

K

Memori utama, sesuai
namanya adalah
memori dengan

kedudukan penting
pada PC. Tanpa

memori utama, PC
akan menolak untuk
bekerja. Kinerja dari
memori utama juga

sangat mempengaruhi
kinerja dari sistem

secara keseluruhan. Ti-
dak jarang suatu sis-
tem yang dilengkapi

dengan prosesor yang
cepat menghasilkan ki-
nerja tidak seperti yang

diharapkan karena
terhambat oleh kinerja

dari memori utama
yang digunakan.

inerja memori
utama, selain
dipengaruhi oleh diri-
nya sendiri, juga dipe-

ngaruhi oleh memory controller
yang digunakan. Spesifikasi yang
paling umum ditampilkan dari
sebuah keping memori utama
adalah kapasitasnya dan
kecepatannya. Dari sisi kecepatan
yang paling umum ditampilkan
adalah frekuensi kerjanya dan
CAS latency yang dimiliki.

Chip DRAM
Sebuah keping memori

utama terbentuk dari beberapa

chip DRAM. Chip DRAM ini
tersusun dengan rapi pada PCB
(printed circuit board) yang
digunakan. Jumlah chip DRAM
yang digunakan juga bervariasi.
Karena tersusun dari beberapa
chip DRAM, tentunya kapasitas
dan kinerja dari keping memori
utama ini sangat dipengaruhi
oleh chip DRAM tersebut.

Seperti yang pernah PCplus
bahas sebelumnya, suatu chip
DRAM memiliki kedalaman dan
lebar data. Kedalaman dan lebar
data ini akan mempengaruhi
kapasitas dari suatu chip DRAM.
Kapasitas dari suatu keping
memori utama jelas dipengaruhi
oleh kapasitas dan jumlah dari
chip DRAM yang digunakannya.
Kapasitas dari suatu chip DRAM
adalah hasil kali dari kedalaman
dan lebar data yang dimilikinya.
Kapasitas dari suatu keping
memori utama adalah jumlah
kapasitas dari chip DRAM yang
digunakannya.

Saat ini memori utama
yang bisa dikatakan
mendominasi adalah DDR-

SDRAM yang Non-ECC dan
Unbuffered. Memori utama
tersebut, hingga saat ini,
memiliki lebar data sebesar 64
bit. Dengan lebar data yang
sebesar 64 bit, komposisi chip
DRAM yang digunakan juga
harus menghasilkan lebar data
sebesar 64 bit ini.

Dari pengamatan PCplus
terhadap keping memori utama
yang pernah PCplus
gunakan,

banyaknya chip DRAM yang
umum digunakan pada sebuah
keping memori utama adalah 8
dan 16.  Belakangan, untuk
memori utama jenis SDR-SDRAM,

PCplus pernah menemukan
keping yang hanya
menggunakan 4 chip DRAM.
Tentunya jumlah chip DRAM
yang sebanyak 4, 8, ataupun 16
ini harus menghasilkan lebar data
total sebesar 64 bit.

Berdasarkan rumusan
tersebut, untuk keping
yang

menggunakan 16 chip DRAM
yang sama, setiap chip DRAM
tersebut akan memiliki lebar data
sebesar 4 bit. Sementara untuk
yang 8 chip DRAM yang sama,

Suatu keping memori utama tersusun dari beberapa chip DRAM

masing-masing chip DRAM terse-
but akan memiliki lebar data
sebesar 8 bit. Untuk kapasitas
keping memori utama yang sama
(misalnya sama-sama 256MB),
keping yang memiliki 8
chip DRAM

yang
sama akan memiliki

kedalaman data yang sama
dengan keping yang memiliki 16
chip DRAM yang sama. Karena
lebar data yang berbeda,
kapasitas dari chip DRAM
tersebut akan berbeda pula,
256Mb dengan 128Mb pada
contoh 256MB di atas. Suatu
keping memori utama juga
sering dinyatakan dengan
kedalaman dan lebar datanya,
seperti halnya chip DRAM. PC+
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Begitu kita
mendengar kata

Internet, maka yang
kita bayangkan

adalah suatu
komunitas terbuka

yang penuh dengan
banyak hiburan dan
informasi yang bisa
kita nikmati kapan

saja dan di mana saja.
Hanya berbekal

sebuah PC, modem
dan jaringan telepon

serta account di ISP
(Internet Service Pro-

vider, penyedia
layanan Internet), kita
sudah bisa menikmati

jagad maya.

nternet
menyediakan
berbagai macam
hiburan dan informasi

yang luas. Tetapi di balik semua
itu, banyak ancaman yang
mungkin menganggu kita untuk
bisa mengecap kenikmatan
menjelajahi dunia cyber yang
sangat inovatif tersebut. Hal ini
bisa dilihat dari jumlah
kerusakan yang ditimbulkan
oleh virus, pembobolan situs,
pemalsuan data, pencurian
kartu kredit dan lain-lain.

BERBAGAI GANGGUAN DI
INTERNET

Masalah keamanan
merupakan masalah yang

Keamanan
di Jagad Maya

Willy Sudiarto Raharjo
willy@e-jogja.net

I

sangat banyak diperbincangkan
di berbagai tempat, karena
kasus keamanan ini
berhubungan dengan informasi-
informasi yang sangat sensitif.
Sementara, beberapa pihak
menginginkan privasinya bisa
terjamin ketika menjelajahi dunia
cyber yang penuh dengan
ancaman-ancaman yang bisa
menganggu mereka setiap
waktu.

Saat ini sudah banyak
macam virus yang setiap waktu
selalu berkembang, baik itu
dalam cara penyebarannya,
maupun dari tingkat kerusakan
yang ditimbulkan. Luasnya
platform yang dapat diinfeksi,
dan mudahnya membuat
sebuah virus dengan sebuah tool
yang sudah mulai tersebar luas
turut membantu pengembangan
virus.

Selain virus, masih ada
gangguan lainnya, misalnya
worm, trojan, spamming,
sniffing, cracking, hacking, dan
masih banyak lagi. Sebagai
tambahan saja, tahun 2001
dinobatkan sebagai tahun
dengan populasi virus paling
banyak, mengingat jumlah virus
yang beredar meningkat cukup
drastis dibandingkan dengan
tahun-tahun sebelumnya. Kita
ambil contoh dua virus yang
menggemparkan dunia saat itu,
yaitu CodeRed dan Sircam.
Kerugian yang sudah ditimbulkan
dari penyebaran kedua virus itu
sudah cukup besar, belum
ditambah dengan virus-virus lain
yang beredar juga pada tahun
yang sama.

BERBAGAI CARA
MENGATASINYA

Mengingat banyaknya kasus
yang muncul berhubungan
dengan keamanan di Internet,
maka muncullah beberapa
perusahaan yang memfokuskan
diri pada masalah keamanan,
misalnya perusahaan pembuat
antivirus, sertifikat digital,
enkripsi, firewall, dan lain-lain.

Dengan semakin banyaknya
produk-produk yang membanjiri
pasaran, maka dapat dilihat
bahwa semakin banyak orang
yang mengkhawatirkan
keamanan di Internet yang
sangat rawan ini. Juga, semakin
banyak orang yang peduli
terhadap masalah keamanan di
Internet dengan berusaha
membantu mereka dengan
produk-produk yang mereka
kembangkan.

Untuk menjamin transfer
data yang aman di Internet,
maka banyak perusahaan yang
menggunakan standar enkripsi
128-bit yang diyakini dapat

mengurangi kemungkinan
data dapat dibaca oleh
orang yang tidak berhak
untuk membacanya.
Tetapi dengan semakin
berkembangnya teknologi
enkripsi, bukan hal yang
mustahil semakin canggih
pula teknologi untuk
menembusnya. Saat ini
ada beberapa macam tipe
enkripsi, tetapi yang lazim
digunakan adalah dengan
Single Key atau Public
Private Key.

Enkripsi bukanlah
satu-satunya solusi terbaik
untuk mengatasi masalah
keamanan di Internet,
karena masih ada
alternatif lain yang
kiranya bermanfaat untuk
meningkatkan
kenyamanan untuk
berselancar di dunia cyber.
Contoh nyata adalah
firewall, SSL untuk layanan
e-commerce, sertifikat
digital dari pihak ketiga,
misalnya RSA, Verisign,
sampai pada proses
otentikasi yang rumit,

sehingga hanya memungkinkan
para pengguna yang sah yang
bisa mengakses data tersebut.
Semua teknologi tersebut saling
melengkapi, karena tidak ada
produk yang sempurna di
dunia ini.

FIREWALL
Salah satu contoh alternatif

yang dapat meningkatkan
keamanan di Internet adalah
penggunaan firewall. Software
ini berada di antara komputer
dengan jaringan Internet,
sehingga ia bisa memblok adanya
serangan terhadap komputer
yang berada di balik
firewall tersebut. Selain
itu dapat memblok
usaha untuk
mengirimkan data
keluar komputer tanpa
seijin pemilik komputer.
Firewall terbagi menjadi
2 kategori, yaitu hard-
ware dan software.

Untuk firewall yang
berjenis hardware,
biasanya sudah
terintegrasi pada
hardware yang
bersangkutan, misalnya
router, proxy server, atau
pada server yang
bertugas sebagai
gateway untuk bisa
mengakses Internet.
Jenis ini biasanya dipakai
untuk golongan
korporat yang membutuhkan
keamanan tingkat tinggi untuk
menjamin amannya data.

Firewall berjenis software
lebih digunakan untuk
kebutuhan personal, karena
harganya yang lebih terjangkau
dan lebih mudah
pengoperasiannya. Walaupun
tidak secanggih firewall hard-
ware, tapi firewall berjenis
software sudah mencukupi
karena kualitas pengamanannya
tidak kalah dengan firewall
berjenis hardware. Banyak dari
perusahaan antivirus terkemuka
juga membuat firewall jenis
software untuk mendukung
keamanan para pemakainya di
Internet. Contoh dari perangkat
lunak firewall yang cukup
terkenal adalah ZoneAlarm dari
Zonelabs (www.zonelabs.com)
atau Norton Personal Firewall
dari Symantec
(www.symantec.com).

CELAH KEAMANAN
Para pembuat software pun

juga berusaha untuk membuat
software mereka sesempurna
mungkin. Tetapi mungkin karena
terburu-buru melemparnya ke
pasar, maka sering software yang
mereka keluarkan masih
mengandung cacat (bug). Cacat
ini akan diperbaiki pada versi

berikutnya atau produsen akan
mengeluarkan sebuah
perbaikan (patch). Tentunya
tidak akan ada software yang
benar-benar sempurna, tetapi
bisa meminimalkan celah yang
bisa ditimbulkan oleh adanya
cacat tersebut.

Software yang sampai
sekarang ini sering dieksploitasi
kelemahannya adalah produk-
produk dari Microsoft, yang
notabene memegang pangsa
pasar terbesar di dalam dunia
Internet. Untuk menghindari
pengeksploitasian produk-
produk Micorosft, maka
belakangan ini Microsoft mulai

memperkenalkan sistem
keamanannya, yaitu “Get
Secure and Stay Secure” yang
bisa diakses lewat
www.microsoft.com/secu-
rity. Fasilitas ini juga
menyediakan link ke halaman
yang menyediakan bantuan
kepada para pengguna Win-
dows 2000 untuk bisa
mengamankan sistem, karena
Window s2000 juga bisa
berfungsi sebagai server yang
menangani banyak informasi-
informasi penting. Hal ini
tentunya sangat berbahaya bila
sampai dicuri atau dirusak oleh
para cracker.

Dengan semakin
berkembangnya teknologi,
akankah tindakan ilegal, seperti
cracking, defacing, hacking,
dapat dicegah, bahkan
dihilangkan sama sekali? Hal itu
semua hanya bisa dijawab oleh
diri kita masing-masing, karena
manusia yang membuat dan
manusia pula yang merusak.
Komputer dan segala teknologi
yang sudah kita nikmati saat ini
merupakan produk hasil
pemikiran manusia dan
manusia pula yang
menciptakan teknik-teknik
untuk melakukan tindakan
ilegal di Internet. PC+

Firewall mampu mengurangi
kemungkinan jebolnya PC dari
gangguan yang berasal dari
Internet.

Celah-celah keamanan pada software dapat dimanfaatkan oleh para hacker
iseng untuk merusak sistem atau mencuri informasi.

Hati-hati dalam menerima e-mail
dengan attachment yang menggoda,
yang pengirimnya tidak dikenal. Isinya
bisa ditunggangi oleh virus Trojan
atau worm.
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Lebih Lanjut
Mengenai Babylon

Y.J. Thurana
thurana@e-pcplus.com

B

“Harga yang hampir
mencapai limaratus
ribu itu (US$ 49,95)
terasa terlalu berat

untuk ukuran
kantong pengguna

komputer awam
seperti saya. Saya

sudah mulai
menabung untuk

membayar lisensinya,
tetapi sepertinya

tidak akan terkumpul
dalam waktu dekat.

Sementara itu tool ini
dirasa sangat berguna

untuk kegiatan saya
dalam berkomputer.
Jadi dengan rendah

hati saya ingin
“menagih” janji Bung

untuk memberikan
cara “sedikit

memperpanjang”
penggunaan

shareware ini.”

egitu kira-
kira bunyi salah
satu e-mail yang
mampir di inbox saya

sehubungan dengan pemuatan
artikel mengenai Babylon dua
minggu yang lalu. Banyaknya
tanggapan yang masuk
membuktikan bahwa ini adalah
memang salah satu tool yang
paling berguna untuk komputer
Anda. Itu juga yang mendorong
dibuatnya artikel ini sebagai
kelanjutan dari yang lalu.

PENGATURAN DASAR
Setelah menginstal program

(dan kamus-kamus)-nya,
menggunakan Babylon semudah
meng-klik mouse. Anda harus
menentukan sendiri bagaimana
cara kerja Babylon yang Anda
inginkan. Biasanya hal ini
dilakukan pada saat proses
instalasi. Jika belum, lakukan
lewat klik kanan pada ikon
Babylon di System Tray dan
pada jendela yang muncul pilih
menu Configuration.
(Gambar 1)

Banyak hal yang bisa
dilakukan dari jendela Configu-

ration ini. Semua bisa diakses dari
6 tab yang tersedia. Mereka
adalah:

• General (Gambar 2):
mengatur apakah Babylon
dijalankan saat Windows start,
ukuran jendela Babylon setiap kali
muncul, dan apa yang harus

dilakukan jika mouse berpindah
ke program lain. Tombol Kecil
Advanced (Gambar 3) mengatur
mengenai OCR (Optical Charac-
ter Recognition) yaitu
kemampuan membaca karakter
dari file image. Dengan
kemampuan ini Anda bisa dengan
mudah mencari arti dari suatu

kata yang ada pada sebuah
gambar. Tetapi boleh dikatakan
bahwa kemampuan ini masih jauh
dari sempurna.

• Find (Gambar 4): menyangkut
masalah bagaimana cara kerja
pencariannya, mulai dari
kombinasi keyboard dan mouse
yang digunakan, target bahasa,
dan hasil pencarian. Jangan lupa
untuk memberi tanda pada kotak
“Show ‘Save-it’ buttons”
karena tombol ini akan berguna

untuk menyimpan hasil pencarian
kita.

• Appearance (Gambar 5):
mengatur tampilan huruf dan
bahasa. Gunakan tombol Change

untuk mengubah huruf sesuai
dengan yang Anda inginkan.

• Connection (Gambar 6):
membahas masalah tipe koneksi
seperti apa yang Anda miliki.
Untuk mereka yang tidak men-
download kamus, pengaturan ini
sangatlah penting karena
pencarian data yang dilakukan

hanya dari Internet. Disini juga
diatur mengenai pengaktifan
update secara online, dan apakah
Anda menginginkannya terjadi
secara otomatis.

• Voice (Gambar 7): untuk
mengaktifkan kemampuan
Babylon untuk “menyuarakan”
kata yang dipilih. Syaratnya,
komputer Anda harus memiliki
Direct Speech Engine untuk bisa

membuat Babylon berbicara. Jika
belum ada, Anda bisa
mendapatkannya di situs Babylon
atau Microsoft, atau mencari di
situs download.

• Licenses (Gambar 8):
menunjukkan informasi mengenai
status Babylon Anda. Apakah trial
atau sudah memiliki license, juga

tipe license yang seperti apa yang
Anda miliki. Di sini juga tempat
memasukkan kode rahasia yang
Anda dapatkan
setelah membelinya
untuk mengaktifkan
program ini.

MENYIMPAN
HASIL
PENCARIAN

Pertama kali
menggunakan
program ini saya
merasa sedikit
terintimidasi.
Masalahnya, saya
tidak bisa memblok
kata atau kalimat
hasil pencarian saya.
Setiap kali saya klik
dan drag pada
jendela Babylon yang
terbuka, yang terjadi
malahan jendela
tersebut berpindah
sesuai dengan arah
mouse.

Ternyata bukan
seperti itu caranya. Di
sebelah setiap hasil
pencarian ada dua
ikon kecil. Satu
berbentuk speaker,
yang jika Anda klik
akan membuat
Babylon
menyuarakan bagaimanakah kata
tersebut dibunyikan. Sayangnya
fasilitas ini hanya bekerja dengan
baik dengan kata-kata dalam
bahasa Inggris. Bahasa lain akan
terdengar “lucu”. Syarat untuk

mengaktifkan fasilitas ini sudah
dibahas di atas dan tentu saja
komputer Anda harus memiliki
kemampuan untuk
mengeluarkan bunyi.

Satu ikon lagi berbentuk
seperti pin (Gambar 9), paku
untuk menempelkan pesan di
papan styrofoam. Jika kita klik,
ikon paku itu berubah arah dan
hasil pencarian tersebut akan
disimpan, dan dengan mengklik
ikon di bagian atas Babylon yang
bernama Saved berwarna biru,
hasil penyimpanan tersebut akan
ditampilkan. Dari sini kita bisa
menggunakan data tersebut
(Gambar 10).

Gunakan ikon Save untuk
menyimpan hasil pencarian
tersebut. Ada tiga format
penyimpanan yang disediakan:
*.bps (format penyimpanan
Babylon), *.html (sebagai
halaman Web), dan *.txt

(sebagai teks murni).
Keuntungan penyimpanan
dalam format *.bps adalah kita
dapat membukanya lagi nanti
dalam Babylon dengan
menggunakan ikon Open. PC+Gambar 1

Gambar 2

Gambar 3

Gambar 4 Gambar 7

Gambar 5

Gambar 6

Gambar 8

Gambar 9

Gambar 10
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F.X. Bambang Irawan
fbi@e-pcplus.com Histeris dengan

Ringtone Liga Inggris
Blowing Bubbles
(West Ham Utd)

MOTOROLA
f2.g3f3e3#d1g2f3#a0.#a2.
*5c3#a3a3#a1g2f0

NOKIA
d=8,o=5,b=180:4f.,g,f,e,2d#,4g,f,
1a#.,4a#.,c6,a#,a,2a#,4g,1f

SAMSUNG
4 0**** 5**** 4**** 3**** 2 ^ * 5
4**** 6 ^ ** 0* 6 ^  0****
18**** 6 ^ **** 6****
6 ^ * 5 4**

SIEMENS
4 88 500 4 3 28888 (^) 500 (v) 400
68888 88 (^) 60000 1 ^ 00 (v) 6 v (^)
6 (v) 68888 (^) 500 (v) 48888

SONYERICSSON
4 58 4 3 299## 58 48 6999## 688##
180 6000## 6 699## 58 499

ALCATEL
4* 088 588 488 388 28# 5 488
68888# 08 6# 088 1*88 6**88# 688
68# 5 48888

PANASONIC
444 0 * 555 * 444 * 33 * 2222 ****
555 444 * 6666 ***0 6666 0 * 1 *
6666 * > 666 * > 6666 **** 555 444
***

PHILIPS
5 (v3) 2 (^1) 2 (v1) 2 (v1) 6 (v1) # 4
(^3) 2 (v1) 8 (^2) # 5 # 2 (^2) 2 (v2)
# 2 6 # 4 (v1) 8 (v1)

Blue is The Color
(ChelseaFC)

MOTOROLA
a1a2.g3f2c1.#a2#a2#a2.a3g1.
r2g1g2.f3e2c1c2*5c2*5d2#a2
*5c2a1.f2*5d1*5d1*5d1*5c2#a2
*5c1*5f1f1r2g2a1c1#a2#a2a
2g2f0r0

NOKIA
4a,a.,16g,f,4c.,a#,a#,a#.,16a,4g.,p,
4g,g.,16f,e,4c,c,c6,d6,a#,c6,4a.,f,
4d6,4d6,4d6,c6,a#,4c6,4f6,4f,
p,g,4a,4c,a#,a#,a,g,2f,2p

SAMSUNG
6* 6 0**** 5**** 4 1* 0* 6 ^  6 ^  6
^  0**** 6**** 5* 0* 0 5* 5 0****
4**** 3 1* 1 18 28 6 ^  18 6* 0* 4
28* 28* 28* 18 6 ^  18* 48* 4* 0 5
6* 1* 6 ^  6 ^  6 5 4** 0**

SIEMENS
6 8888 600 500 488 188 600 (^) 6 6
600 (v) 58888 * 5 500 400 388 188
100 1 ^ 2 6 v (^) 1 ^ (v) 6 v 88 400 2
^ 88 2 2 100 6 v (^) 1 ^ 88 (v) 4 4 v *
500 688 1 600 (^) 6 6 (v) 5 48888
*88

SONYERICSSON
69 68 58 49 19 68## 6## 6## 68 599
*8 59 58 48 39 19 18 10 2 6000##
10 69000 48 290 2 2 18 6000##
190 4 4000 *8 5 69 1 68## 6## 6 5
499 *

ALCATEL
6* 6 088 5888 4 1 088 6# 6# 6# 088
6888 5 088 0 5 5 088 4888 3 1 1 1* 2
6**# 1* 6** 088 4 2* 2 2 1 6**# 1*
4 4** 0 5 6 1 6# 6# 6 5 48 08

PANASONIC
666 > 666 0 * 555 ** 444 111 0 *
6666 > 6666 > 6666 0 * 666 ** 555 0
555 > 555 0 * 444 ** 33 111 > 111 >
1 2 6666 1 666 0 * 444 2 > 2 > 2 1
6666 1 4 > 444 0 555 666 111 6666 >
6666 > 666 555 444 **** 0 ****

PHILIPS
4 (v1) 5 1 (v1) 4 (v1) 5 (v3) 4 (^5) # 4
# 5 # 1 5 (v1) 9 4 5 1 (v1) 4 (v1) 4
(v2) 4 4 (^7) 4 (^1) 4 (v3) # 4 (^2) 5
(v2) 4 (v2) 4 (^5) 4 4 4 (v1) 4 (v2) # 4
(^2) 4 (^3) 4 (v7) 9 4 (^1) 4 (^1) 4
(v5) 4 (^5) # 4 # 4 4 (v1) 6 (v1) 9

Fog on theTyne
(Newcastle Utd)

MOTOROLA
g3g3g3b2b3*5d2*5e2*5e2*5d1b
3b3b3a2a3a2b2r1r2g3g3g3b2b3
*5d2*5e2*5e2*5d1b3b3b3a2a3
a2g2r1r2

NOKIA
g,g,g,4b,b,4d6,4e6,4e6,2d6,b,b,b,
4a,a,4a,4b,2p,4p,g,g,g,4b,b,
4d6,4e6,4e6,2d6,b,b,b,4a,a,4a,
4g,2p,4p

SAMSUNG
5**** 5**** 5**** 7 7**** 28 38
38 28* 7**** 7**** 7**** 6 6****
6 7 0* 0 5**** 5**** 5**** 7 7****
28 38 38 28* 7**** 7**** 7**** 6
6**** 6 5 0* 0

SIEMENS
5 5 5 788 700 2 ^ 88 3 3 288 7 v
0000 7 7 688 600 688 7 *8 * 500 5 5
788 700 2 ^ 88 3 3 288 7 v 0000 7 7
688 600 688 5 *8 *

SONYERICSSON
58 5 5 79 78 290 3 3 29 788000 7 7
69 68 69 7 *9 *8 58 5 5 79 78 290 3
3 29 788000 7 7 69 68 69 5 *9 *8

ALCATEL
5* 5 5 7 7 2* 3 3 28 7** 7 7 6 6 6 7 08 0
5 5 5 7 7 2* 3 3 28 7** 7 7 6 6 6 5 08 0

PANASONIC
555 > 555 > 555 77 > 77 2 3 > 3 2
**** 77 > 77 > 77 666 > 666 > 666
77 0 **** > 0 555 > 555 > 555 77 >
77 2 3 > 3 2 **** 77 > 77 > 77 666 >
666 > 666 555 0 **** > 0

PHILIPS
4 (v2) 4 4 4 (^2) 4 4 (^2) 4 (^1) 4 6
(v1) 4 (v2) 4 4 4 (v1) 4 4 4 (^1) 9 9 4
(v2) 4 4 4 (^2) 4 4 (^2) 4 (^1) 4 6
(v1) 4 (v2) 4 4 4 (v1) 4 4 4 (v1) 9 9

Ghost Riders
(Aston Villa FC)

MOTOROLA
*6g3c3c3c3d3#d3#d3#d3c3*6#a3
*6#a3*6#a3*6g3*6#a1.r3.*6g3c3c3c
3d3#d3#d3#d3.f4g3g3g3#d3g0g3c3c3
c3c3g3g2g3g3g3#d3c2.c3*6#g3*6#
g3*6#g3*6#g3#d2#d0r3#d3#
d3c3c3*6#a3c0r0

NOKIA
g3,c,c,c,d,d#,d#,d#,c,a#3,a#3
,a#3,g3,2a#3.,p,g3,c,c,c,d,d#,d#,d#.,16f,
g,g,g,d#,1g,g,c5,c5,c5,c5,g,4g,g,g,g,
d#,4c.,c,g#3,g#3,g#3,g#3,4d#,1d#,p,d#,
d#,c,c,a#3,1c,1p.

SAMSUNG
58**** 188**** 188**** 188****
288**** 2 ^ 88**** 2 ^ 88**** 2 ^
88**** 188**** 6 ^ 8**** 6 ^
8**** 6 ^ 8**** 58**** 6 ^ 8* 0*
0**** 0*** 58**** 188****
188**** 188**** 288**** 2 ^
88**** 2 ^ 88**** 2 ^ 88**** 0***
488*** 588**** 588**** 588**** 2
^ 88**** 588** 588**** 1****
1**** 1**** 1**** 588**** 588
588**** 588**** 588**** 2 ^
88**** 188 0**** 188**** 5 ^
8**** 5 ^ 8**** 5 ^ 8**** 5 ^
8**** 2 ^ 88 2 ^ 88** 0**** 2 ^
88**** 2 ^ 88**** 188****
188**** 6 ^ 8**** 188** 0**

SIEMENS
^ ^ 1 v v v 1 1 2 2 (^) 2 2 1 (v) 6 ^ ^
^ (^) 6 6 5 (v) 68888 (^) *0 5 ^ ^ ^
0000 (v) 1 v v v 1 1 2 2 (^) 2 2 400
(v) 588 5 5 2 (^) 58888 88 (v) 50000
00 1 ^ 1 1 1 5 v 588 500 5 5 2 (^)
188 (v) 100 5 ^ ^ ^ (^) 5 5 5 2 v v v
88 28888 *0 20000 00 2 1 (v) 1 6 ^ ^
^ (^) 1 v v v 8888 88 (v) *88

SONYERICSSON
5800 100 1 1 2 2## 2## 2## 1 600##
6## 6## 5 699## *8800 500 100 1 1
2 2## 2## 2## 48 59 5 5 2## 5999
5888 1 1 1 1 5 59 58 5 5 2## 19 18
500## 5## 5## 5## 2900## 299##
*888 2## 2## 1 1 600## 199900 *

ALCATEL
5** 1** 1 1 2 2# 2# 2# 1 6*# 6# 6# 5
68# 0 0 088 5 1** 1 1 2 2# 2# 2# 088
4888 5 5 5 2# 58888 5 1 1 1 1 5 5 5 5 5
2# 1 088 1 5*# 5# 5# 5# 2**# 28888#
0 2# 2# 1 1 6*# 1**8888 08888

PANASONIC
555 55 111 > 111 > 111 222 > 2222
> 2222 > 2222 111 666 666 > 666
666 > 666 666 555 55 666 666 ****
0 555 55 111 > 111 > 111 222 >
2222 > 2222 > 2222 0 * 444 ** 555
> 555 > 555 2222 555 *** > 555 111
> 111 > 111 > 111 555 > 555 > 555 >
555 > 555 2222 111 0 * 111 555 555
> 555 555 > 555 555 > 555 555 2222
> 2222 *** 0 2222 > 2222 111 > 111
666 666 111 *** 0 ***

PHILIPS
4 (^5) 4 (v11) 4 4 4 (^1) 4 # 4 # 4 # 4
(v1) 4 (^12) # 4 # 4 # 4 (v1) 7 (^1) # 9
4 (v1) 4 (v11) 4 4 4 (^1) 4 # 4 # 5 # 1
(^2) 4 (^1) 4 4 4 (v3) # 8 (^3) 4 4 (v4)
4 4 4 4 (^4) 4 4 4 4 4 (v3) # 5 (v1) 4 4
(^11) # 4 # 4 # 4 # 4 (v10) # 8 # 9 4 #
4 # 4 (v1) 4 4 (^12) # 8 (v12) 9

Glory Glory
(Man United)

MOTOROLA
g2.r5f4r5e3r5g4r5*5c3r5*5d4
r5*5e1*5c1a2.r5b4r5*5c3r5b4r5*5c
3r5a4r5g1e1g2.r5f4r5e3r5g4r5*5c3r5
*5d4r5*5e1*5c2*5c3r5*5c4r5*5d2
*5d2* 5c2b2*5c1r1r2

NOKIA
4g.5,p,16f5,p,8e5,p,16g5,p,8c,p,16
d,p,2e,2c,4a.5,p,16b5,p,8c,p,16b5,p,
8c,p,16a5,p,2g5,2e5,4g.5,p,16f5,
p,8e5,p, 16g5,p,8c,p,16d,p,
2e,4c,8c,p,16c,p,4d,4d,4c,4b5,2c,2p,4p

SAMSUNG
5 0**** 0*** 4*** 0*** 3**** 0***
5*** 0*** 18**** 0*** 28*** 0***
38* 18* 6 0**** 0*** 7*** 0***
18**** 0*** 7*** 0*** 18****
0*** 6*** 0*** 5* 3* 5 0**** 0***
4*** 0*** 3**** 0*** 5*** 0***
18**** 0*** 28*** 0*** 38* 18

18**** 0*** 18*** 0*** 28 28 18 7
18* 0* 0

SIEMENS
5 88 *00 40000 *00 388 *00 500 *00
1 ^ 88 *00 200 *00 38888 88 1 6 v
00 *00 70000 *00 1 ^ 88 *00 7 v 00
*00 1 ^ 88 *00 6 v 00 *00 58888 88
3 500 *00 40000 *00 388 *00 500
*00 1 ^ 88 *00 200 *00 38888 88
100 100 *00 100 *00 28888 2 1 7 v 1
^ 88 *8 *

SONYERICSSON
5 *888 49 *8 399 *88 59 *8 1990
*88 29 *8 388 1 68000 *888 79 *8
1990 *88 79000 *8 1990 *88 69000
*8 588 3 58 *888 49 *8 399 *88 59
*8 1990 *88 29 *8 388 18 18 *88 19
*8 2999 2 1 7000 190 * *8

ALCATEL
5* 088 0888 4888 0888 388 0888
5888 0888 1*88 0888 2888 0888 38
18 6** 088 0888 7888 0888 1*88
0888 7**888 0888 1*88 0888
6**888 0888 58 38 5 088 0888 4888
0888 388 0888 5888 0888 1*88 0888
2888 0888 38 1 188 0888 1888 0888
2 2 1 7** 1*8 08 0

PANASONIC
555 0 ** 444 ** 0 ** 33 * 0 ** 555
** 0 ** 1 * 0 ** 2 ** 0 ** 3 **** 1
**** 666 0 ** 77 ** 0 ** 1 * 0 ** 77
** 0 ** 1 * 0 ** 666 ** 0 ** 555
**** 33 **** 555 0 ** 444 ** 0 **
33 * 0 ** 555 ** 0 ** 1 * 0 ** 2 ** 0
** 3 **** 1 > 1 * 0 ** 1 ** 0 ** 2 >
2 1 77 1 **** 0 **** > 0

PHILIPS
5 (v2) 9 1 (v1) 9 2 (v1) 9 1 (^2) 9 2
(^3) 9 1 (^1) 9 6 (^1) 6 (v2) 5 (v2) 9
1 (^1) 9 2 (^1) 9 1 (v1) 9 2 (^1) 9 1
(v2) 9 6 (v1) 6 (v2) 5 (^2) 9 1 (v1) 9 2
(v1) 9 1 (^2) 9 2 (^3) 9 1 (^1) 9 6
(^1) 4 (v2) 2 9 1 9 4 (^1) 4 4 (v1) 4
(v1) 6 (^1) 9 9

Hail Hail (Celtic FC)
MOTOROLA
*5g3*5a3*53*6c2.*5g2.*5e2.*5c2.*5g2.
*5g1.*5g3*5a3*53*6c2.*5g2.*5f2.*5e2.
*5a0*51r3*5#a3*51r3*5#a3*53r3
*5#a3 *51.*5a3r3*5g3*5a3

NOKIA
g,a,h,4c7.,4g.,4e.,4c.,4g.,2g.,
g,a,h,4c7.,4g.,4f.,4e.,1a,2h,p,a#,2h,p,
a#,h,p,a#,2h.,a,p,g,a
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SAMSUNG
5**** 6**** 18 0**** 5 0**** 3
0**** 1 0**** 5 0**** 5* 0* 5****
6**** 18 0**** 5 0**** 4 0**** 3
0**** 6** 0**** 6 ^ **** 0**** 6 ^
**** 0**** 6 ^ **** 6**** 0****
5**** 6****

SIEMENS
5 ^ 6 1 ^ 88 5 v 3 1 5 588 50000 6 1
^ 88 5 v 4 3 68888 *0 60000 (^) *0
60000 *0 6 60000 (v) *0 5 6

SONYERICSSON
580 6  190 5000 3 1 5 59 588 6  190
5000 4 3 699  *888 6##  * 6##  * 6##
6 * 5 6

ALCATEL
5 6 1** 088 5* 088 3 088 1 088 5
088 58 0 5 6 1** 088 5* 088 4 088 3
088 68888 0 6# 0 6# 0 6# 6 0 5 6

PANASONIC
555 666  111 11 0 * 555 0 * 33 0 *
111 0 * 555 0 * 555 ****0 555 666
111 11 0 * 555 0 * 444 0 * 33 0 *
666 ***  **** 0 6666  **** 0 6666
0 6666  ****0 666 0 555 666

PHILIPS
4 (v7) 4 4 (^7) 5 (^8) 5 (v8) 5 5 5 7 4 4
4 (^7) 5 (^8) 5 (v8) 5 5 8 6 (^7) 9 4 # 6
(^7) 9 4 # 4 (^7) 9 4 # 7 (^7) 4 9 4 4

Marching on Together
(Leeds United)

MOTOROLA
b2r4b2*5e2.*5#d4r4*5#d2*5#c2.r2.
a4.r5a2#f2*5#d2*5#c2b2.r4b2.*5#c4b
2a2#g2#f2#g4.r5.#g2b2e2.#g2b2a
2b2*5#c2*5#c2b2a2b2.r2*5#d2.r2.*5e1

NOKIA
4b,16p.,b,4e6.,16d#6,16p,d#6,4c#6.,
p,16a.,32p,4a,f#,4d#6,4c#6,b.,16p,b.,16c#6,
b,a,g#,f#,16g#.,32p,4g#,b,4e.,g#,b,
4a,b,c#6,c#6,b,a,4b.,p,4d#6.,p,2e6

SAMSUNG
7 0*** 7 38 0**** 2 ^ 8*** 0*** 2 ^
8 1 ^ 8 0**** 0 0**** 6*** 0***
0*** 6 4 ^  2 ^ 8 1 ^ 8 7 0**** 0***
7 0**** 1 ^ 8*** 7 6 5 ^  4 ^  5 ^
*** 0*** 0*** 0*** 5 ^  7 3 0**** 5
^  7 6 7 1 ^ 8 1 ^ 8 7 6 7 0**** 0 2 ^
8 0**** 0 0**** 38*

SONYERICSSON
7 *88 799 30 288## * 299## 1# *000
688 *8 6999 4# 20## 1# 7000 *88
799 1880# 799000 6 5## 4# 588##
*800 599900## 7 3 5## 7 6 7 10# 1#
7000 6 7 * 20## *000 390

SIEMENS
7 88 *00 7 3 ^ 20000 (^) *00 28888
1 * 6 ^ 0000 (v) *00 68888 4 (^) 2 ^
1 7 v *00 7 1 ^ 0000 (^) 7 v 8888 6 5
(^) 4 50000 *00 5 v v 8888 7 3 5 (^)
7 6 7 1 ^ (^) 1 7 v 6 7 * 2 ^ (^) * 3 ^
^ 88

ALCATEL
7* 0888 7 3* 088 2888# 0888 2# 1#
088 0 088 6**888 0888 0888 6 4#
2*# 1# 7** 088 0888 7 088 1*888#
7** 6 5# 4# 5888# 0888 0888 0888
5# 7 3 088 5# 7 6 7 1*# 1# 7** 6 7
088 0 2*# 088 0 088 38

PANASONIC
77 0 ** 77 3 0 * 22 ** 0 ** 22 11 0
666 ** 0 ** 666 4444 22 11 77 0 **
77 0 * 11 ** 77 666 5555 4444 5555
** 0 ** 5555 77 33 0 * 5555 77 666
77 11 > 11 77 666 77 0 22 0 3 ****

PHILIPS
4 9 4 5 (^3) 1 (v1) # 9 4 # 5 (v1) # 9 2
(v2) 9 4 4 (v2) # 4 (^5) # 4 (v1) # 5
(v1) 9 5 1 (^1) # 4 (v1) 4 (v1) 4 (v1) #
4 (v1) # 2 (^1) # 9 4 # 4 (^2) 5 (v4) 4
(^2) # 4 (^2) 4 (v1) 4 (^1) 4 (^1) # 4
# 4 (v1) 4 (v1) 5 (^1) 9 5 (^2) # 9 6
(^1)

Red Red Robin
(Bristol City FC)

MOTOROLA
#d3r5f4r5g3.r5.g3.r5.g3r5f4r5#d3.
r5.f3.r5.f3.r5.f3r5#d4r5d3.r5.#d1r3
*6#a3.r5.g1r3#d3r5f4r5g3.r5.g3.r5.
g3r5f4r5#d3.r5.f3.r5.f3.r5.f3r5#d4r5
d3.r5.#d1r3*6#a3.r5.#a1.r3.c3

NOKIA
8d#4,p,16f4,p,8g4.,p.,8g4.,p.,8g4,p,
16f4,p,8d#4.,p.,8f4.,p.,8f4.,p.,
8f4,p,1 6d#4,p,8d4.,p.,2d#4,8p,
8a#3.,p.,2g4,8p,8d#4,p,16f4,p,8g4.,
p.,8g4.,p.,8g4,p,16f4,p,8d#4.,
p.,8f4.,p.,8f4.,p.,8f4,p,16d#4,
p,8d4.,p.,2d#4,8p,8a#3.,p.,2a#4.,8p.,8c5.

SAMSUNG
2 ^ 88**** 0*** 488*** 0***
588**** 0*** 0*** 0*** 588****
0*** 0*** 0*** 588**** 0***
488*** 0*** 2 ^ 88**** 0*** 0***
0*** 488**** 0*** 0*** 0***
488**** 0*** 0*** 0*** 488****
0*** 2 ^ 88*** 0*** 288**** 0***
0*** 0*** 2 ^ 88* 0**** 6 ^ 8****
0*** 0*** 0*** 588* 0**** 2 ^
88**** 0*** 488*** 0*** 588****
0*** 0*** 0*** 588**** 0*** 0***
0*** 588**** 0*** 488*** 0*** 2 ^
88**** 0*** 0*** 0*** 488****
0*** 0*** 0*** 488**** 0*** 0***
0*** 488**** 0*** 2 ^ 88*** 0***
288**** 0*** 0*** 0*** 2 ^ 88*
0**** 6 ^ 8**** 0*** 0*** 0*** 6 ^
88* 0* 0**** 0*** 1****

SIEMENS
2 v (^) *00 400 (v) *00 588 *00 5 v v
v *00 5 v v v *00 400 *00 288 (^)
*00 4 v v v (v) *00 4 v v v *00 4 v v
v *00 200 (^) *00 288 (v) *00 2 v v v
8888 (^) *0 6 ^ ^ ^ 0000 *00 5 v v v
8888 (v) *0 20000 (^) *00 400 (v)
*00 588 *00 5 v v v *00 5 v v v *00
400 *00 288 (^) *00 4 v v v (v) *00 4
v v v *00 4 v v v *00 200 (^) *00
288 (v) *00 2 v v v 8888 (^) *0 6 ^ ^
^ 0000 *00 6 v v v 8888 *0 1 ^ 0000
(v)

SONYERICSSON
28## *88 49 *8 599 *8800 59900
*8800 59900 *88 49 *8 299## *8800
49900 *8800 49900 *8800 49900
*88 29## *8 299 *8800 28800## *88
600## *88 58800 *88 2## *88 49 *8
599 *8800 59900 *8800 59900 *88
49 *8 299## *8800 49900 *8800
49900 *8800 49900 *88 29## *8 299
*8800 28800## *88 600## *88
68800## *88 1

ALCATEL
288# 0 4888 0 588 0888 0 088 588
0888 0 088 588 0 4888 0 288# 0888
0 088 488 0888 0 088 488 0888 0
088 488 0 2888# 0 288 0888 0 088
28# 088 6**88# 0888 0 088 5*8 088
288# 0 4888 0 588 0888 0 088 588
0888 0 088 588 0 4888 0 288# 0888
0 088 488 0888 0 088 488 0888 0
088 488 0 2888# 0 288 0888 0 088
28# 088 6**88# 0888 0 088 6*8# 0
088 0888 1*88

PANASONIC
2222 * 0 444 ** 0 555 * 0 555 * 0
555 * 0 444 ** 0 2222 * 0 444 * 0
444 * 0 444 * 0 2222 ** 0 222 * 0
2222 **** 0 * 666 666 * 0 555 ****
0 * 2222 * 0 444 ** 0 555 * 0 555 *
0 555 * 0 444 ** 0 2222 * 0 444 * 0
444 * 0 444 * 0 2222 ** 0 222 * 0
2222 **** 0 * 666 666 * 0 6666
**** 0 * 111 *

PHILIPS
2 (v7) # 9 1 9 3 9 3 9 2 9 1 9 3 # 9 3
9 3 9 2 9 1 # 9 3 9 6 # 9 3 (^13) # 9 6
(v13) 9 2 # 9 1 9 3 9 3 9 2 9 1 9 3 # 9
3 9 3 9 2 9 1 # 9 3 9 6 # 9 3 (^13) # 9
7 (v13) # 9 2 (^1)

The Pride (Everton)
MOTOROLA
*53.*54*53*5a3*5g3*5a4*5g3.*5e3
*5d3*5e3*5d33*5d1*5g3.*5g4
*5g3*5g3*5#f3*5g3*5a3*53*5g2.
*5g3*5a2*5a3.*5g4*5#f3*5a2.*5a2
*5a3.*5g4*5#f3*5a2.*5a4*5a4
*5a4 *5a4*5a4*54*5g3*5#f3*5#f3
*5e3*5d3*51.*6d3*6d4*6d2.*53
*6c3*6c2*5a3*5g4*5g3*5g3.*5#f3
*5d3*5d2*6c3*6d4*6d3*6d3.
*53*5a3*5#f3*5e3*5d3*5g1

NOKIA
H.,8H,H,A,G,8A,G.,E,D,E,D,H4,1D,G.,
8G,G,G,F#,G,A,H,2G.,G,2A,A.,8G,
F#,2A.,2A,A.,8G,F#,2A.,8A,
8A,8A,8A,8A,8H,G,F#,F#,E,D,
1H.,D6,8D6,2D6.,H,C6,2C6
,A,8G,G,G.,F#,D,2D,C6,8D6,
D6,D6.,H,A,F#,E,D,1G

SAMSUNG
6**** 5**** 6*** 5**** 0***
3**** 2**** 3**** 2**** 2* 5****
0*** 5*** 5**** 5**** 4 ^ ****
5**** 6**** 5 0**** 5**** 6 6****
0*** 5*** 4 ^ **** 6 0**** 6 6****
0*** 5*** 4 ^ **** 6 0**** 6***
6*** 6*** 6*** 6*** 5**** 4 ^
**** 4 ^ **** 3**** 2**** 28****
28*** 28 0**** 18**** 18 6****
5*** 5**** 5**** 0*** 4 ^ ****
2**** 2 18**** 28*** 28****
28**** 0*** 6**** 4 ^ **** 3****
2**** 5*

SIEMENS
6 5 600 588 3 2 3 2 2 ^ 8888 50000
500 588 5 4 (^) 5 (v) 6 588 500 688
600 500 488 (^) 688 (v) 6 600 500
488 (^) 688 (v) 60000 6 6 6 6 588 4
(^) 4 3 2 2 ^ 0000 200 28888 1 ^ 188
6 v 00 500 588 5 4 (^) 2 (v) 288 1 ^
00 200 288 2 6 4 (^) 3 2 58888

SONYERICSSON
680 5 68 59 3 2 3 2  299 588 58 59
5 4# 5 6  59 58 69 68 58 49# 69 6
68 58 49# 69 688 6 6 6 6  59 4# 4#
3 2  20 28 299  18 19 68000 58 59
5 4# 2 29 180 28 29 2  6000 4# 3 2
599

ALCATEL
6* 5 688 5 088 3 2 3 2 28888 5 088
588 5 5 4# 5 6 58 0 5 68 6 088 588
4# 68 0 68 6 088 588 4# 68 0 688
688 688 688 688 5 4# 4# 3 2 2* 288
28 0 1 18 6** 588 5 5 088 4# 2 28 1*
288 2 2 088 6** 4# 3 2 58888

PANASONIC
> 0 *  *  6 5 6 * 5 0 * 3 2 3 2  > 2
*** 5 0 * 5 * > 5 > 5 44 5 6  5 ****0
5 6 **** > 6 0 * 5 * 44 6 ****0 6
**** > 6 0 * 5 * 44 6 ****0 6 * > 6 *
> 6 * > 6 * > 6 *  * 5 44 > 44 3 2
***0 222 22 > 222 22 * > 222 22
****0  111 11 > 111 11 **** 6 5 * >
5 > 5 0 * 44 2 > 2 **** 111 11 222
22 * > 222 22 > 222 22 0 *  6 44 3 2
5 ***

PHILIPS
5 2 4 4 (v1) 4 (v1) 2 (^1) 5 (v1) 4 (v2)
4 (v1) 4 (^1) 4 (v1) 4 (^5) 8 5 (^3) 2
4 4 4 (v1) # 4 (^1) 4 (^1) 4 (^1) 7
(v1) 4 6 (^1) 5 2 (v1) 4 (v1) # 7 (^2) 6
5 2 (v1) 4 (v1) # 7 (^2) 2 2 2 2 2 2
(^1) 4 (v1) 4 (v1) # 4 # 4 (v1) 4 (v1) 8
(^5) 4 (^7) 2 7 4 (v2) 4 (v1) 6 4 (v2) 2
(v1) 4 5 4 (v1) # 4 (v2) 6 4 (^6) 2 (^1)
4 5 4 (v2) 4 (v3) 4 (v2) # 4 (v1) 4 (v1)
8 (^3)

You’ll Never Walk
Alone (Liverpool)

MOTOROLA
*5d2*5c2*5d1*5e2*5d2*5e1
*5c2*5c1b2*5c2*5d1*5c2*5d2*5e1
*5e2*5d2*5e1*5e2*5d2*5e1*5c2*5g1
*5e2*5c1a2*5c1

NOKIA
d,c,2d,e,d,2e,c,2c,b4,c,2d,c,d,2e,e,d,
2e,e,d,2e,4c,2g,4e,2c,4a4,2c

SAMSUNG
2 1 2* 3 2 3* 1 1* 788 1 2* 1 2 3* 3
2 3* 3 2 3* 1 5* 3 1* 688 1*

SIEMENS
2 88 1 288 300 2 388 100 188 7 v
00 1 ^ 288 100 2 388 300 2 388
300 2 388 100 588 300 188 6 v 00 1
^ 88

SONYERICSSON
20 1 29 38 2 39 18 19 78000 10 29
18 2 39 38 2 39 38 2 39 18 59 38 19
68000 190

ALCATEL
2* 1 28 3 2 38 1 18 7** 1* 28 1 2 38
3 2 38 3 2 38 1 58 3 18 6** 1*8

PANASONIC
2 1 2 **** 3 2 3 **** 1 > 1 **** 77
1 2 **** 1 2 3 **** > 3 2 3 **** > 3
2 3 **** 1 5 **** 3 1 **** 666 1
****

PHILIPS
4 (v5) 4 (v1) 6 (^1) 4 (^1) 4 (v1) 6
(^1) 4 (v2) 6 4 (v1) 4 (^1) 6 (^1) 4
(v1) 4 (^1) 6 (^1) 4 4 (v1) 6 (^1) 4 4
(v1) 6 (^1) 4 (v2) 6 (^4) 4 (v2) 6 (v2)
4 (v1) 6 (^1) PC+



10 |

plusTrik IV • 10 - 16 September 2003
PCplus 143

Windows NT/2000/XP:
Menyembunyikan Ikon Control Panel

Pada edisi terdahulu,
PCplus pernah membahas
mengenai bagaimana untuk
menyembunyikan berbagai
menu di Control Panel pada
Windows 9x/Me. Kali ini kita
akan mencoba trik yang sama
pada sistem operasi yang ber-
beda, Windows NT/2000/XP. Ti-
dak usah berpanjang lebar lagi,
ikuti langkah-langkah berikut:
1. Buka Registry Editor

dengan mengklik
[Start]>[Run...] kemudian
ketik regedt32.

2. Masuklah subkey:
HKEY_CURRENT_USER\Control
Panel\don't load

3. Klik kanan mouse pada
bagian kanan window,
kemudian klik [New]>[String
Value].

4. Beri nama String Value
baru tadi dengan nama file
di Control Panel yang ingin
Anda hilangkan, misalnya
inetcpl.cpl untuk
menyembunyikan Internet
Options.

5. Isikan value data-nya
dengan No.

6. Ulangi langkah 3, 4 dan 5
untuk menyembunyikan ikon
Control Panel yang lain.

7. Tutup Registry Editor
kemudian restart komputer.

Untuk mengaktifkan kembali

ikon-ikon di Control Panel
yang pernah Anda
sembunyikan, ubah value
data No menjadi Yes atau
langsung hapus entry
String Value yang telah
Anda buat. Berikut ini
adalah ikon-ikon yang biasa
terdapat di Control Panel:

• access.cpl: Accessibility
Options

• hdwwiz.cpl: Add hardware
• appwiz.cpl: Add/Remove

Programs
• console.cpl: Console
• timedate.cpl: Date and Time
• desk.cpl: Display
• fax.cpl: Fax
• inetcpl.cpl: Internet Options
• joy.cpl: Game Controllers
• liccpa.cpl: Licensing
• main.cpl: Mouse
• mlcfg32.cpl: Mail
• modem.cpl: Modem and

Phone
• ncpa.cpl: Network Connec-

tions
• netcpl.cpl: Network and

Dial-up Connectivity
• nwc.cpl: Netware Client
• odbccp32.cpl: ODBC
• devapps.cpl: PC Card
• ports.cpl: Ports
• telephon.cpl: Phone and

Modem Options
• powercfg.cpl: Power

Options

• intl.cpl: Regional and
Language

• sticpl.cpl: Scanner and Camera
• srvmgr.cpl: Server Manager
• mmsys.cpl: Sound and

Audio Devices
• sapi.cpl: Speech Properties
• sysdm.cpl: System
• tweakui.cpl: TweakUI
• nusrmgr.cpl: User Accounts
• irprops.cpl: Wireless Link
• wspcpl32.cpl: WSP Client
• Adobe Gamma.cpl: Adobe

Gamma
• cpqmgmt.cpl: Compaq

Insight Agents
• igfxcpl.cpl: Intel Graphics

Technology
• jpicpl32.cpl: Java Plug-in
• LightFrame.cpl: LightFrame 2
• nmo.cpl: Nokia Modem

Options
• NclConf.cpl: Nokia Connec-

tion Manager
• S32LUCP1.cpl: Norton Live

Update
• QuickTime.cpl: QuickTime
• Avsmcpa.cpl: VirusScan

Untuk mengetahui menu
Control Panel apa saja yang
Anda miliki, caranya klik
[Start]>[Search] kemudian
masukkan *.cpl pada bagian
All or part of the file name.
Selamat mencoba.

Steven Andy Pascal
steven@e-pcplus.com

Mengirim SMS
NewsFlash dengan

Oxygen Phone Manager
Jika Anda merupakan pengguna proXL, Anda pasti tau apa
yang dimaksud dengan NewsFlash ini. Ya, customer service proXL
biasa mengirimkan SMS resmi kepada pelanggannya dengan
fasilitas NewsFlash. SMS yang dikirimkan dengan NewsFlash,
pesannya akan langsung muncul di layar ponsel. Jadi ketika SMS
diterima, yang muncul bukan 1 message received atau sejenisnya,
melainkan pesannya langsung muncul di layar ponsel. Pesan yang
masuk pun tidak secara otomatis disimpan. Sehingga apabila Anda
tidak memilih [Save] setelah membaca pesan, maka SMS tersebut
tidak akan pernah Anda temui lagi di Inbox.

Pengiriman NewsFlash ini memang tidak dapat dilakukan
melalui ponsel biasa. Anda memerlukan software khusus yang
mampu mendukung pengiriman NewsFlash. Salah satu software
yang mendukung pengiriman SMS NewsFlash adalah Oxygen
Phone Manager II for Nokia Phones. Bagaimana cara
menggunakan fitur ini? Berikut langkah-langkahnya:
1. Aktifkan infrared atau kabel data pada ponsel Anda.
2. Klik [Start]>[All Programs]>[Oxygen Phone Manager

II]>[Oxygen Phone Manager II].
3. Pada My Phones, pilih ponsel yang akan Anda gunakan untuk

mengirim SMS NewsFlash.
4. Masuklah ke menu SMS Manager, kemudian klik [New Message].
5. Ketikkan pesan SMS Anda pada kolom yang disediakan dan

isikan nomor ponsel yang dituju pada bagian To seperti
mengirim SMS biasa.

6. Sekarang adalah tahap yang paling penting, tandai checkbox
[NewsFlash] yang terdapat di bagian bawah Validity period.

7. Klik [Send] untuk mengirim SMS NewsFlash Anda.
Seperti pernah dibahas pada plusFokus PCplus edisi 133, Anda
membutuhkan kabel data atau infrared untuk menghubungkan
komputer dengan ponsel Anda. Untuk lebih jelasnya, silahkan
lihat kembali PCplus edisi tersebut!

Steven Andy Pascal
steven@e-pcplus.com

Membuat dan Menggunakan
Template Microsoft Word

Suatu ketika mungkin
Anda sering membuat sebuah
dukumen atau surat berulang
kali yang memerlukan style,
teks, atau format yang sama.
Biasanya kita buat dokumen
tersebut satu per satu, baru ke-
mudian memformat, membuat
style, dan pengaturan teks pada
masing-masing dokumen
tersebut. Tentu saja hal ini tidak
efisien karena akan merepotkan
dan banyak memakan waktu.

Dengan menggunakan fa-
silitas template yang telah dise-
diakan oleh Microsoft Word,
maka kejadian tadi bisa dihin-
dari. Template adalah dokumen

khusus dimana Anda bisa menyim-
pan style, teks, dan format untuk
digunakan pada dokumen lain.

Yang perlu Anda lakukan
untuk menggunakan fasilitas
template ini adalah
1. Klik menu [File], lalu klik [New].
2. Klik tab untuk jenis Template

yang Anda inginkan. (Pada
Word XP akan muncul Task
Pane, dari list Anda dapat
mengklik [General Tem-
plate…]).

3. Klik ganda ikon template
yang diinginkan.

4. Setelah itu Anda dapat
mengedit dokumen template
itu untuk membuat dokumen

baru yang Anda inginkan,
kemudian setelah selesai
Anda dapat menyimpan
dokumen baru tersebut.

Selain menggunakan
template yang telah di sediakan
oleh Word, Anda pun bisa
menggunakan template yang
bisa Anda buat sendiri. Adapun
caranya sebagai berikut:
1. Buat dokumen baru atau

yang sudah ada, Anda bisa
tentukan style, teks, format
margin, halaman dan lainnya
yang diinginkan pada
dokumen tersebut.

2. Setelah selesai, simpan

dokumen tersebut sebagai
template dengan mengklik
[File]>[Save As…]

3. Beri nama file tersebut seke-
hendak Anda, lalu pada Save
as type, pilih Document
template (*.dot). Pastikan
bahwa folder template
(biasanya terletak pada folder
Microsoft Office, di dalam
folder Program Files) muncul

pada kotak Save In.
Pada Word XP template

disimpan dalam folder tem-
plate yang ada didalam folder
Document and
settings\{Nama
User}\Application
Data\Microsoft.

Muhamad Taufik
muhtfk2@telkom.net
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Membuat Jadwal Waktu
Sholat dengan PHP

Sebuah web site yang
informatif selayaknya menye-
diakan informasi yang berguna
bagi pengunjungnya, misalnya
informasi ramalan cuaca, kurs
valas, dan lain-lain. Dalam tuli-
san ini Anda akan mempelajari
bagaimana menampilkan
informasi jadwal waktu sholat
yang dinamis dengan PHP.

Komponen yang Anda
perlukan adalah database
waktu sholat dalam format
plain text yang berisi data
dengan susunan berikut:
tanggal|shubuh| fajar|zhuhur|
ashar|maghrib|isya

Simpan database jadwal
waktu sholat tersebut dalam
klasifikasi per bulan, seperti
contoh file sholat.03.txt berikut:

sholat.03.txt
01|04:45|05:55|12:02|03:05|06:09
|07:19
02|04:45|05:55|12:02|03:04|06:09
|07:19
03|04:45|05:55|12:02|03:03|06:08
|07:18
04|04:45|05:55|12:02|03:04|06:08|
07:18
05|04:45|05:55|12:01|03:04|06:08
|07:17
...
...
...

30|04:44|05:53|11:54|03:10|05:56
|07:05
31|04:43|05:53|11:54|03:10|05:55
|07:05

File sholat.03.txt berarti
jadwal waktu sholat untuk
bulan ke-03 atau Maret. Jika
Anda memiliki database jadwal
waktu sholat selama setahun
berarti Anda memiliki 12 file
.txt yang diberi nama
sholat.01.txt sampai
sholat.12.txt.

Langkah selanjutnya ada-
lah membuat script PHP yang
akan membaca file
sholat.[bulan_ke].txt,
menyorot baris [tanggal],
mengexplode data dalam baris
yang disorot, dan mendefinisi-
kan data array yang dihasilkan-
nya sebagai value dari masing-
masing variabel waktu sholat.

Berikut ini adalah script
sholat.php:
sholat.php
<?php

$tanggal = date(d, time());
$bulan = date(m, time());
$jadwal=
file("sholat.$bulan.txt");
$nomor= ($tanggal-1);
$waktu_sholat = ex-
plode("|",

$jadwal[$nomor]);
$shubuh = $waktu_sholat[1];
$fajar = $waktu_sholat[2];
$zhuhur = $waktu_sholat[3];
$ashar = $waktu_sholat[4];
$maghrib = $waktu_sholat[5];
$isya = $waktu_sholat[6];
?>

Script tanggal.php ini berisi
variabel $tanggal = date(d,
time());  yang mendefinisikan
tanggal hari ini dalam urutan angka
01 – 31. Variabel $bulan = date(m,
time()); mendefinisikan bulan
dalam urutan angka 01 – 12.
Variabel $jadwal =
file(“sholat.$bulan.txt”);
mendefinisikan file database
sholat.[bulan_ke].txt. Variabel
$nomor = ($tanggal-1);
mendefinisikan urutan baris data
ke-[tanggal - 1] sebab dalam PHP
penghitungan dimulai dari 0 (nol),
jadi data untuk tanggal 01 dikenal
oleh PHP sebagai baris ke-0, tanggal
02 adalah baris ke-1 dan seterusnya.

Selanjutnya variabel
$waktu_sholat = explode(“|”,
$jadwal[$nomor]); adalah yang
meng-explode data yang ada pada
file sholat.[bulan_ke].txt pada
baris ke-[tanggal - 1] dan
mengurutkan setiap entri yang
dibatasi oleh karakter “|” sebagai
data array $waktu_sholat[]:

$waktu_sholat[0] --> tanggal
$waktu_sholat[1] --> shubuh
$waktu_sholat[2] --> fajar
$waktu_sholat[3] --> zhuhur
$waktu_sholat[4] --> ashar
$waktu_sholat[5] --> maghrib
$waktu_sholat[6] --> isya

Sebagai contoh, untuk
tanggal 03 Maret 2003 maka
file database yang dibuka adalah
sholat.03.txt. Baris yang disorot
adalah baris tanggal (03) - 1
sehingga data array yang
dihasilkan adalah sebagai
berikut:
$waktu_sholat[0] --> 03
$waktu_sholat[1] --> 04:45
$waktu_sholat[2] --> 05:55
$waktu_sholat[3] --> 12:02
$waktu_sholat[4] --> 03:03
$waktu_sholat[5] --> 06:08
$waktu_sholat[6] --> 07:18

Selanjutnya data array
$waktu_sholat[] dijadikan value
dari masing-masing variabel
waktu sholat sebagai berikut:
$shubuh = $waktu_sholat[1];
$fajar = $waktu_sholat[2];
$zhuhur = $waktu_sholat[3];
$ashar = $waktu_sholat[4];
$maghrib = $waktu_sholat[5];
$isya = $waktu_sholat[6];

Contoh implementasi script
sholat.php dalam halaman Web
site adalah sebagai berikut:
<;php include
(“sholat.php”);?>
<table width =”100%”>
<tr>
<td width="100%"
colspan="2">
<p align="center"><b>Jadwal
Waktu Sholat Hari Ini</b></td>

</tr>
<tr>
<td width="50%">Shubuh</
td>
<td width="50%"><?php
echo "$shubuh"; ?></td>
</tr>
<tr>
<td width="50%">Terbit
Fajar</td>
<td width="50%"><?php
echo "$fajar"; ?></td>
</tr>
<tr>
<td width="50%">Zhuhur</
td>
<td width="50%"><?php
echo "$zhuhur"; ?></td>
</tr>
<tr>
<td width="50%">Ashar</
td>
<td width="50%"><?php
echo "$ashar"; ?></td>
</tr>
<tr>
<td width="50%">Maghrib</
td>
<td width="50%"><?php
echo "$maghrib"; ?></td>
</tr>
<tr>
<td width="50%">Isya</td>
<td width="50%"><?php
echo "$isya"; ?></td>
</tr>
</table>

Hasil yang diperoleh dari
implementasi script sholat.php
jika ditampilkan oleh Web
browser adalah seperti pada
gambar.

Muhammad Imansyah
imansyah@gmx.net
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Cakrawala Gintings
cakra@e-pcplus.com Pengaruh Cluster pada

Kecepatan Harddisk

S

Harddisk sudah
menjadi komponen

yang umumnya harus
tersedia pada sebuah

PC. Kapasitas dari
harddisk ini juga

semakin hari semakin
besar saja. Harga per

MB dari harddisk juga
semakin terjangkau.

Selain masalah
kapasitas, masalah

kinerja juga
merupakan hal

penting pada
harddisk. Hal

terpenting dari
harddisk adalah

keandalannya. Buat
apa harddisk

berkecepatan tinggi,
tetapi data yang

disimpan banyak yang
hilang.

aat ini
harddisk IDE
yang banyak
digunakan masih

menggunakan Parallel ATA. Dari
sisi kinerja harddisk, Parallel
ATA ini memang masih mampu
menangani harddisk-harddisk
IDE yang banyak digunakan. Di
samping itu harddisk Serial ATA
memang masih jarang
ketersediaannya di pasaran.
Dengan semakin tingginya
kinerja dari harddisk, nantinya
penggunaan Serial ATA
memang menjadi diperlukan.

Cluster
Suatu harddisk akan mem-

butuhkan file system untuk da-
pat bekerja dengan baik. Meng-
gunakan file system (dalam tuli-
san ini file system yang dimak-
sud lebih ditujukan pada FAT32),
harddisk akan dibagi menjadi
banyak cluster. Cluster ini akan
memengaruhi efisiensi dari
harddisk dan juga akan meme-
ngaruhi kinerja dari harddisk.

Suatu cluster akan terdiri
dari sebuah atau lebih sector.
Pada sebuah file system yang
memiliki cluster berukuran 32kB,
data yang berukuran lebih kecil
dari 32kB akan membutuhkan
kapasitas sebesar 32kB bila
disimpan. Ini disebabkan satu
buah data tersebut akan
menempati satu buah cluster.

Untuk data yang memiliki
ukuran lebih besar dari 32kB,
data tersebut akan menempati
cluster dengan jumlah tertentu
yang akan menghasilkan total
kapasitas yang sama ataupun
sedikit lebih besar dari ukuran
data tersebut. Sedikit lebih
besar maksudnya di sini adalah
total kapasitas yang lebih besar
dari ukuran data tersebut
dengan jumlah cluster yang
terendah. Data sebesar 64kB
akan menempati dua buah
cluster (32kB dan 32kB),
sementara data sebesar 48kB
juga akan menempati dua buah
cluster (32kB dan 16kB).

Dari contoh ini saja, sebuah
data sebesar 48kB akan
membuat kapasitas sebesar

16kB menjadi terbuang. Semakin
banyak data yang seperti ini
semakin besar kapasitas dari
harddisk yang terbuang.
Bayangkan bila data yang
disimpan memiliki ukuran sebesar
33kB. Akan terjadi pemborosan
sebesar 31kB. Dari angka ini bisa
dikatakan terjadi pemborosan
mendekati 50%.

Dalam contoh di atas,
ukuran cluster yang digunakan
adalah 32kB. Bagaimana bila
cluster yang digunakan adalah
8kB? Untuk contoh data yang
sama, akan terjadi penghematan
terhadap pemborosan yang
terjadi. Pada data sebesar 64kB
tentunya tidak terdapat
perbedaan pemborosan antara

8kB dan 64kB. Pada data sebesar
48kB, untuk cluster dengan
ukuran sebesar 8kB tidak terjadi
pemborosan. Jauh lebih hemat
dibandingkan dengan 32kB.
Apalagi pada data sebesar 33kB,

untuk 8kB terjadi pemborosan
sebesar 7kB dibandingkan
dengan 31kB pada cluster
berukuran 32kB. Bila melihat
kasus di atas, seseorang mungkin
akan berpikiran untuk menggu-
nakan cluster dengan ukuran
terkecil yang tersedia pada file
system yang digunakan. Sayang-
nya kesimpulan ini hanya benar
pada kasus efisiensi penggunaan

kapasitas pada harddisk. Untuk
masalah kinerja, kondisinya

menjadi berubah sama sekali.
Untuk kinerja,

penggunaan cluster
dengan ukuran yang

terkecil umumnya akan
memberikan kinerja

yang lebih rendah.
Hal ini antara lain

disebabkan oleh
ukuran dari FAT

(File Allocation
Table) yang
semakin besar
dan
kemungkinan
akan
terjadinya
fragmentation
yang lebih

besar. Memang besarnya kinerja
yang lebih rendah ini
dipengaruhi oleh banyak hal
termasuk hardware yang
digunakan. Bagi sebagian
pengguna PC, selisih kinerja ini
sering kali tidak begitu dirasakan.

Untuk sekadar memperoleh
gambaran mengenai pengaruh
cluster terhadap kinerja, PCplus

melakukan pengujian
menggunakan ZD
WinBench 99 Ver-
sion 1.2, tepatnya
menggunakan
Business Disk
WinMark 99 Version
1.2 dan High-End
Disk WinMark 99
Version 1.2. Adapun
harddisk yang
digunakan adalah
Seagate 7200.7
dengan cluster
berukuran 1kB, 2kB,
dan 4kB. Harddisk ini
diletakkan sebagai
harddisk kedua dan
bisa dikatakan tidak
berisi file.

Hardware
pendukung lainnya
adalah Albatron
PX865PE Pro II
dengan BIOS 1.01,
Intel Pentium-4
3,2GHz, Kingston
KVR400X64C25/512
(DDR-400 512MB, SPD)

sebanyak 2 keping, MSI
Ti4800SE-VTD8x, Adaptec SCSI
card 29320, Maxtor
ATLAS15K_73WLS (SCSI, 73GB
15000RPM), Asus 50x, Enlight
420W, dan Mugen 14”.

Cluster sangat memengaruhi efisiensi dan kinerja
dari harddisk

Hasil Pengujian
Dari hasil pengujian yang

dilakukan diperoleh bahwa dari
sisi kinerja menggunakan cluster
1kB menghasilkan kinerja yang

lebih lambat dibandingkan
menggunakan cluster 4kB
ataupun 2kB. Mengubah cluster
dari berukuran 4kB menjadi
berukuran 1kB akan menurunkan
kinerja sekitar 6,5% pada
pengujian menggunakan High-
End Disk WinMark 99 Version 1.2.
Pada Business Disk WinMark 99
Version 1.2 hal ini akan

menurunkan kinerja sekitar
19,2%. Angka yang terakhir ini
menunjukkan penurunan kinerja
yang cukup besar.

Penurunan kinerja ini juga
bisa dirasakan sewaktu
melakukan format yang menjadi
prosedur standar pada Seagate
DiscWizard Starter Edition
Version 10.34.10. Perbedaan
kinerja ini belum tentu terasa
merugikan bagi setiap pengguna
PC. Hal ini bisa disebabkan
karena naiknya efisiensi yang
diperoleh, atau memang
pengguna tersebut tidak

Sewaktu melakukan format, seseorang bisa
memilih ukuran dari cluster yang digunakan

terlampau mementingkan
kinerja.

Memilih ukuran cluster
yang sesuai tentunya
bergantung pada banyak hal,

seperti selera dari pengguna,
ukuran dari file yang banyak
digunakan, kapasitas dari
harddisk yang digunakan, dan
juga kinerja dari harddisk itu
sendiri. Kinerja dari harddisk
yang dimaksud di sini adalah
kinerja dasar dari harddisk itu
sendiri, seperti kecepatan puta-
ran piringan dan kepadatan

data. Bila kinerja ini sudah
rendah, menggunakan cluster
dengan ukuran yang membuat
kinerja semakin rendah lagi
tidak merupakan hal yang
menarik untuk dilakukan.

Dari segi ukuran data yang
banyak digunakan, semakin hari
rasanya juga semakin besar.
Harddisk dengan kapasitas yang
sangat besar bisa dikatakan ku-
rang sesuai menggunakan
cluster dengan ukuran yang
kecil. Hal ini disebabkan
besarnya FAT yang akan
dihasilkan. PC+

ARE/PCplus
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Memasang Kamera
Video pada PC

Silvester Sila Wedjo
sila@e-pcplus.com

K

Kompatibilitas PC
dengan perangkat

multimedia yang lain
sekarang ini memang

boleh diacungi
jempol. Selain inter-

face yang dimiliki PC
cukup beragam, soft-

ware-software
aplikasi yang

mendukung juga
amat beragam. Tak

heran jika kemudian
dengan mudah para

pengguna
mengombinasikan

beberapa perangkat
multimedia sekaligus

dalam sebuah PC.

ompatibilitas
ini bisa dilihat
misalnya dari
kemampuan PC untuk

terkoneksi dengan kamera
video, baik dari kelas atas yang
menggunakan koneksi yang
canggih seperti firewire atau
USB, atau dari kelas “seadanya”
yang menggunakan koneksi
tipe analog macam kabel RCA.

PCplus mencoba
mengombinasikan PC dengan
kamera sangat standar yang
harganya tak lebih dari 200 ribu
untuk dipasang sebagai
webcam ataupun kamera
pengintai. Dengan

menggunakan kartu grafis yang
memiliki fasilitas port TV output
yang disambungkan ke Audio
Video Adapter plus sebuah kabel
konektor RCA, kamera murah-
meriah ini bisa terhubung ke PC.
PCplus juga mencoba dengan
memanfaatkan TV tuner yang
memiliki fitur port video-in.  Dan
ternyata pemasangannya sama
mudahnya dengan memasangnya
di kartu grafis.

Meski tergolong mudah, tak
ada salahnya jika Anda
mengetahui langkah demi
langkah pemasangan kamera ini
hingga gambar bisa terlihat
lewat monitor PC. Bukan apa-
apa. Karena kameranya murah
meriah, tidak diberikan
tambahan software atau apapun
oleh pabrik pembuatnya agar
gambar bisa ditangkap di PC.
Inilah langkah demi langkahnya

1. Sambung Jack
Video dan Audio
pada Port yang
Sesuai
Langkah pertama yang

dilakukan adalah menyambung-
kan kabel dan port penghubung
yang ada dengan tepat. Langkah
ini harus benar-benar diperhati-
kan agar sistem bisa mendapat-
kan gambar maupun suara
dengan benar. Pada langkah ini
Anda harus mencolokkan jack
video ke port video-in pada TV
tuner atau Composite-in pada
kartu grafis. Selain itu, Anda juga
bisa colokkan jack audio yang

tersedia pada kamera ke line-in
pada kartu suara agar suara juga
ikut terekam waktu Anda
merekam gambar.

2. Sambungkan
dengan Adaptor
Untuk tenaga listrik yang

dibutuhkan, langkah
selanjutnya adalah
menyambungkan jack power
ke adaptor yang tersedia.
Adaptor ini tinggal Anda
colokkan ke jala-jala listrik.
Umumnya, adaptor yang
digunakan adalah adaptor 8
volt 80mA biasa yang banyak
digunakan pula untuk
peralatan lain.

3. Instal Driver
WDM jika tidak
Disertakan
Driver atau
Software
Bawaan
Agar kamera ini bisa

kompatibel dengan kartu
grafis yang digunakan, instal
juga driver yang
berhubungan. Bila Anda
kebetulan menggunakan kartu
grafis nVidia, Anda bisa
menginstal nVidia WDM Driver

agar gambar dari kamera dapat
ditampilkan oleh software-
software yang kompatibel. Untuk
driver ini Anda bisa
mengambilnya dari bundel
software yang biasa diberikan
oleh pabrik pembuat kartu
grafisnya atau Anda dapat men-

download-nya secara langsung di
situs nVidia.  Cara
penginstalannya sendiri tidak

berbeda jauh dengan
penginstalan untuk driver kartu
grafis pada umumnya.

4. Coba pada Soft-
ware Aplikasi
yang Kompatibel
Setelah driver terinstal,

sekarang Anda bisa coba
gunakan kamera video ini
untuk berbagai keperluan.
PCplus misalnya meng-
gunakannya sebagai video
security, kamera video, dan
sebagai webcam pada
yahoo messenger seperti
layaknya menggunakan
webcam berbasis USB.

Sayangnya PCplus be-
lum bisa menggunakan
kamera ini untuk
NetMeeting, meskipun un-
tuk keperluan lainnya sama
sekali tidak ada masalah.
Bisa jadi ini lantaran kompa-
tibilitas kamera dengan
software ini kurang baik.

Nah, mudah kan cara
pemasangannya? Cuma
dibutuhkan ketelitian. Yang

pasti, kamera semacam ini akan
banyak gunanya buat
pengguna yang kreatif. PC+
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Hubungkan jarak kamera pada port yang
tepat agar bisa dilihat pada monitor
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Mobile Music Polyphonic

Membuat Dering
Ponsel Unik

Stem
Keyboard

KeyTweak

Quiz Master 1.2

Yuk, Bermain Kuis

Formasi penataan huruf untuk keyboard yang umum digunakan adalah
formasi QWERTY. Formasi ini ternyata bisa diubah. Misalnya QWERTY jadi ABCDEF.
Caranya dengan menggunakan KeyTweak, sebuah freeware berukuran 168 KB yang
dapat di-download dari webpages.charter.net/krumsick/.

Di KeyTweak, ada tampilan tombol keyboard dengan angka-angka. Perlu
diperhatikan bahwa angka-angka di situ bukan melambangkan karakter yang muncul
jika tombol ditekan. Untuk melihat karakter apa yang muncul jika tombol ditekan, klik
pada salah satu tombol, misalnya tombol nomor 8. Lihat pada bagian Keyboard
Controls. Di situ ada tulisan Key Selected : 8 is currently mapped to : 7.

Nah sekarang, bagaimana cara mengubahnya? Kita pakai lagi tombol nomor 8
yang tadi sudah diklik. Pada bagian Keyboard Controls ada Choose New
Remapping. Di sebelahnya masukkan karakter baru yang diwakili oleh tombol nomor
8. Setelah itu klik [Remap Key]. Remapping belum selesai. Perubahan baru disimpan di
dalam daftar Pending Changes. Setelah tombol [Apply] diklik, baru remapping
dilakukan. Sistem akan meminta agar kita me-restart PC. Hal ini karena KeyTweak
mengubah beberapa nilai dalam registry yang berhubungan dengan keyboard.

KeyTweak menyediakan tombol-tombol spesial, seperti Sleep, Power Off, e-
mail dan sebagainya, yang hanya ada di keyboard-keyboard tertentu saja. Dengan
KeyTweak, tombol yang tidak ada di keyboard kita bisa jadi ada. Tombol-tombol
spesial itu bisa dilihat di bagian Specialty Buttons.

Semua perubahan fungsi tombol keyboard dapat di-reset. Jadi jangan khawatir
kalau keyboard kita tidak bisa kembali ke konfigurasi awal. KeyTweak menyediakan
[Restore All Default] untuk mengembalikan fungsi tombol keyboard ke fungsi aslinya.

Alex Pangestu
alex@e-pcplus.com

Nada dering polyphonic sekarang  tidak lagi milik oleh ponsel-ponsel kelas
atas. Ponsel-ponsel “murah” pun bisa bernyanyi merdu. Walaupun ponsel sudah diisi
dengan dering-dering indah, kadang-kadang masih muncul rasa kepingin unik, lain
daripada yang lain. Salah satu cara untuk memperoleh nada dering polyphonic adalah
dengan menggunakan PC. Bahkan tidak hanya sebagai “tukang antar”, tapi bila ada
aplikasi pendukung, PC dapat digunakan untuk membuat nada dering polyphonic.
Aplikasi yang akan dibahas di rubrik ini adalah Mobile Music Polyphonic.

Mobile Music Polyphonic dapat digunakan untuk membuat nada dering
polyphonic. Aplikasi ini menyediakan template berupa partitur not balok yang masih
kosong. Jadi bagi yang bisa menulis not balok, bisa menciptakan jingle sendiri. Bagi
yang tidak bisa, cari saja partitur dari buku. Terus disalin di Mobile Music Poly-
phonic. Tapi partitur yang digunakan lebih baik partitur yang sederhana karena
Mobile Music Polyphonic tidak menyediakan jeroan-jeroan untuk membuat partitur
yang rumit. Partitur yang sudah dibuat bisa di-review dengan menekan tombol Play
yang terletak di sebelah kiri, berbentuk segi tiga. Setelah sesuai keinginan, baru
partitur disimpan dalam bentuk SMAF (*.mmf) atau MIDI (*.mid). Biasanya nada
dering untuk ponsel bertipe SMAF.

Selain membuat sendiri, Mobile Music Polyphonic bisa digunakan untuk
menghasilkan SMAF dari MIDI, MP3 atau WAVE (*.wav). Caranya dengan membuka
file MIDI, MP3 atau WAVE, kemudian klik Save As, yang dilambangkan dengan ikon
disket dengan tulisan As. Pilih disimpan dengan tipe SMAF. Lebih asyik lagi, Mobile
Music Polyphonic bisa menyimpan bagian lagu yang dipilih, misalnya bagian refrain
saja. Yang harus dilakukan adalah mencari posisi refrain pada gelombang suara.
Kemudian diblok sampai posisi akhir. Baru pilih Save As.

Mobile Music Polyphonic tidak bisa langsung memindahkan nada dering dari
PC ke dalam ponsel. Jadi untuk memindahkannya, kita membutuhkan software lain,
tergantung dari jenis ponsel yang kita miliki.

Silakan jenguk www.ringtone4me.com untuk memperoleh Mobile Music
Polyphonic yang merupakan shareware dengan batasan fungsi tertentu. Misalnya,
kita hanya bisa meng-convert file MP3 menjadi SMAF selama satu detik. Lalu kita
hanya bisa menyimpan partitur dengan panjang 5 not saja. Untuk memperoleh fungsi
penuhnya, siapkan uang sebesar US$29.

Alex Pangestu
alex@e-pcplus.com

Ada beberapa acara kuis yang sedang in saat ini. Contohnya Siapa Berani,
Who Wants to be a Millionaire?, dan lain lain. Tentu ada keinginan untuk mengikuti.
Namun bila Anda belum beruntung untuk ikutan kuis seperti itu, Anda bisa mencoba
software ini. Hitung-hitung buat latihan sebelum memperoleh kesempatan ikutan
acara kuis yang sebenarnya.

Software yang bernama Quiz Master akan membantu Anda untuk menguji
kemampuan intelektual Anda. Software ini memiliki beberapa kategori pertanyan
kuis, yaitu astronomi, biologi, geografi, teknologi informasi, tumbuhan, dan lain-lain .
Quiz Master yang berukuran hanya 180 KB ini memiliki database pertanyaan yang
berisi 250 pertanyaan dengan 10 kategori.

Quiz Master juga bisa ditingkatkan kemampuannya, karena dilengkapi dengan
utiliti untuk membuat soal-soal yang akan diujikan sesuai dengan bidang yang Anda
inginkan. Anda dapat berkreasi soal kuis melalui [Menu]>[Build]. Setelah jendela Quiz
Database Builder muncul, klik [New]. Anda tinggal  mengikuti langkah selajutnya
melalui panduan Quiz Master ini.

Quiz Master memiliki ScoreBoard untuk mengetahui seberapa jauh Anda sudah
menjawab soal. Quiz Master ini menggunakan Visual Basic. Jadi untuk
menjalankannya pastikan Windows  sudah terinstal Visual Basic 6 Run Time.

Anda tidak perlu melakukan register karena software ini bersifat freeware.

Program ini dapat anda peroleh di www.freewarefiles.com. Program Quiz Master
dapat berjalan pada Win 98, Win ME dan Win XP. Selamat  bermain!

Ahmad  Syarif  Zein
syarifzein@yahoo.com
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WinRoute Lite

Software
Berkemampuan

Trojan

Remote Administrator

Berbagi Koneksi
Internet

Jika Anda mempunyai 2 PC atau lebih di dalam rumah atau
kantor yang sudah terhubung dalam sebuah jaringan, dan salah satu
dari komputer memiliki akses Internet, Anda bisa membagi koneksi
internet tersebut ke PC yang lain. Fungsi ini sudah tersedia di
Windows. Tetapi dengan software Winroute Lite proses pembagian
koneksi akan menjadi lebih sederhana. Winroute Lite memang
dibuat untuk memudahkan sebuah jaringan untuk berbagi koneksi
Internet.

Penggunaan software ini sangatlah mudah, pada modul Set-
tings sudah diberi gambaran tentang pengaturan jaringannya.
Dengan demikian, mempermudah user dalam menggunakan soft-
ware ini.  Jika masih mengalami kesulitan ikuti langkah berikut ini. PC
Anda yang memiliki akses Internet kita namakan server. Sedangkan
PC-PC lain yang menerima kita beri nama klien. Berikut ini cara
pengaturannya:
1. Instal Winroute Lite pada server.

2. Masuklah ke bagian Settings. Di sini Anda harus mengatur jenis
koneksi yang Anda gunakan, apakah koneksi Anda menggunakan
modem dial-up (modem, ISDN ) atau network adapter (T1,
modem kabel, dan lain-lain)

3. Jika mau mengatur jaringan Anda lebih spesifik, Anda bisa masuk
ke Advance Settings, disni anda bisa mengeset DHCP, DNS, Port
Mapping, dan Security.

4. Langkah terakhir adalah mengubah pengaturan IP pada klien.
Biasanya kita menggunakan IP static, yaitu IP yang sudah kita
tentukan secara manual. Jika kita menggunakan IP static maka
pada PC klien, kita harus menambahkan Gateway dan DNS Server
yang isinya adalah nomer IP server. Misalkan server kita
menggunakan IP 192.168.1.1 maka Gateway dan DNS untuk PC
klien adalah 19.168.1.1.  Jika kita menggunakan DHCP pada
Winroute Lite yang artinya kita menggunakan IP dynamic, maka
pada PC klien baik IP, Gateway dan DNS Server di-automatic saja.
Jangan lupa untuk me-restart PC Anda .Jika ingin mempelajari

Winroute Lite lebih lanjut Anda bisa menggunakan Help dari
software ini.

Winroute Lite bisa didapat dari situs www.kerio.com. Software
yang Anda dapat berupa trial. Anda hanya dapat menggunakannya
dalam waktu 30 hari. Jika ingin menggunakannya lagi, Anda harus
membelinya dengan harga US$79.

Bowon
b0w0n@yahoo.com

Pengguna Internet atau penggemar dunia komputer, pasti
mengenal apa itu Trojan. Namun software
yang satu ini bukanlah Trojan, tetapi
memiliki kemampuan seperti Trojan, yaitu
menyusup untuk mengendalikan PC lain
alias melakukan remote access. Software itu
bernama Remote Administrator yang
dapat kita gunakan untuk melakukan
terhadap akses PC yang ada di dalam suatu
jaringan atau koneksi Internet, yang
memiliki sistem operasi Windows, secara
GUI (Graphical User Interface).

Software yang ukurannya sebesar 1,3
MB ini dapat di-download melalui access-
remote-pc.com. Remote Administrator
bersifat shareware dengan batasan
pemakaian sebanyak 30 kali. Software ini
dihargai US$35.

Selesai mengekstraksi dan
menginstalnya, akan muncul pertanyaan:
apakah ingin menginstal server? Check
kotak tersebut. Kemudian pada Remote
Administrator di server aktifkan Start
Remote Administrator Server. Pada PC
lain di LAN lakukan hal yang sama, hanya
pada Remote Administrator pilih Re-
mote Administrator Viewer.

Buatlah koneksi baru dengan mengklik

[Connection to...]>[New], yang diikuti dengan pengisian IP Address
dan klik tombol [Connect]. Kemudian mucul layar dan siap untuk
melakukan remote pada PC yang terinstal server. Selama koneksi kita
bisa mentransfer file apa saja yang kita inginkan, mengakses telnet,
bahkan mematikan PC.

Penulis mencoba Remote Administrator pada dua PC yang
terhubung pada LAN. PC dengan sistem operasi Window XP
digunakan sebagai PC yang terinstal server dan Windows 98 sebagai
viewer-nya. Koneksi berjalan dengan baik.

Iqra Gantira
iqragantira@hotmail.com

Winroute 1 Winroute 2
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Kamera Video:
Penyambung Mata
Masyarakat Modern

Vincent Bayu T.B
vincent@e-pcplus.com

Zaman boleh berlalu
dan berganti, namun

naluri untuk
berkomunikasi dengan
melibatkan tatap muka

tidak bisa dipisahkan
dari kehidupan dan

peradaban manusia.
Boleh saja telepon

digunakan untuk
bercakap-cakap dan

untuk sementara
waktu hal seperti itu

sudah dianggap cukup.
Tapi manusia tetap
ingin lebih. Naluri

mereka tak mungkin
dipupus dan keinginan
untuk menatap secara

visual tetap mendo-
rong mereka mencari

alat yang memungkin-
kan untuk itu.

alam
perkembangannya,
komputer menjadi otak
besar peradaban

manusia modern dengan
kemampuannya menjalankan
berbagai peralatan, mulai dari
kamera digital, kamera video,
televisi dan radio, internet,
hingga sarana hiburan pemutar
musik dan game. Peralatan yang
bisa mensimulasikan komunikasi
langsung (real-time) dalam hal ini
adalah kamera video.  Suara,
gambar bergerak, disinkronkan
menjadi satu wahana kontak

langsung.  Lalu, apa saja contoh
ragam kegunaan kamera video
yang sampai saat ini populer dan
dinilai sangat membantu?

Security
Personil penjaga keamanan

dapat saja terlena, karena keter-
batasan fisik dan panca indera.
Oleh karena itu, kamera video di
banyak instansi digunakan untuk
mendukung upaya pengamanan
dan pengawasan.  Bisa
dibayangkan, jika personil yang
harus melakukan tugas itu dari
sudut-sudut pandang yang sulit
dan bertujuan agar tidak terlihat
atau tidak terduga oleh target
pengawasan.

Beberapa produsen kamera
video pengawasan saat ini
bahkan telah memperkenalkan
produk mereka yang

dikamuflasekan ke dalam benda-
benda yang menunjang sisi
estetik dari sebuah area atau
ruangan, misalnya: di balik
lukisan, patung, jam dinding,
kipas angin, jam meja, radio
portabel, lampu dinding, antena,
speaker, boneka monyet,
detektor asap, tanaman hias,
peraut pensil, tas tangan, lampu
duduk, pembersih udara, lampu
meja dan sebagainya.

Kamera-kamera video yang
dipasang untuk keperluan ini
dapat juga dijadikan sarana
pelacak kejahatan sekaligus
dijadikan barang bukti terhadap
suatu tindak kriminal. Detail
pelaku kejahatan dapat diamati
dan dicermati dari rekaman
kamera pengawas.  Barang-
barang yang dijadikan alat dalam
melakukan kejahatan, perilaku
saat melakukan kejahatan dapat
menyingkap modus operandi dan
ciri khas pelaku kejahatan. Salah
satu bukti yang diselidiki lebih
lanjut oleh polisi dalam kasus
bom di Hotel Marriott, Jakarta,

adalah kamera yang
tersembunyi ini.

Satu hal yang perlu
diperhatikan dalam
instalasi kamera video
pengawas adalah
tersedianya sumber daya
cadangan untuk
mengantisipasi
kemungkinan rusaknya
sumber daya utama
kamera video
pengawas.  Contoh-
contoh instansi yang
menggunakan fasilitas
kamera video pengawas
antara lain: bank, hotel,
department store,
kantor kedutaan asing,
instalasi militer, lembaga
pemasyarakatan, bahkan
rumah-rumah pribadi,

dan pabrik-pabrik yang ketat
dalam melindungi rahasia
perusahaan.

Presentasi, Display
Demo, dan
Pertunjukan

Masyarakat masa kini, tidak
dapat dipungkiri, menyukai
kegiatan-kegiatan yang bersifat
instan dan massal. Tontonan dan
demo menjadi alat yang ampuh
dalam menyedot dan membetot
perhatian massa, apalagi jika hal
tersebut dilakukan di public area
atau pusat keramaian. Presenter
atau talent (bintang pertunjukan)
tak ayal akan tenggelam dalam
massalitas dan besarnya jumlah
audiens.  Untuk menjembatani
hal tersebut dan menjaga
efektifitas pesan pada semua
audiens, layar display yang meng-

cover pusat perhatian sangat
membantu.  Dengan demikian,
seluruh audiens dapat menyimak,
menirukan, dan mengingat
kegiatan yang menjadi pusat
perhatian.

Presentasi dan demo saat ini
tidak terbatas pada briefing,
rapat kalangan eksekutif, dan
kegiatan-kegiatan belajar-
mengajar. Kegiatan marketing di
pusat-pusat keramaian,
pertunjukan musik dan kesenian
merupakan bentuk presentasi
yang lain karena berbagai
kegiatan tersebut pasti memiliki
satu pesan utama yang harus
dikomunikasikan. Dua instrumen
utama yakni kamera video dan
layar display merupakan
penyambung lidah bagi presenter
dan talent. Di sisi lain, kamera
video dan layar display juga
merupakan “penyambung mata
dan rasa” bagi audiens.

Dilihat dari sisi perlengkapan
pendukung presentasi berbasis
video, kamera video berukuran
kecil yang bisa dihubungkan
langsung ke proyektor, proyektor
dengan tingkat kecerahan (ANSI
lumens) tinggi menjanjikan
penyatuan makna antara
komunikan dan audiens.

Chatting
dan Teleconference

Mungkin, adegan film atau
drama romantis tentang lakon
yang sedang menulis surat sambil
memandangi foto sang kekasih
saat ini dapat dinilai ketinggalan
zaman. Mengetikkan kata-kata

sambil memandangi gerak-gerik
dan perubahan ekspresi wajah
lawan komunikasi lewat webcam
merupakan cara berkomunikasi
instan yang menjanjikan bonus
terpenuhinya kerinduan akan
rasa kedekatan.

Lebih jauh, komunikasi bisa

menjadi semakin pribadi karena
para komunikan tidak perlu pergi
ke penyedia jasa layanan
komunikasi.  Mereka bisa
melakukannya dari rumah, dari

kamar pribadi tanpa intervensi
orang lain.

Produsen kamera digital
tidak kalah gesit dan jeli dalam
memanfaatkan peluang dari
semakin “ngepop”nya chatting
dan teleconference.  Mereka
menambahkan fungsi webcam ke

produk kamera digital mereka
sehingga user bisa
memanfaatkannya untuk
chatting berbasis video.  Sarana
perekam gambar gerak (video)
dalam kamera digital saat ini
juga memungkinkan user me-
ngirimkan rekaman video mereka

D

selama beberapa menit lewat
Internet.  Menariknya, kamera
digital model ini ditawarkan
dengan harga yang terjangkau.

Nanny
Coba kita

renungkan,…semaju dan
semodern peradaban masyarakat
kita, tetap saja belum ada yang
namanya “sekolah menjadi orang
tua”.  Salah satu fungsi parental
yang semakin tak berdaya dilibas
kehidupan modern adalah
pengawasan.  Menyikapi hal
tersebut, saat ini mulai dikenal
pemanfaatan teknologi
komunikasi berbasis video untuk
mengawasi anak, khususnya
balita.

Kamera video yang tersem-
bunyi dan tidak menakutkan si
anak (mulai dari yang berbentuk
boneka Teddy Bear, radio, sampai
peraut pensil) memiliki kemam-
puan untuk menggantikan mata
orang tua, meskipun tidak akan
pernah bisa menggantikan peran
psikologisnya.

Jurnalistik
Pernahkah Anda melihat

sudut-sudut pandang sulit dalam
tayangan olahraga, misalnya saja
rekaman laju motor Repsol
Honda milik Valentino Rossi dari
balik stang/kemudi, atau bahkan
dekat ban? Atau rekaman
balapan F-1 saat kendaraan Ralf
Schumacher ditubruk Rubens
Barrichello dan Kimi Raikkonnen.
Rekaman tersebut diambil
dengan menggunakan kamera
video mini berteknologi wireless.

Sayangnya, fungsi kamera
video mini tersebut dalam
perkembangannya saat ini sering
disalahgunakan untuk
menampilkan “insting primitif”,
yaitu penyebaran rekaman
“colongan” yang melecehkan
gender, seperti: rekaman dari
kamar mandi, kamar ganti,
kamar hotel, dan sebagainya.
Sungguh, pada akhirnya wajah
teknologi tetap ditentukan oleh
mentalitas, moralitas, dan
itikad dari masyarakat
penggunanya. PC+

Kamera dalam bentuk boneka untuk mengawasi anak/balita

Kamera dengan ukuran sanat kecil, dalam bentuk keping mata
uang

Kamera dalam bentuk jam meja untuk
sudut pandang sejajar target
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Perangkat multimedia
semacam kamera video

ternyata dapat
diaplikasikan untuk
beragam keperluan

seperti sebagai kamera
pengawas, webcam,

kamera video, maupun
untuk teleconference.
Beragam perusahaan

software pun terus
mengembangkan

fungsi kamera video ini
untuk beragam

keperluan yang cukup
menarik. Uniknya,

fitur-fitur yang
dikembangkan oleh

masing-masing
pembuat software

menawarkan
kemudahan dan

kenyamanan yang
sangat membantu

penggunanya untuk
keperluan tertentu.

alau dulu kamera
video semacam ini
hanya digunakan untuk
keamanan gedung atau

ruang saja, belakangan fungsinya
makin melebar. Dengan pesatnya
kemajuan teknologi Internet
misalnya, kamera video semacam
ini kemudian bisa dijadikan alat
yang sangat efektif untuk
berkomunikasi melalui telecon-
ference. Bahkan, untuk
pengguna-pengguna tertentu,
kamera semacam ini digunakan
sebagai perangkat pendukung
seperti “nanny” alias pengasuh
dari jarak jauh.

Itu semua bisa terjadi, tak
lain karena adanya software yang
memungkinkan penggunaan
kamera secara remote. Alhasil,
pengontrolan penggunaan
kamera ini bisa dilakukan dari
jarak jauh!

Menariknya, beberapa
produsen perangkat multimedia
seperti kartu grafis ataupun TV
tuner juga membundel software
menarik yang memungkinkan
kamera video bisa difungsikan
untuk berbagai keperluan, baik
untuk pembuatan video
sederhana, hingga video security
dengan bermacam-macam fitur
unggulannya. Ini tentu saja
membuat penggunaan kamera
video semacam ini semakin
“membumi”.

Berikut adalah beberapa
contoh software aplikasi menarik
yang bisa digunakan untuk
memaksimalkan penggunaan
kamera video untuk berbagai
keperluan.

Honestech MPEG
Security

Merupakan salah satu
software yang cukup baik untuk
digunakan untuk sistem
keamanan dengan menggunakan
kamera. Meski fiturnya tergolong
standar, software ini cukup
mudah untuk digunakan.

Fitur yang tersedia
memungkinkan penggunanya
untuk merekam pergerakan yang
ditangkap kamera video berupa

Silvester Sila Wedjo
sila@e-pcplus.com Software-software

Aplikasi Kamera Video
pada PC

K

gambar. Bila perangkat yang
digunakan juga memungkinkan,
suara yang muncul saat ada
pergerakan pun bisa ikut
ditangkap dengan software ini.
Fitur lain adalah adanya bunyi
alarm yang akan terdengar
begitu kamera menangkap

pergerakan. Menariknya,
software ini juga dilengkapi
dengan fasilitas schedule,
sehingga penggunanya bisa
mengatur kapan software ini
mulai bekerja.

Sama seperti software
security yang lain, Honestech ini
juga dapat melakukan
pengiriman e-mail secara
otomatis ke penggunanya begitu
kamera menangkap adanya
pergerakan di area yang diawasi.
Uniknya, pada Honestech MPEG
Security, yang dapat di-download
versi demonya secara gratis,
pengguna juga bisa mengatur
ukuran gambar yang akan
direkam, kualitas gambar, dan
lokasi penyimpanan capture. Tak
lupa disertakan pula fitur untuk
mengatur sensitivitas deteksi.

Asus-Video Security
Software ini merupakan

software bawaan dari TV Tuner
Asus yang dapat difungsikan

sebagai software untuk
pengawasan. Dahulunya,
software ini juga dibundel untuk
beberapa tipe kartu grafis yang
diproduksi oleh perusahaan asal
Taiwan ini.

Fitur-fitur yang
ditawarkannya sebetulnya

hampir sama dengan yang lain.
Fasilitas utama yang disediakan
adalah jendela untuk melihat
tampilan gambar yang dihasilkan
kamera video. Fitur-fitur yang
dimiliki antara lain adalah
kemampuannya untuk mengatur
sensitifitas pendeteksian yang
bisa diatur sesuai keperluan.
Kemampuan penangkapan
gambar juga bisa diatur sesuai
kebutuhan dan kemampuan
hardware yang dimiliki.

Salah satu fitur unik yang
dimiliki software ini adalah
kemampuannya untuk
menentukan area deteksi sesuai
dengan kebutuhan. Pengguna
dapat menentukan daerah yang
akan membuat kamera
melakukan perekaman secara
otomatis, cukup dengan
menggunakan mouse. Alhasil,
meski kamera menangkap
gambar pada area yang lebih
besar, kamera hanya akan
melakukan perekaman begitu

Dapat mengirim e-mail secara otomatis

Mampu menentukan area deteksi
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daerah deteksi yang telah
ditentukan tersebut “dimasuki”
oleh seseorang. Adanya fitur
semacam ini jelas bisa
menghemat ruang di harddisk
karena sistem hanya akan
melakukan capture jika
seseorang memasuki area yang
telah ditentukan saja.

Software ini juga dilengkapi
dengan suara alarm yang akan
berbunyi jika mendeteksi adanya
pergerakan yang tidak
diinginkan pada detect region
yang ditentukan. Uniknya,
perekaman gambar ini bisa
dilakukan berulang kali atau
sekali saja, tergantung setting
dari penggunanya.

Software yang disertakan
ini punya kemampuan untuk
melakukan penanganan lebih
lanjut jika video menangkap
pergerakan yang tidak

diinginkan. Software ini
memberikan kemungkinan
untuk melakukan pengiriman
tanda bahaya lewat email,
handphone, telepon rumah,
menjalankan software tertentu,
atau perekaman secara
otomatis begitu ada bahaya
mengancam.

Yahoo Messenger
Kamera video juga bisa

digunakan sebagai pelengkap
chatting. Kemampuan ini
misalnya didapati pada Yahoo
Messenger yang menyediakan
fasilitas webcam. Dengan adanya
fasilitas ini, selain text dan suara,
para chatters juga dapat melihat
wajah lawan bicara secara online.

Namun begitu, performa
webcam semacam ini sangat
tergantung dari resources yang
dimiliki. Pada Yahoo Messenger

misalnya kecepatan gerak
gambar amat tergantung pada
koneksi maupun perangkat
pendukung yang digunakan. Bila
koneksinya baik, gambar yang
terlihat oleh lawan bicara tidak
akan terlihat terputus-putus.

Sama seperti webcam yang
berbasis USB, untuk menjalankan
kamera video yang difungsikan
sebagai webcam ini pengguna
tinggal mengklik tombol
[Tools]>[Start My
Webcam]>[Ok].

WinDVD Creator
Software ini bisa

menggunakan kamera
video untuk keperluan
video editing atau yang
lain. Sama seperti soft-
ware pengolah video
lainnya, disediakan
fasilitas capture video

yang
memungkinkan
pengambilan
gambar secara
langsung lewat
kamera video yang
ada.

Fitur-fitur
pendukung
penggunaan video
kamera pada
software ini
tergolong standar.
Sama seperti
software aplikasi
pengolah video
yang lain, WinDVD
Creator juga
menyediakan fasilitas
pemilihan sumber video
dan audio, format
perekaman, maupun
standar video yang

digunakan. Untuk melakukan
perekaman gambar dari kamera
secara langsung, pengguna
tinggal mengklik tombol
[Record] yang disediakan.
Penggunaan kamera video
untuk pengolahan audio video
dengan software ini memang
tergolong mudah, meski fitur
yang diusung boleh dibilang
standar.

Adobe Premiere
Adobe Premier ini adalah

salah satu software pengolah
video yang memiliki fasilitas
capture secara langsung dari

kamera standar.
Fitur untuk capture yang

dimiliki software ini boleh
dibilang sangat lengkap. Jika
capture telah selesai, Adobe

Premiere secara langsung akan
menginformasikan jumlah
frame yang terekam,
formatnya, ukuran file, durasi,
dan sebagainya.

Setting-setting yang bisa
diutak-atik untuk capture video
ini juga cukup banyak, mulai
dari ukuran gambar, format,
banyaknya frame yang
ditangkap untuk tiap detiknya,
ukuran rate video, dan lain
sebagainya.

Masih banyak software-
software lain yang dapat
digunakan buat beragam
aplikasi yang memanfaatkan

kamera video mini. Yang pasti,
kamera video pada PC bisa
digunakan untuk beragam
keperluan, asal software yang
dipakai cukup memadai. PC+

Salah satu kunci
terpenting dalam

pengoperasian kamera
video untuk berbagai

keperluan adalah
transmisi data atau

koneksi yang
digunakan. Yang juga

tak kalah penting
diperhatikan adalah

untuk keperluan apa
kamera tersebut

dipasang.

pabila video
hendak dimanfaatkan
untuk keperluan
remote seperti untuk

teleconference atau chatting,
maka diperlukan jaringan
pentransmisi seperti Internet.
Untuk menghasilkan kualitas
gambar yang memadai, transmisi
video ini memerlukan jalur yang
lebar dan didedikasikan khusus
untuk itu (dedicated line).
Apabila sekadar memanfaatkan
jaringan Internet berbasis dial-up,
gambar yang ditangkap akan
terlihat patah-patah dan tidak
bisa menghasilkan gambar yang
maksimal (terjadi delay time).

Saat ini, sudah banyak
organisasi atau perusahaan yang
sudah memanfaatkan kamera

Alois Wisnuhardana
wisnu@e-pcplus.com Perkara Transmisi

dan Implementasi dalam
Kamera Video

A

video berbasis jaringan untuk
berbagai keperluan. Salah
satunya adalah jajaran kepolisian.
Kepolisian RI memanfaatkan
teknologi kamera video ini di
beberapa kantor kepolisian
daerahnya. Beberapa di antara
yang sudah terpasang adalah
kantor Polda Jatim dan Bali.

Di Kepolisian Daerah Bali,
kamera video ini dipasang di
kantor Kepala Kepolisian Daerah
Bali dan juga di tempat
persidangan kasus bom Bali.
Dengan demikian, setiap saat
Kapolda bisa memantau
perkembangan sidang bom Bali.
Demikian juga di markas besar
kepolisian di Jakarta. Untuk di
Jawa Timur sendiri, bahkan sudah
terdapat 12 titik kamera yang
terpasang yang bisa
dimanfaatkan untuk berbagai
keperluan. Di antara 12 titik
lokasi pemasangan kamera itu
adalah kantor Kapolda Jatim,

kantor Polwiltabes Surabaya,
Bundaran Waru, Jalan Jenderal
Sudirman, kawasan Bambu
Runcing, gedung DPRD tingkat I
dan DPRD tingkat II serta gedung
Grahadi (kantor gubernur).

Sementara itu, di lingkungan
perusahaan yang sudah
memanfaatkan pengoperasian
kamera video di kantornya
adalah perusahaan tambang/
perminyakan Vico. Saat ini,
menurut Sugiarto atau lebih
sering dipanggil Hoky, direktur
PT Masterdata yang menangani
instalasi pemasangan kamera
video ini, proyek tersebut tengah
dalam pengerjaan.

Masterdata menggunakan
teknologi transmisi jaringan
Internet ISDN untuk
mentransmisikan data-data video
dari lokasi penambangan Vico di
Balikpapan ke kantor pusat di
Jakarta, sementara di lokasinya,
terdapat beberapa cara

pemasangan. Pada beberapa
bagian, digunakan kabel biasa
sedangkan di beberapa bagian
yang tidak memungkinkan untuk
ditarik kabel, “Kami
menggunakan kamera video
wireless,” ujar Hoky. Untuk
sementara, mau tidak mau
mereka menggunakan frekuensi
2,4GHz untuk keperluan transmisi
data.

Selain Vico dan Kepolisian RI,
Hoky juga terus mensosialisasikan
penggunaan kamera video ini
untuk berbagai keperluan bisnis.
Salah satunya adalah jaringan
supermarket Yogya Department
Store. Menurut Hoky, IT Center di
Roxy Square, Jakarta rencananya
juga akan diterapkan
penggunaan kamera video ini.

Dengan adanya infrastruktur
ini, setiap pelanggan bisa
mengakses informasi yang
bersifat live dari tempat
dipasangnya kamera video

melalui PC yang terhubung ke
jaringan internet. Bahkan, saat
ini, ponsel pun bisa digunakan
untuk memantau keadaan di
tempat dipasangnya kamera.

Dari sisi konsumen,
penggunaan kamera video
semacam ini untuk saat
sekarang memang masih belum
populer karena masih mahalnya
teknologi dan infrastruktur
yang harus dipasang. Akan
tetapi, bagi orang-orang yang
memiliki anggaran lebih, boleh
jadi masalahnya memang
bukan di anggaran tapi
pengetahuan akan manfaat
yang mereka terima serta
teknis pemasangannya.

Namun, Hoky optimis bila
suatu saat masyarakat akan lebih
terbuka melihat manfaatnya,
sementara dari sisi teknologi pun
harganya akan semakin murah.
“Oleh karenanya, kami terus
berpromosi,” tutur Hoky.  PC+

Fasilitas capture sangat lengkap

Dapat digunakan untuk Video Editing
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Codec XMMS Mpg 123
Agar Bisa Memutar MP3

U

Bukan hal yang
mengherankan jika
banyak pertanyaan

mengapa XMMS
(WinAmp-nya Linux),
terutama pada distro

Redhat dan Mandrake
versi 8 ke atas tidak

bisa memutar mp3. E-
mail Redaksi PCplus

juga “dibanjiri”
pertanyaan serupa.

sut punya
usut, ternyata
format file audio mp3
dinilai bersifat komersil

dan tidak lagi di-support oleh
pengembang Linux. Linux telah
menyediakan format file audio
.ogg (Ogg Vorbis) yang free,
lebih kecil ukurannya, tapi lebih
bagus kualitasnya. Tetapi…...,
jangan khawatir. Komunitas
Linux telah menyediakan
semacam codec yang bila
“dipasangkan” pada XMMS
memungkinkan mp3 bisa kita
putar kembali. Berikut ini
langkah-langkahnya.
1. Download-lah file codec

XMMS Mpeg 123 dari URL
http://havardk.xmms.org/
dist/xmms-1.2.7-rh8-rh9-
rpm atau dari
www.xmms.org. File ini
gratis, berekstensi RPM dan
berukuran kecil (98,5 KB)
sehingga bisa disimpan dalam
disket 3,5 inci. Artinya, dapat
di-install dengan perintah

teks # rpm –ivh nama-
file.rpm  maupun di-install
langsung lewat RPM manager.

Kita lakukan saja cara yang
kedua (lebih mudah).

2. Login sebagai root. (Main
Menu>Logout, lalu isi ID
dengan root dan masukkan
password root).

3. Letakkan file xmms mpeg
123.rpm tersebut di direktori /
usr/local/src. Jika Anda

kesulitan mencarinya, klik ikon
home di desktop. Klik
direktori root ( / ) yang

merupakan direktori paling
atas di sistem file Linux

(plusLinux edisi 132). Direk-
tori /root dapat juga diakses
dengan menekan tombol up

sampai direktori paling atas.
Secara berurutan (dengan klik

ganda pada folder), buka
direktori /usr, lalu /local, dan
selanjutnya /src.  Letakkan file

xmms mpg 123.rpm di
direktori /src tersebut.

4. Klik ganda file xmms
mpg.rpm.  Secara otomatis,
proses install akan berjalan

sampai selesai.
5. Jika Anda ingin

menyalin file mp3 dari
partisi Windows,
lakukan mounting.
Sebelumnya, periksa
lokasi partisi Windows
dengan perintah # df
–h.  Lakukan perintah
# mount  –t  msdos
/dev/lokasi partisi /
mnt.  Dalam contoh,
lokasi partisi Windows
ada di hda1, maka
perintahnya adalah
#mount  -t  msdos  /
dev/hda1  /mnt.

6. Klik ganda ikon home
di desktop, lalu buka
direktori /mnt. Kita
bisa mengakses partisi
Windows, menyalin
file dari sini. Buka
folder di partisi
Windows yang berisi
file mp3, salin file-file
tersebut (klik kanan,
pilih Copy Files).

7. Klik ganda ikon
home, lalu buka fol-
der /home. Buatlah
folder baru untuk
lagu-lagu kita. Letak-
kan (paste) salinan file
mp3 di folder baru ini.

8. Klik [Main Menu]>
[Sound&Video]> [Au-
dio Player].  Klik tom-
bol playlist.  Masuk-
kan lagu-lagu mp3.  Pi-
lih lagu (sorot), kemu-
dian klik tombol play.

Sampai di sini, kita
tetap bisa menikmati file
mp3, sambil mempersiap-

kan penggunaan file .ogg (Ogg
Vorbis).  Selamat mencoba! PC+

M
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n
 m

en
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Ikon  Home
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GIMP:

Another
Cleopatra’s

Cat

Vincent Bayu T.B.
vincent@e-pcplus.com

Bahasan kali ini meru-
pakan lanjutan papa-

ran sekilas tentang
GIMP pada  plusLinux

141 dan 142.

ika dua edisi
tersebut memaparkan
letak dan fungsi
berbagai fasilitas

maupun alat kerja (dibandingkan
dengan Adobe Photoshop), maka
kali ini redaksi mencoba
menyajikan praktek penggunaan
GIMP.

J

Oke, kita telah mencoba tidak tergantung pada suatu alat kerja. Jangan sampai
kreativitas dibatasi alat kerja! PC+

1. Buka foto bahan dasar, dengan klik menu [File] > [Open] pada Toolbox.
2. Sederhanakan (crop) foto dengan klik kanan mouse pada bidang foto, klik menu

[Tools]>[Transform Tools] > [Crop & Resize]. Drag di bidang kerja untuk mem-
bentuk bidang crop.  Geser handle point di kanan bawah atau kiri atas untuk
mengubah lebar bidang crop.  Klik tombol Crop di dialog box Crop & Resize.

3. Klik menu [File] > [Dialogs] > [Layers, Channels, & Paths] pada Toolbox. Klik
ganda layer Background, kemudian ubah nama layer (pada Layer Properties)
dengan nama Dasar.

4. Klik kanan mouse pada bar (batang) layer Dasar, lalu pilih [Duplicate Layer].
Klik ganda layer Dasar Duplicate dan ubah namanya dengan Mata Kanan.

5. Aktifkan layer Mata Kanan, lalu buat seleksi pada mata kucing sebelah kanan
dengan Select Rectangular Regions Tool di Toolbox. Balik seleksi dengan klik
kanan mouse pada bidang gambar, lalu pilih menu [Select] > [Invert].  Hapus
bagian yang tidak diperlukan dengan klik kanan mouse lagi, lalu pilih menu [Edit]
>[Clear].

6. Ulangi langkah 4, lalu beri nama layer dengan Mata Kiri. Buat seleksi pada
mata kiri kucing, lalu bagian tak perlu seperti langkah 5.

11. Aktifkan layer Mata Kanan, terapkan filter Supernova dengan klik kanan pada
bidang gambar, pilih menu [Filters] > [Light Effects] > [Supernova].  Atur letak
flare , diameter dan pancarannya di dialog box. Lakukan hal yang sama pada
layer Mata Kiri. Simpan (Save) pekerjaan Anda.7. Aktifkan layer Mata Kanan. Kurangi bintik kilatan cahaya pada pupil mata

dengan Paint with Pattern Tool (Clone Tool) di Toolbox.  Kita mengambil sampel
dengan menekan terus tombol [Ctr] dan klik di daerah sampel. Kuat-lemahnya
semprotan (tebal-tipisnya) semprotan diatur dengan menggeser slider Tool
Opacity.  Klik ganda tool bersangkutan untuk menampilkan dialog box Tool
Opacity.

8. Aktifkan layer Mata Kiri, lakukan seperti pada langkah 7.

9. Aktifkan layer Dasar, klik kanan pada layer tersebut, pilih [Duplicate
Layer]. Tempatkan di urutan layer paling atas. Atur Level untuk
menggelapkan bulu (klik kanan di bidang gambar, pilih menu [Image]
>[Colors]> [Level]).

10. Beri masking dengan klik kanan pada duplikat layer tersebut dan pilih
[Add Layer Mask]. Pilih nada gelap, gunakan Paint Fuzzy Brush Tool untuk
menyapu dan menyembunyikan bagian mata kucing di layer ini. Kuat-
lemahnya sapuan kuas diatur dengan cara yang sama pada langkah 7 (klik
ganda Paint Fuzzy Brush Tool). Diameter brush diatur dengan klik ganda
ikon active brush pada bagian bawah Toolbox.

Klik ganda
untuk ubah
properti layer

Klik kanan
dan pilih
duplicate
layer

Slider Tool
Opacity

Clone Tool

Klik kanan
dan pilih Add
Mask

Klik untuk
aktifkan
Mask

Klik ganda
untuk atur
brush

Klik ganda
untuk untuk
aktifkan layer
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SATA memiliki beberapa
keunggulan dibanding harddisk
paralel ATA yang digunakan
selama ini. Keunggulan paling
menjanjikan terutama
kemampuan transfer datanya
yang sebesar 150Mbps. Meski
sampai sejauh ini perbedaan
performa yang ditawarkan tidak
terlalu signifikan, namun dalam
beberapa hal, harddisk jenis ini
memiliki keunggulan tersendiri
dibanding paralel ATA.

Dari segi kemudahan
instalasi misalnya. Karena bentuk
dan konfigurasi interface yang
ditawarkan, pemasangan kabel
penghubung SATA jelas lebih
mudah. Begitu pula untuk port
power-nya. Karena bentuk
interface-nya, pemasangan kabel
data maupun kabel power-nya
dipastikan tidak akan salah
dipasang.

Bentuk kabel yang ramping
juga jadi keunggulan tersediri
dari harddisk jenis ini. Lantaran
bentuknya yang ramping, kabel
data yang dimilikinya
dipastikan tidak akan
mengganggu sirkulasi udara
dalam casing. Jelas ini jadi nilai
lebih buat para pengguna PC
yang takut PC-nya terlalu panas
karena sirkulasi udara di dalam
casing terganggu..

Apa sudah perlu
beralih?

Dengan berbagai
keunggulan yang ditawarkan,
apakah memang sudah saatnya
beralih ke harddisk jenis ini
untuk penyimpan data di sistem
PC? Jawabannya memang
kembali berpulang pada
kebutuhan dari masing-masing
pengguna.

Buat pengguna yang
menginginkan PC-nya bekerja
dengan lebih memuskan,
dukungan harddisk berbasis SATA
dalam sistem memang
menjanjikan. Ini dikarenakan
kemampuan transfernya yang
jelas lebih baik.

Namun, buat pengguna
dengan aplikasi-aplikasi yang
ringan hingga menengah, tetap
memilih harddisk dengan
interface paralel ATA masih tetap
jadi pilihan yang bijaksana. Toh
untuk penggunaan PC seperti ini
tidak terlalu dibutuhkan harddisk
dengan kecepatan yang sangat
tinggi untuk mendukung kerja
sistem.

Apalagi dari segi harga yang
ditawarkan untuk sekarang ini
harddisk berbasis SATA masih
relatif lebih tinggi dibanding
paralel ATA untuk kapasitas yang
sebanding.

Untuk kapasitas sebesar
80GB misalnya, harddisk SATA
harganya sekitar 125 dolar per

S

SATA: Interface Harddisk
yang Perlu Dilirik

Silvester Sila Wedjo
sila@e-pcplus.com

Kecepatan pengolahan
data yang makin cepat

yang dihasilkan oleh
prosesor membawa

dampak ke semua
perangkat periferal PC

yang lain. Makin
cepatnya kemampuan

eksekusi prosesor ini
mau tak mau juga

harus dibarengi
dengan peningkatan

kemampuan yang
dimiliki oleh

komponen lain.

alah satu
komponen yang
juga harus mengikuti
perkembangan jaman

ini adalah harddisk. Seperti
diketahui, komponen inilah yang
merupakan komponen
penyimpan data utama dalam
sistem PC yang belum terganti-
kan oleh komponen manapun.
Alhasil, komponen ini juga harus
mampu mengikuti perkem-
bangan kecepatan yang dimiliki
prosesor maupun memori yang
berhubungan erat dengannya.

Meski demikian, karena

harddisk yang selama ini dipakai
memiliki kemampuan transfer
data yang boleh dibilang sudah
“mentok” pada kecepatan
100Mbps atau 133Mbps, banyak
pihak yang sudah merasa internal
harddisk yang umumnya berbasis
paralel ATA sudah saatnya digan-
tikan dengan yang lebih cepat.

Kerena pertimbangan inilah
hadir harddisk berbasis interface
yang baru yang berbasis serial
ATA yang menawarkan teknologi
yang lebih baru dengan
kemampuan transfer data yang
lebih cepat. Serial ATA (SATA)
inilah yang diproyeksikan akan
menggantikan paralel ATA yang
selama ini dipakai sebagai inter-
face harddisk utama pada PC.

Nyatanya, tawaran SATA
yang dikembangkan oleh
berbagai pihak ini disambut oleh
berbagai produsen. Mulai dari
produsen konverter interface
harddisk, hingga motherboard
yang dilengkapi kontroler
maupun port SATA kemudian
muncul. Belakangan bahkan tak
lengkap rasanya jika
motherboard yang dibeli tidak
dilengkapi dengan fasilitas SATA.

Tampaknya pasar memang mulai
siap-siap beralih menggunakan
penyimpan data yang punya port
interface sangat kecil ini.

Lebih Unggul Diban-
ding Paralel ATA?

Dari segi kinerja yang
ditawarkan, harddisk berbasis

unitnya sementara untuk
paralel ATA 7200rpm harganya
hanya sekitar 80 dolar per
unitnya. Bahkan harddisk

kecepatan 5400rpm paralel ATA
harga yang ditawarkan sekitar
80 dolar saja.

Untuk kapasitas 160GB,
perbedaan harga antara paralel
ATA 7200rpm dengan serial ATA
bahkan masih  terpaut sekitar 40
dolar. Memang dari segi harga

Kabel data yang ramping jadi keunggulan tersendiri dari harddisk
ber-interface serial ATA dalam mendukung sirkulasi udara sistem
yang lebih baik.

Bentuk dan konfigurasi port SATA yang unik membuat proses
pemasangan harddisk ke dalam sistem jadi sedemikian mudah dan
meminimalisir kemungkinan kesalahan pemasangan.

masih tergolong tinggi.
Namun bila Anda

berencana meng-upgrade PC
Anda dua atau tiga tahun

mendatang, harddisk SATA
tentu lebih kompatibel dengan
sistem yang nanti akan
digunakan.

Maklum, ke depannya
memang harddisk berbasis
interface SATA yang akan jadi
standar.  PC+
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Dukungan dari perangkat pendukung membuat SATA makin banyak
dipakai
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Di Mana Web
Hosting Gratis?

Saya baru belajar tentang
pembuatan homepage dan se-
karang saya bermaksud mem-
publish homepage (situs pri-
badi) saya di Internet. Kalau re-
kan-rekan ada yang bisa
membantu, ada beberapa hal
yang ingin saya tanyakan, di
antaranya adalah:
• Di mana saya bisa mendapat-

kan layanan web hosting
gratis untuk situs saya nanti?

• Bagaimana cara termudah
untuk meng-upload ke web
hosting tersebut?

• Di mana saya bisa mendapat
referensi contoh pembuatan
situs pribadi yang bagus?

Terima kasih atas saran
rekan-rekan semuanya. Salam.

Aris Asrori

Jawab:
• Untuk web hosting gratis,

Anda coba saja daftar di

Mouse PS/2 Saya
Tidak Terdeteksi OS

Halo mailplus. Saya anggota
baru nih dan mau nanya
masalah mouse PS/2 saya yang
tidak terdeteksi oleh sistem
operasi, sehingga tidak bisa
jalan. Saya sudah cek mouse saya
ternyata kondisinya masih baik.
Saya juga sudah mencoba
dengan mouse lain pada
komputer saya ini, tetapi tetap
tidak berhasil. Sehingga saya
menggunakan mouse cadangan
yang saya miliki di COM1.

Pertanyaan yang ingin saya
ajukan adalah:
1. Benarkah PS/2 mouse

connector atau controller
saya sudah rusak?
Komputer tersebut pernah
saya bawa ke Mangga Dua
dan diutak-atik BIOS Setup-
nya dan kemudian bisa
jalan, tetapi tidak lama

www.tripod.com,
www.geocities.com,
www.xoom.com,
www.freeservers.com. Contoh
lainnya seperti di bravenet,
topcities, dan brinkster.com.
Kalau Anda ingin mencoba
yang lain, Anda bisa
mencarinya lewat search
engine, misalnya cari di
www.google.com, masukkan
kata free web hosting. Pasti
akan muncul banyak pilihan,
Anda tinggal banding-
bandingkan fasilitas yang
ditawarkan.

• Cara yang termudah biasanya
kalau Anda sudah mendaftar,
seperti di Geocities, misalnya,
nanti Anda akan diminta
untuk menentukan lokasi di
mana file Anda (baik di
harddisk ataupun di disket
Anda) yang akan di-upload
ke situs tersebut. Biasanya
Anda dapat meng-upload
satu atau beberapa file
sekaligus. Setelah konfirmasi
dengan mengklik OK atau
semacamnya, maka file-file

tersebut akan langsung
tersimpan di folder yang
juga telah Anda tentukan di
situs tadi. Kalau yang sudah
jago sih, biasanya lebih suka
pakai FTP, tetapi harus

punya programnya. Atau
kalau pakai Frontpage juga
bisa langsung publish dari
Frontpage, dengan syarat
server-nya juga support
publish dari Frontpage.

• Coba Anda browsing ke
www.lynda.com, atau
www.master.web.id.
Mudah-mudahan bisa
membantu.

Calculus, titik hitam

kemudian tiba-tiba kok
ngadat lagi. Bagaimana set-
ting BIOS nya? Saya sudah
coba ubah-ubah menurut
buku petunjuk yang diserta-
kan, tetapi tidak berhasil.
Spesifikasi komputer saya
adalah: Intel Pentium-III
733MHz, motherboard Asus
CUV4X-C, memori SDRAM PC-
133, kartu grafis AGP 4X,
Award BIOS Set Up Utility
Asus ACPI BIOS (Flash
Memory Writer VI.29), mouse
PS/2 merek Logitech.

2. Saya sudah pernah coba
ubah seting BIOS dengan
mengubah-ubah:
• PS/2 Mouse Function

Control dari default-nya
[AUTO] ke [Enable] tetapi
tidak berhasil.

• PCI IRQ Resource Exclusion
dari default-nya [No/ICU]
ke [Yes] juga tidak

berhasil.
• Kalau saya mencoba

mengubah Hardware di
System pernah muncul
pesan Error Code 24. Apa
artinya ini?

• Kondisi PS/2 Mouse Con
nector-nya juga stabil
tidak goyang.

Terimakasih atas perhatian-
nya, mudah-mudahan ada di
antara rekan-rekan mailplus yang
bisa membantu. Salam.

Rudywarwa

Jawab:
Coba Anda lihat di port USB-

nya. Anda memasang perangkat
apa saja? Karena saya pernah me-
ngalami hal yang sama persis dan
dengan menggunakan mother-
board yang sama seperti milik
Anda. Lalu setelah saya pindah
printer yang saya pasang di port
USB ke port USB lainnya, sampai

sekarang mouse PS/2 yang saya
gunakan tidak ada masalah tuh.

Kemungkinan kedua
memang terjadi kerusakan pada
mouse controller atau connector-
nya. Coba Anda bawa ke pusat
servis motherboard Asus Anda.
Kalau Anda di Jakarta, bawa saja
ke Astrindo Senayasa di daerah

Hasil Transfer
Putus Putus

Rekan milis, saya mencoba
melakukan transfer file gambar
bergerak dari handycam ke VCD
dnegan menggunakan Pin-
nacle PCTV dan Nero. Ketika
hasilnya yang sudah dibakar
menjadi VCD dan diputar di
VCD player, tampak gambar
terlihat agak putus-putus
seperti ada delay. Tetapi kalau
diputar di CD-ROM, gambarnya
normal-normal saja. Kira-kira
apa penyebabnya ya?

Sebagai informasi, saya
menggunakan CD-RW drive
merek Sony 48x24x48. Saya sudah
coba di tiga VCD player yang

Mangga Dua Mall. Kalau cuma
mouse connector-nya yang
rusak, kayaknya ongkos servis-
nya gak terlalu mahal. Tetapi
kalau mouse controller-nya
yang rusak, kurang tahu juga
deh. Ada baiknya Anda bawa
saja ke sana.

djoko@nugroho

berbeda dan hasilnya tetap sama,
patah-patah. Meski tidak terlalu
menyolok, patahnya tapi terasa
mengganggu. Tetapi akan saya
coba lagi kembali dengan VCD
player yang agak bagusan.
Sekadar ingin lihat hasilnya sama
nggak.

Haye

Jawab:
Kemungkinan besar hal itu

terjadi karena hasil burn Anda
tidak bagus. Penyebab putus-
putusnya film saat diputar di
VCD player adalah karena
hardware di VCD player
memiliki kemampuan yang
lebih rendah daripada hard-
ware pada PC.

Setahu saya, Sony itu yang
membuat LiteOn. Coba update ke
firmware yang lebih baru
(download dari website-nya aja).
Kalau tidak berhasil juga, coba
Anda lakukan pembakaran
dengan kecepatan antara 4-16x.
Pilih salah satu, antara 4, 8, 12, 16
speed.

Biasanya 8 speed memberi-
kan hasil yang prima. Kalau pada
kecepatan bakar 8x masih tam-
pak putus-putus juga, silakan
posting lagi. Kalau masalah VCD
player, biasanya sih
kemampuannya memang segitu,
sebaiknya Anda mengakalinya
langsung dari source-nya aja
dengan memperbaiki kualitas
hasil bakaran. Salah satunya

dengan cara yang barusan
dibahas ini.

Diovan, DimeDeviL

Driver Yang
Cocok Untuk Linux

Kawan kawan, mohon
pencerahan. Saya memakai Linux
Mandrake 9 dan ternyata driver
VGA dan sound card nggak
terdetaksi. FYI, graphic card saya
menggunakan GeForce-2 MX400,
dan sound card C-media, mohon
pencerahannya.

bungky rashaun

Jawab:
Coba aktifkan alsad (atau

semacamnya), itu alsa driver yang
kalau tidak salah sudah support
C-Media (dulu GF-Excel saya saja
bisa kok). Terus VGA card. Anda
download dulu driver-nya dan
baca cara instalasinya di situsnya
nVidia:
http://www.nvidia.com/
view.asp?IO=linux_display_ia32_
1.0-4363.

Kalau soal hardware support,
Mandrake memang rada payah,
padahal kedua hardware ini
sudah full support di SuSE
sedangkan di Mandrake masih
ajah "Known Hardware...has
been reported as compatible with
Mandrake Linux by someone...."

Paulus Tangke Allo

✔

+

✔

+

✔

+

✔

+

Bagi pembaca yang tertarik untuk berinteraksi di rubrik ini, silakan mendaftar dengan mengirimkan e-mail  kosong ke mailplus-subscribe@yahoogroups.com. Agar keanggotaan Anda segera diaktifkan,
balas e-mail konfirmasi yang dikirimkan oleh Yahoo ke alamat e-mail Anda. Setelah terdaftar, Anda dapat mengirimkan e-mail pertanyaan ataupun tukar menukar pengalaman seputar dunia komputer.

Jangan lupa untuk memeriksa account e-mail Anda secara rutin.
Jika Anda tertarik untuk berdiskusi langsung secara online, silakan Anda join ke server DALnet pada channel #chatplus di mIRC.

PENTING!!!
Kalau Anda ingin menerima dan membaca e-mail secara digest (satu e-mail berisi beberapa message), kirim e-mail kosong ke mailplus-digest@yahoogroups.com. Sebagai informasi, setiap hari

Jum’at hingga Minggu adalah hari bebas di milis ini. Setiap anggota dapat mem-posting e-mail diluar seputar masalah komputer asalkan tidak mengandung SARA, pornografi, bajak-membajak
software, flamming, dan sebagainya. Jika Anda tidak ingin menerima e-mail OOT (Out Of Topic), kirim e-mail ke mailplus-nomail@yahoogroups.com, dan silakan Anda aktifkan kembali ke mode normal

dengan mengirim e-mail ke mailplus-normal@yahoogroups.com.
                                  •Redaksi
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Aplikasi Web dengan Fitur
Login dan Logout (Bagian 1)

Yahya Kurniawan
yahya@e-pcplus.com

Banyak sekali aplikasi
di Internet yang

menggunakan fitur
login dan logout.

Fungsinya tentu saja
membatasi akses

terhadap layanan
tertentu yang

disediakan pada situs
tersebut. Hanya

anggota yang telah
terdaftar saja yang

diijinkan mengakses
layanan-layanan
khusus tersebut.

ali ini PCplus
akan membahas bagai-
mana membuat aplikasi
yang memiliki fitur

login/logout. Yang dibahas di sini
adalah halaman login dan log-
outnya saja, sedangkan isi apli-
kasi yang terletak di dalamnya
bisa Anda kembangkan sendiri.

Dalam pembuatan aplikasi
ini kita membutuhkan database
yang akan menyimpan data-data
dari para anggota yang telah
terdaftar. Buatlah database
dengan MySQL sebagai berikut:

mysql> create database
daftar;

mysql> create table anggota(
-> uname varchar(20),
-> pswd varchar(32));

Database tersebut terdiri
dari satu tabel bernama “ang-
gota” dan tabel tersebut memi-
liki 2 buah field yaitu uname
untuk menyimpan user name dan
pswd untuk menyimpan pass-
word. Mengapa field pswd
ditentukan untuk memiliki 32
karakter? Kita akan bahas nanti.

Sekarang mula-mula kita
akan buat dahulu halaman
pendaftaran anggota. Skripnya
adalah sebagai berikut:

<HTML>
<HEAD>
<TITLE>Sign Up </TITLE>
</HEAD>

<BODY>
Isilah username dan password
yang Anda inginkan <BR>

<PRE>
<FORM NAME="frmSignUp"
METHOD="post"
ACTION="process.php">
Username : <INPUT

TYPE="text"
NAME="uname">

Password : <INPUT
TYPE="password"
NAME="pswd">

<INPUT TYPE="submit"
VALUE="Submit">
</FORM>

</BODY>
</HTML>

Simpanlah skrip ini dengan
nama signup.php. Diberi nama
signup.htm pun boleh karena
pada kenyataannya tidak ada
skrip php pada file ini. Jika

dijalankan pada browser hasilnya
akan nampak seperti Gambar 1.

Berikutnya kita akan mem-
buat file process.php yang akan
memroses pendaftaran kita tadi.
Skripnya adalah sebagai berikut:

<HTML>
<HEAD>
<TITLE>Processing your
Account </TITLE>
</HEAD>

<BODY>
<?
$uname = $_POST['uname'];
$pswd =
md5($_POST['pswd']);
$host = "localhost";
$user = "root";
$pwd = "rahasia";
$db = "daftar";

$stop = 0;
$sql = "select uname from
anggota";
$conn =
@mysql_connect($host,
$user,$pwd) or

die("Koneksi gagal : "
. mysql_error());
mysql_select_db($db);
$qry = mysql_query($sql) or

die("Query salah : " .
mysql_error());
while ($row =

mysql_fetch_array($qry)) {
if ($uname ==

$row['uname']) {
echo "Username

$uname was already chosen
by someone else <BR>";

echo "Go back and
choose another username";

$stop = 1;
break;
}

}

if ($stop==0) {
$sql = "insert into

anggota values
('$uname','$pswd')";

$qry =
mysql_query($sql) or

die("Query salah : "  .
mysql_error());

echo "Your account is
successfully
created <BR>";

echo "<A
HREF='login.php'>
Click here </A>
to login";
}
?>
</BODY>
</HTML>

Perhatikan
bahwa pada baris
kedua skrip php
(setelah bagian
<BODY>)
terdapat fungsi
md5. Fungsi
md5 merupakan
fungsi yang
menghitung md5
hash dari suatu

string. (Mengenai hal ini Anda
dapat mendapatkan informasi
lebih detil di http://
www.faqs.org/rfcs/
rfc1321.html). Md5 hash
menghasilkan 32 karakter dalam

format heksade-
simal. Itulah se-
babnya mengapa
field pswd
dibuat bertipe
data karakter
dengan panjang
32 karakter. De-
ngan md5 hash
ini password
Anda akan disim-
pan dalam ben-
tuk yang sangat
sulit ditebak.

Pada skrip ini
mula-mula
diperiksa apakah
username yang
dipilih telah ada
di dalam data-
base. Jika telah
ada, maka php
akan memberi-

kan peringatan bahwa username
tersebut telah ada dan Anda
dipersilakan membuat username
baru. Jika belum ada, maka
informasi username dan pass-
word Anda akan didaftarkan ke
dalam database dan Anda akan

diberitahu bahwa account Anda
telah dibuat. Bandingkan dengan
Gambar 2 dan Gambar 3.

Setelah
proses sign up
berhasil, kini kita
akan membuat
halaman untuk
login. Skripnya
adalah sebagai
berikut:

<HTML>
<TITLE>Login </
TITLE>

<BODY>
Registered user
log in: <BR>

<PRE>
<FORM
NAME="frmLogIn"
METHOD="post"
ACTION=
"main.php">
Username : <INPUT
TYPE="text"
NAME="uname">
Password : <INPUT
TYPE="password"
NAME="pswd">

<INPUT TYPE="submit"
VALUE="Submit">
</FORM>
</PRE>
New user please register
<A HREF=”signup.php”here </
A>
</BODY>
</HTML>

Simpanlah
file ini dengan
nama login.php
atau login.htm.
Jika dijalankan
pada browser ha-
silnya akan nam-
pak seperti Gam-
bar 4. Skrip ini
akan diolah pada
file main.php.
Nah, skrip dari file
main.php adalah
sebagai berikut:

<HTML>
<HEAD>
<TITLE>Main
Page </TITLE>
</HEAD>

<BODY>
<?
$uname = $_POST['uname'];
$pswd =
md5($_POST['pswd']);
$host = "localhost";
$user = "root";
$pwd = "rahasia";
$db = "daftar";
$stop = 0;
$sql = "select * from anggota
where uname='$uname'";
$conn =
@mysql_connect($host,$user,
$pwd) or

die("Koneksi gagal : "

. mysql_error());
mysql_select_db($db);
$qry = mysql_query($sql) or

die("Query salah : " .
mysql_error());
$num =
mysql_num_rows($qry);
$row =
mysql_fetch_array($qry);

if ($num==0) {
echo "Username not

found <BR>";
echo "Go back and try

another username";
} else {

if
($pswd!=$row['pswd']) {

echo "Your password
is incorrect <BR>";

echo "Go back and
type the correct password";

} else {
echo "You are success-

fully logged in";
}

}
?>
</BODY>
</HTML>

Pembahasan selengkapnya
dari skrip ini akan diberikan ming-
gu depan. Sampai jumpa. PC+

Gambar 1

Gambar 2

Gambar 3

Gambar 4
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ECS L4IGVM6:

Seri i845 dengan
Onboard Grafis

ECS Indonesia
www.ecs.com.tw
☎ (021) 6282048

66 dolar AS

Olympus C-740 Ultra Zoom:

Optical Zoom 10x

Olympus Service Center
☎ (021) 4256438

453 dolar AS

Olympus
memiliki
beberapa kamera dengan
zoom besar, anggap saja lebih
dari 5X pembesaran secara op-
tik. Salah satunya adalah seri C-
740 Ultra Zoom, kamera digital
dengan resolusi 3.2MP yang
memiliki perbesaran optik 10X.

ISI BUNDEL
Bundel C-740 Ultra Zoom

adalah sebuah kamera, xD
Picture Card berkapasitas 16MB,
dua baterai CR-V3 lithium, neck
strap, tutup lensa dan strap-nya,
back cover, kabel USB, kabel
video, software Olympus
Camedia Master dan driver,
buku manual dasar, quick start
dan manual yang full di dalam
CD-ROM.

Isi bundel ini bisa lebih baik
lagi jika baterai yang diberikan
adalah baterai rechargeable,

Dari sekian banyak
produk motherboard yang
beredar, motherboard jenis all in
one merupakan jenis
motherboard yang cukup
banyak peminatnya. Salah satu
vendor yang cukup rajin merilis
produk-produk model tersebut
adalah Elitegroup Computer
Systems.

Untuk produk jajaran
chipset i845, ECS menelurkan
pula produk yang memiliki
banyak fitur terintegrasi yang
salah satunya akan kita uji kali
ini. Produk yang dimaksud
adalah ECS L4IGVM6.

Dari kode namanya, kalau
Anda sering mengamati
produk-produk terbaru, Anda
mungkin dapat menebak
bahwa motherboard yang
dimuat kali ini adalah
merupakan motherboard
untuk sistem berbasis
Pentium-4, menggunakan form
factor Micro ATX, dengan
chipset Intel GV. Berhubung
hanya jajaran chipset i845 saja
yang memiliki varian dengan
kode nama GV, maka chipset

yang ditanam pastilah i845GV.
Benar saja. Motherboard ini

memang memiliki form factor
Micro ATX berukuran 24,4 x 20,3
cm. Untuk chipset-nya, ECS
menggunakan kombinasi
northbridge i845GV dan ICH4.
Sedangkan prosesor Intel yang
dapat digunakan adalah Pentium-
4 dan Celeron yang menggunakan
FSB 400 atau 533MHz.

Sebagai fitur grafis
terintegrasi, pada northbridge
i845GV ini tersedia fitur inte-
grated Intel Extreme Graphics.
Grafis terintegrasi ini memiliki
clock dengan kecepatan 200MHz.
Performanya sudah cukup baik
kalau digunakan untuk
menjalankan aplikasi grafis 3D
sederhana.

Chip-chip lain yang
melengkapi motherboard yang
diberi warna ungu khas ECS ini di
antaranya adalah chip W83637HF-
AW dari Winbond yang
merupakan chip kontroler input
output, serta chip CMI9739A yang
merupakan AC’97 Audio Codec.
Untuk southbridge ICH4 yang
digunakan pada EMC L4IGVM6

kali ini, fitur
integrated 10/100 LAN-nya
juga sudah dimanfaatkan.

Untuk slot ekspansi, ECS
hanya menyediakan dua buah slot
PCI dan sebuah slot CNR pada
board yang merupakan versi 1.0
dari produk jenis ini. Ruang untuk
menempatkan dudukan bagi
sebuah slot PCI, dan sebuah slot
AGP pada board ini dibiarkan
kosong tidak digunakan.
Kemungkinan pada board versi
berikutnya, ruang ini akan
dimanfaatkan. Kemungkinan
berikutnya adalah desain board
ini serupa dengan desain
produk motherboard ECS lain
yang menggunakan chipset
berbeda.

Untuk modul memori, pada
ECS L4IGVM6 ini tersedia dua
buah slot DDR DIMM 184-pin yang
dapat dipasangkan memori jenis
DDR200, DDR266, dan DDR333.
Untuk kapasitas totalnya, chipset

i845GV yang digunakan ini dapat
menampung hingga 2GB.

Pada kemasan jual yang kami
terima, motherboard ini disertai
pula dengan sebuah card reader
kit. Jenis-jenis card yang dapat
digunakan adalah memory stick,
compact flash, secure digital, dan
SM card. Untuk dapat
menggunakan kit yang bisa
dipasangkan pada drive bay 3,5”
ini, penggunanya harus
memasangkan konektor yang
tersedia ke header USB pada
motherboard.

Kami menguji produk ini
dengan Pentium-4 2,4GHz, dua
keping memori Kingston DDR400
masing-masing berkapasitas
512MB, serta harddisk Seagate
Barracuda 7200.7 kapasitas 40GB.
Untuk grafisnya, kami

SysMark 2002
Rating :251
Internet Content :335
Office Productivity:188

SisoftSandra 2003
ALU :6485 MIPS
FPU :1346 MFLOPS
ISSE2 :3160 MFLOPS

3D Mark 2001
640 x 480  16bit :2993
640 x 480  32bit :3121
800 x 600  16bit :2521
800 x 600  32bit :2312
1024 x 768  16bit :1823
1024 x 768  32bit :1951

Quake III Arena
640 x 480  16bit :124,3fps
640 x 480  32bit :97,1fps
800 x 600  16bit :90,5fps
800 x 600  32bit :66,6fps
1024 x 768  16bit :60,0fps
1024 x 768  32bit :44,5fps

selain karena bisa
menghemat uang,

juga lebih ramah
lingkungan dan

tahan lama.
Selain itu,
andai saja
memori yang
diberikan
lebih besar

kapasitasnya.
Tidak perlu

besar-besar,
32MB saja, bisa
lebih puas motret-
nya. Satu lagi yang
bisa dikomplain
adalah manual

yang dicetak hanya
manual dasarnya.

Walaupun manual lengkapnya
tetap disertakan di CD, tapi repot
juga kalau harus mencetaknya
sendiri.

Software Olympus Camedia
Master yang dapat digunakan
untuk mem-browse, men-transfer
foto, mencetak, membuat
panorama, membuat wallpaper
serta mengedit gambar. Olympus
Camedia Master bisa dipakai
untuk mengatur brightness,
contrast, color balance, serta
menghilangkan red-eye.

EKSPLORASI KAMERA
C-740 Ultra Zoom lebih kecil

dibandingkan C-730 Ultra Zoom,
kamera Ultra Zoom seri
sebelumnya. C-740 memiliki
dimensi 106.68 x 68,58 x 66,04 mm
(p x l x t). Ukuran kamera ini

memang tidak bisa pocket. Tapi
dengan memperhitungkan ukuran
lensanya, wajarlah kalau kamera
ini berukuran sedikit montok.
Bodinya dibangun dari kombinasi
antara metal dan plastik. Dengan
kombinasi itu kamera ini memiliki
berat sebesar 295 gram tanpa
baterai.

Lensa C-740 adalah lensa ED
(Extra-low Dispersion) Olympus
dengan 10X zoom. Lensa dengan
ED mampu mengurangi lingkaran
ungu yang sering muncul pada
kamera dengan lensa zoom besar.
Lensa dengan aperture F2.8 – F3.7
ini memiliki focal range 6.3 – 63
mm. Lensa C-740 bisa ditambah
dengan lensa wide-angle,
telephoto, dan macro. Namun
sebelumnya C-740 harus ditambah
adapter lensa CLA-4.

Olympus menyediakan
banyak scene-mode pada C-740.
Ada untuk close-up, olah raga,
pemandangan, malam atau
kondisi gelap, dan pemandangan
dengan obyek di depannya. Ada
pula pengaturan Auto untuk
kondisi umum. Kamera bekerja
secara otomatis memilih
pengaturan yang paling cocok
untuk suatu keadaan.

Bagi fotografer yang sudah
lumayan profesional, Olympus

menyediakan banyak sekali
pengaturan manual pada C-740.
Pada program mode
(dilambangkan P pada lingkaran
menu), pengguna C-740 dapat
mengatur segala sesuatunya
secara manual kecuali aperture
dan shutter. Aperture dan shutter
dapat diatur secara manual pada
A/S/M. A berarti aperture priority,
yang berarti pengguna dapat
mengatur nilai aperture,
sedangkan C-740 secara otomatis
mengatur kecepatan shutter. S
adalah shutter priority, artinya
kebalikan dari A. Sedangkan M
berarti pengguna mengatur
keduanya secara manual.

C-740 memiliki LCD dan
viewfinder. Viewfinder, yang di
dalamnya juga LCD, mengambil
gambar langsung dari lensa,
bukan dari jendela tembus seperti
kamera pada umumnya. Jadi apa
yang kita lihat, adalah apa yang
kita dapat. Penggunaan
viewfinder dapat menghemat
baterai.

Lampu flash alias blitz pada
C-740 mampu bekerja dalam jarak
0.3 – 4.5m. Cukup disayangkan C-
740 tidak diberi hot shoe (baca:
tatakan untuk lampu flash
tambahan). Padahal lensa C-740
mampu melakukan zoom sampai

menggunakan fitur Intel
Extreme Graphics yang

tersedia secara
terintegrasi di chipset
i845GV yang
terpasang. Sedangkan
untuk sistem operasi

yang kami gunakan
saat menguji adalah

Windows XP Professional,
sedangkan software

benchmark yang kami
pakai adalah Sysmark2002,

Sisoft Sandra 2003,
Quake 3 Arena, dan

3DMark2001. (fmn)

ARE/PCplus

jarak yang cukup panjang.
Sayang sekali jika tidak didukung
dengan lampu flash yang kuat.

Menu pada C-740 sangat
mudah untuk dieksplor, sehingga
memudahkan penggunanya
untuk memilih pengaturan
dengan efisien. Opsi-opsi yang
dapat diakses pada menu
tergantung pada scene yang
pengguna pilih.

KESIMPULAN
Apa yang membuat C-740

ini menarik? Yang pertama
adalah perbesaran optisnya yang
mencapai 10X, yang didukung
dengan ED untuk mengurangi
lingkaran ungu. Yang kedua
adalah setting manual yang
banyak. Berikutnya adalah
playback mode yang didukung
dengan cropping langsung di
kamera. Sedangkan
kekurangannya adalah tidak
adanya hot shoe, tempat untuk
flash tambahan. Kemudian video
yang tidak didukung oleh suara.
Kapasitas xD card yang
dibundelkan terlalu kecil. (alx)

ARE/PCplus
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CR-T4-U6S:
Six In One
USB Card Reader

Cinex F173:

Monitor LCD
17 Inci

PT Hexatech
☎ (021) 6129831

450 dolar AS

Maxtor Atlas 15K IV:

Harddisk SCSI
Internal 73GB

PT Jayacom Alpha Electronic
www.maxtor.com
☎ (021) 6292427

690 dolar AS

PT Mostech Gigaddonics
☎ (021) 9253484

15 dolar AS

Setelah melakukan
penetrasi ke pasaran
monitor Indonesia dengan produk
CRT ukuran 17 inci pada kuartal
pertama tahun ini, kembali
produk terbaru keluaran Cinex
Multimedia Monitor dapat kita
jumpai di pusat perbelanjaan
komputer di tanah air. Kali ini
produk yang ditawarkan adalah
sebuah monitor LCD yang juga
berukuran 17 inci dengan nama
lengkap Cinex F173.

Hal yang sedikit unik pada
monitor ini adalah dudukannya.
Berbeda dengan monitor LCD
buatan produsen lainnya, monitor

Se-
buah
media
penyim-
panan,
terutama yang
berfungsi untuk
menyimpan sejumlah
besar data di dalam jaringan tentu
haruslah memiliki kemampuan
yang prima. Sejalan dengan
meningkatnya kebutuhan pasar
akan harddisk dengan kinerja
tinggi, vendor-vendor storage
device terus memproduksi media

Penggunaan
berbagaimacam kartu
multimedia sudah semakin marak.
Selain digunakan pada kamera
digital, kartu multimedia semacam
ini juga dimanfaatkan oleh
perangkat genggam yang sedang
naik daun yaitu PDA.

Beberapa jenis kartu multime-
dia yang dapat dijumpai di
pasaran di antaranya adalah
Compact Flash (CF), Secure Digital
(SD), Multi Media Card (MMC),
Memory Stick (MS), Micro Drive
(MD), dan Smart Media (SM).
Kartu-kartu memori ini ukurannya
berbeda beda. Mulai dari 8MB
hingga 256MB, bahkan lebih.

Cinex yang satu ini menggunakan
dudukan yang terbuat dari bahan
logam padat. Desain dudukan ini
juga tampak cukup kokoh dan
meyakinkan.

Tombol power dan pengaturan
OSD untuk monitor
yang terletak di
bagian depan
produk ini
dikumpulkan di
sebelah kanan.
Penggunaannya
pun cukup mudah.
Untuk
mengaktifkan,
penggunanya
dapat menekan
tombol OSD.
Untuk memilih
fungsi OSD, dapat
menekan tombol
panah ke atas dan

ke bawah. Untuk menentukan
pilihan, tekan tombol Enter.
Untuk mengubah setting,

kembali tekan tombol panah.

Cukup sederhana bukan?
Setting yang disediakan di

antaranya adalah brightness,
contrast, phase, pitch, horizontal,
vertical, color, menu position, reset,
backlight, dan language. Pada opsi
reset, pengguna monitor ini dapat
pula memilih opsi auto adjust. Opsi
ini berfungsi secara otomatis untuk
menentukan setting terbaik untuk
dimunculkan. Kalau ingin kembali
ke setting default, pada menu ini
juga ada fasilitas recall.

Selain brightness dan contrast,
setting lainnya yang dapat dipilih
untuk menyejukkan mata saat
menggunakan monitor ini untuk
bekerja adalah opsi backlight.
Dengan mengatur besaran back-
light, tingkat kecerahan dapat
dikustomisasi lebih lanjut.

Memiliki pixel pitch 0,264 x
0,264, Cinex F173 mampu
menampilkan resolusi hingga 1280 x
1024. Dengan ukuran diagonal 17
inci, monitor ini dapat menampilkan
hingga 16,7 juta warna dan dengan

penyimpanan yang dapat
menangani transaksi data

yang dapat diandalkan.
Untuk kebutuhan

itulah peranan
harddisk SCSI

menyeruak. Untuk
dipasang di server

ataupun
workstation,

biasanya
harddisk
tipikal jenis
IDE kurang
dapat
memenuhi

tuntutan
kerja. Apalagi kalau

jaringan tersebut cukup luas
dan memiliki tingkat transfer data
yang cukup tinggi.

Salah satu harddisk yang dapat
dimanfaatkan pada jaringan
semacam ini adalah produk buatan
Maxtor yaitu seri Atlas 15K. Sesuai
dengan namanya, harddisk ini
memiliki kecepatan putar
15000rpm. Harddisk SCSI ini

memiliki average seek time yang
cukup tinggi yaitu sekitar 3,2ms.
Bandingkan dengan harddisk IDE
7200rpm pada umumnya yang
memiliki average seek time sekitar
9ms atau saudaranya, yaitu Atlas
10K yang memiliki average seek
time 4,2ms.

Untuk melakukan transfer
data, harddisk yang memiliki
kapasitas sebesar 73GB dan
dilengkapi dengan cache buffer
sebesar 8MB ini memiliki
kecepatan hingga 75MB per detik.
Cocok bila digunakan pada sistem
yang membutuhkan performa
tinggi seperti online transaction
processing, enterprise server, dan
untuk animasi 3D.

Kali ini, kami menguji
harddisk Maxtor Atlas 15K dengan
menggunakan motherboard
Albatron PX865PE Pro II dengan
prosesor Pentium-4 3,2GHz, dua
keping memori Kingston DDR-
SDRAM PC-3200 512MB serta
Adaptec Ultra320 SCSI Card untuk
menghubungkan harddisk ke

motherboard. Sistem operasi yang
kami gunakan adalah Windows
XP Professional serta untuk
mengujinya kami menggunakan
software benchmark Business Disk
WinMark 99 ver. 1.2, High-End
Disk WinMark 99 ver. 1.2, dan
Sisoft Sandra 2003.

Hasil yang diperoleh harddisk
ini untuk Business Disk WinMark
adalah 11600 sedangkan untuk
High-End Disk WinMark adalah
39900. Untuk perbandingan, kami
juga menguji sebuah harddisk
internal tipikal berkecepatan 7200
rpm, dan hasil yang didapatkan
untuk Business Disk WinMark
7890 dan untuk High-End Disk

Bentuk dan ukurannya juga
berbeda. Mulai dari yang tipis
seperti Smart Media hingga yang
sedikit tebal seperti Compact Flash.

Kalau kita memiliki kamera
digital atau PDA, kita dapat
langsung menghubungkannya ke
PC untuk dapat men-download
foto, menyinkronisasi data-data
kerja atau file-file lainnya. Apalagi
kalau kita sudah menggunakan OS
terbaru seperti Windows XP, kita
dapat langsung menghubungkan
ke PC dan sistem operasi sudah
dapat mengenali kamera digital dan
membaca isinya. Mungkin untuk
PDA kita masih perlu
menginstalasikan software bawaan

untuk dapat melakukan
sinkronisasi.

Masalahnya sekarang,
bagaimana kalau kita mempunyai
beberapa kartu multimedia dan kita
perlu mengopikan data-data yang
ada pada kartu tersebut pada PC
untuk kita olah lebih lanjut?
Sebagai contoh, kita memiliki
sebuah kamera digital dengan
sepuluh buah compact flash, apakah
kita harus membongkar pasang
kesepuluh compact flash tersebut ke
dalam kamera digital kita untuk
men-download foto yang kita
ambil? Langkah seperti itu jelas
merepotkan.

Bagi pengguna seperti ini, kini
ada perangkat yang dapat
dipasangkan langsung pada PC
untuk membaca kartu-kartu
tersebut. Salah satu produknya
adalah Six In One USB Card Reader
yang kita bahas kali ini.

Produk ini merupakan sebuah
card reader yang dapat
ditempatkan di salah satu drive bay

3,5” yang
lowong di
casing.
Enam jenis
kartu
multimedia
dapat
dipasang-
kan di
perangkat
ini untuk
dibaca
isinya atau
dipindahkan ke komputer. Untuk
dapat mengaktifkannya, pengguna
alat ini tinggal menghubungkan
kabelnya ke header USB yang
terdapat pada hampir semua
motherboard terbaru saat ini.

Untuk mentransfer data,
perangkat ini juga sudah
mendukung mode USB 1.1 dan 2.0
dengan sistem operasi yang
didukung adalah Windows 98, 98SE,
ME, 2000, dan XP untuk PC serta
Mac OS 9.0 ke atas untuk
Macintosh. Penggunaannya pun

rasio kontras 500:1. Angka ini
merupakan rasio standar yang
biasa dimiliki monitor LCD. Untuk
brightness-nya, monitor yang saat
bekerja memiliki response time
20ms ini memiliki brightness 250
candela per meter persegi.

Saat digunakan, pemakai
monitor ini masih tetap dapat
melihat tampilan pada layar
hingga sudut pandang 140 derajat
secara horizontal. Untuk
vertikalnya, sudut pandang yang
masih dapat dipancarkan oleh
monitor ini adalah 110 derajat.
Daya listrik yang digunakan oleh
Cinex F173 ini juga cukup rendah.
Saat bekerja normal, konsumsi
daya rata-rata yang digunakan
dibawah 45W, sedangkan dalam
mode stand-by tidak sampai 3W.
Menarik kan? (fmn)
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WinMark hasilnya adalah 32200.
Pada pengujian File System
Benchmark di Sisoft Sandra 2003,
harddisk ini dapat meraih angka
49696 kB/s. Sebagai
pembanding, sebuah harddisk
SCSI U160 tipikal berkecepatan
15000rpm hanya meraih angka
40212 kB/s, sedangkan harddisk
IDE ATA 100 dengan kecepatan
7200rpm hanya meraih angka
35732 kB/s. (fmn)

ARE/PCplus

cukup mudah. Setelah
dipasangkan, Anda tinggal
menginstalasi driver dari CD yang
sudah tersedia, maka sistem
operasipun langsung mendeteksi
perangkat ini dan kartu-kartu
multimedia Anda sudah bisa
langsung dibaca. (fmn)

ARE/PCplus
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Tomb Raider:
Angel Of Darkness

Lara Croft Beraksi Kembali

Setelah bertahun-
tahun dalam

penantian, akhirnya
para fans berat Tomb

Rider series bisa
berbahagia dengan

hadirnya petualangan
Lara Croft terbaru

yang berjudul Tomb
Rider: Angel Of

Darkness (TRAOD).
Beberapa kali TRAOD

sempat mengalami
penundaan.

Mungkinkah seri ke-6
dari game terlaris ini
dapat menjadi yang
terbaik dari seri-seri

sebelumnya ?

KISAH LATAR
Seperti pendahulunya,

Anda berpetualang sebagai
Lara Croft dengan kebiasaanya:
berlari, melompat, memanjat,
bergelantungan atau
menembak  menggunakan
pistol ganda dalam aksi.

Ceritanya bermula di kota
Paris, yaitu tentang misteri
lukisan Obscura. Lara Croft
dituduh telah membunuh
mentornya, Profesor Werner
Von Croy. Tewasnya Von Croy
terkait erat dengan lima lukisan
Obscura tersebut. Kelima
lukisan ini akan digunakan
untuk membangkitkan sebuah
kekuatan dahsyat untuk
menguasai dunia oleh seorang
ilmuwan.

MISI
Tugas Anda adalah mencegah

nafsu ambisi ilmuwan jahat
dengan memecahkan segala teka-
tekinya yang tidak terlalu sulit. Di
tengah perjalanan, Lara Croft
akan bertemu seorang petualang
yang bernama Kurtis Trent.
Dengan tujuan yang sama ia akan
membantu Anda. Tidak hanya itu,
Anda juga bisa menggunakan
karakter ini.

Ada pula karakter lain yang
disebut non-playable character
atau yang  biasa disebut NPC. NPC
ini akan memberikan petunjuk
kepada Anda dengan cara
berinteraksi. Hasil percakapan
dapat menentukan rute atau alur
cerita yang akan diambil
selanjutnya. Jadi, rute bisa
berbeda-beda dalam satu lokasi,
tergantung bagaimana Anda
menjawab setiap percakapan
dengan NPC.  Bahkan, salah
langkah di dalam interaksi dengan
NPC bisa mengakibatkan game
over. Adanya interaksi dan
percakapan ini termasuk salah
satu peningkatan dari seri
sebelumnya.

Kemampuan serta keahlian
Lara Croft juga
sudah mengalami
peningkatan.
Misalnya saja
stealth mode
atau bergerak
diam-diam tanpa
ketahuan musuh,
walaupun tidak
berpengaruh
banyak terhadap
beberapa
penjaga
keamanan.
Kekuatan Lara
Croft dapat
bertambah dalam
menggerakkan
benda atau
mendobrak  pintu
berlapiskan besi.
Kekuatan ini
bertambah terus
seiring
berlangsungnya
permainan. Di sisi
lain, terdapat
tingkatan

stamina untuk memanjat atau
bergelantungan. Semakin
lama memanjat atau
bergelantungan, stamina akan
semakin terkuras.

KONTROL DAN KENDALI
AKSI

Sistem pengontrolan tidak
mengalami perubahan yang
signifikan dari versi sebelumnya.
Kontrol pemain sangat lambat
dan kaku, misalnya: berlari,

memanjat, keadaan ketika
memegang senjata, atau
mengambil sebuah item. Posisi
pemain harus benar-benar tepat
ketika akan melakukan suatu aksi.
Untuk berputar ke arah yang
berlawanan pun mengalami
kesulitan. Hal ini mengakibatkan
Lara Croft tidak cekatan dalam
melakukan aksinya, terutama
dalam sudut pandang yang agak
menyusahkan atau ketika berada
dalam ruangan yang sempit.
Seharusnya,  pemain game ini
diberi  fasilitas sudut pandang
orang pertama untuk melihat
area sekitar lebih jelas.

LOKASI LATAR CERITA
DAN PERLENGKAPAN AKSI

Anda akan berpetualang di
antara kota Paris, Prague, dan
tempat-tempat  tua, seperti:
lorong-lorong yang gelap,
apartemen, ruangan bawah
tanah, tempat pemakaman,
catacomb, dan masih banyak
lokasi lainnya. Item-item yang
digunakan tidak berbeda jauh
dari TRAOD versi sebelumnya,
antara lain: cara untuk menambah
power (health pack, medipack,
chocolate, dan lainnya), uang
Euro, diamond ring, sport/gold

Pramadhi Jatmika
pramadhi@hotmail.com

Konfigurasi
Minimal Sistem:
• Prosesor Intel atau AMD

500 MHz
• RAM 128 MB
• Kartu Grafis 16 MB

(mendukung T&L)
• DirectX 9.0
• Ruang Harddisk 300 MB
• MS Windows 98/ME/2000/

XP

Genre : Action
Adventure

Publisher : Eidos
Interactive

Developer : Core Design
ESRB Rating : Teen (T)
Website : www.eidos.com

watch, berbagai jenis key, dan
lainnya.

TRAOD menyediakan senjata,
antara lain: crowbar, beberapa
jenis senjata pistol serta shotgun.
Senjata-senjata ini nantinya
digunakan dalam menghadapi

musuh, di antaranya: para
penjaga keamanan, kelelawar,
anjing, serta bermacam-macam
monster dengan tingkat AI
(Artificial Intellegence) yang
cukup tinggi.

KUALITAS VISUAL DAN
AUDIO

Kualitas grafis game ini
sangat bagus. Karakter Lara
Croft telah perbaiki dari
penampilan hingga animasinya.
Tampilan penuh refleksi dan

efek visual yang bagus seperti
efek air, bayangan, dan partikel-
partikel lainnya. Semua lokasi
dibuat dengan akurat.

Tata suara sangat baik.
Musik yang sempurna dan
akting suara yang bagus dari
karakter Lara Croft, Kurtis Trent,
dan para NPC.

KRITISI
Secara keseluruhan, TRAOD

merupakan petualangan yang
menarik jika dilihat dari jalan
ceritanya. Dilihat dari sisi game-
play-nya, bisa dikatakan kurang
bagus karena kontrol (kendali
aksi) yang buruk, gerakan yang
lambat dan rotasi kamera yang
mungkin menyulitkan.

Di mana ada kekurangan,
pasti terdapat juga kelebihan.
Kelebihan tersebut tetap tidak
bisa didapatkan pada Tomb
Raider seri-seri sebelumnya. PC+
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Workshop Instalasi
Windows Dibuka Lagi

SCOMDEX-13
Digelar di AJBS

Memenuhi
permintaan calon
peserta yang tidak mendapat
tempat dalam workshop
Instalasi Windows dan Optimasi
BIOS yang diadakan pada
tanggal 25-26 Agustus lalu serta
memeriahkan Computer Fiesta
yang diselenggarakan oleh Hi-
Tech Mall, workshop Instalasi
Windows diadakan lagi pada
tanggal 16-17 September 2003.

Seperti pada workshop
yang terdahulu, workshop kali
ini juga didukung oleh Astrindo,
distributor motherboard ASUS.
“Kami selalu siap mendukung

kegiatan semacam ini, yang
sering diadakan oleh Tabloid
PCplus,” ujar Willy, direktur PT
Astrindo Surya. Pada workshop
kali ini ASUS akan menyediakan
motherboard X-series,
motherboard yang paling laris,
untuk peserta workshop. “Demi
kenyamanan peserta dan seperti
yang telah kami lakukan
sebelumnya, komputer yang
disediakan adalah komputer
yang 100% baru,” tegas Willy.

Dalam workshop kali ini,
peserta juga bisa membeli
komputer yang mereka rakit
dengan harga spesial. Selain itu

ASUS juga akan memperkenalkan
motherboard seri terbarunya,
yaitu P4C800. Semua teknologi
terbaru dimiliki oleh
motherboard ini, antara lain
arsitektur memori dual kanal dan
harddisk Serial ATA (SATA).

Motherboard yang
menggunakan chipset Intel 875P
dan mempunyai FSB 800 MHz ini
memang boleh dikatakan
mempunyai segalanya, apalagi
motherboad ini juga
dipersenjatai dengan Asus
Intelligence (AI). Hampir seluruh
motherboard ASUS sudah
dilengkapi Asus Intelligence,

yang meliputi AI Audio, sebuah
teknologi yang secara otomatis
mengecek peralatan audio yang
ditancapkan.

Jadi saat Anda menancapkan
colokan speaker ke colokan
microphone, secara otomatis
motherboard akan mengeluarkan
peringatan kepada Anda. Yang
berikutnya adalah AI Net, sebuah
sistem pendiagnosa jaringan
komputer.

Kemudian yang menarik
adalah AI Overclocking yang
secara otomatis memerintahkan
motherboard untuk
menggunakan frekuensi tertinggi
yang bisa dicapai oleh prosesor.
Dengan kata lain, motherboard
ASUS secara otomatis melakukan
overclocking! AI yang terakhir
adalah AI BIOS yang secara
otomatis melakukan perbaikan
BIOS bila terjadi kerusakan atau
kegagalan BIOS.

Selain AI-series, P4C800 ini
juga dilengkapi Gigabit LAN,
koneksi jaringan komputer
ethernet 1000 MHz yang akan
menjadi standar jaringan
komputer pada tahun-tahun
mendatang.

Kemudian untuk urusan
video, motherboard ini
dilengkapi dengan slot AGP8X
(AGP 3.0) yang memungkinkan
kemampuan grafis sampai
dengan 2.12 GB/detik.

Untuk urusan koneksi
dengan peralatan lain pun juga
tidak tanggung-tanggung,
tersedia 8 port USB 2.0, selain
port paralel, serial, PS/2 mouse/
keyboard, S/PDIF output, dan
beberapa port lainnya. “Satu
hal yang perlu diingat adalah
motherboard ini juga
mendukung teknologi Hyper-
Threading dari Intel,” imbuh
Willy. (din) PC+

Seolah menjadi
tradisi, untuk yang ke-13
kalinya APKOMINDO Jatim
menyelenggarakan SCOMDEX.
Ini berarti sejak tahun 1991
SCOMDEX diselenggarakan
tanpa henti. Namun ada yang
berbeda dengan yang ketiga
belas ini, yaitu tempat
pelaksanaanya. Jika sampai
pada SCOMDEX-12 acara digelar
di WTC Surabaya, kali ini digelar
di Convention Hall AJBS,
tanggal 10-14 September ini.

Menurut Chandra Prayogo,
Sekjen APKOMINDO Jatim,
pemindahan tempat ini
dikarenakan WTC tidak lagi
menyewakan lantai keduanya
untuk pameran, karena sudah
digunakan untuk stand toko.
“Menurut kami, AJBS adalah
tempat pengganti yang cukup
tepat, selain convention hall-
nya cukup luas, letaknya juga
cukup strategis,” terang
Chandra.

SCOMDEX-13 juga

dimeriahkan dengan seminar
yang diisi oleh Intel, Microsoft,
dan SMC. Intel rencananya
mengulas panjang lebar
tentang produk Intel Centrino
Mobile, sedangkan Microsoft
akan mengulas tentang Business
Intelligent, Windows 2003, serta
UU HaKI yang sedang ramai
dibicarakan. Yang terakhir
adalah SMC, yang akan
mengulas tuntas tentang
networking, termasuk di
dalamnya wireless network.

Selain itu, dengan
pembelian jumlah tertentu,
pembeli berhak mendapatkan
kupon yang berhadiah antara
lain 1 unit sepeda motor, 1 unit
televisi LG flat 29”, 21”, dan
14”, 1 unit televisi Samsung flat
29” dan 21”, 1 unit lemari es 2
Pintu LG dan Samsung, 1 unit
DVD player LG dan Samsung, 1
unit mesin cuci LG dan
Samsung, 1 unit microwave
Samsung, dan 2 unit bread
maker. (din) PC+

Tebak Kotak Kemasan
Tinta Refill Berhadiah

Rainbow, sebuah merek
tinta refill yang sudah cukup
lama eksis, bekerja sama
dengan Hi-Tech Mall menye-
lenggarakan acara tebak jumlah
Rainbow-Refill 2003. Dengan
membeli produk Rainbow, pem-
beli mendapatkan kupon untuk
menebak jumlah kotak kemasan
Rainbow yang berbentuk angka
58 dan digantung di hall Hi-
Tech Mall.

Kupon yang telah diisi
dapat dimasukkan ke kotak
yang telah disediakan di depan
Rainbow Refill Center di Hi-Tech
Mall Lt. 1 Blok D-3. Hadiah yang
disedia-kan cukup menarik, an-
tara lain TV, VCD, Magic Com,
dan lain-lain. Se-lain itu Rain-
bow menye-diakan souvenir
cantik selama masa promosi.

Menurut Ludi, salah
seorang reseller Rainbow di Hi-
Tech Mall, acara ini cukup
menarik minat masyarakat.
“Harga printer makin murah,
tapi harga tinta masih cukup

mahal. Inilah yang membuat
masyarakat mulai menggunakan
tinta refill,” ujarnya. Ludi
berharap dengan adanya promosi
ini minat masyarakat untuk
menggunakan tinta refill makin
tinggi.

Acara yang juga ditujukan
dalam rangka merayakan ulang

tahun kemerdekaan RI yang ke-
58 ini berlangsung mulai
tanggal 1 Agustus – 12 Septem-
ber. Penarikan kupon undian
akan dilaksanakan pada tanggal
13 September jam 13.00. Acara
ini akan dimeriahkan dengan
acara hiburan dan musik dari
anak jalanan. (din) PC+
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UGM - JOGJAKARTA

27 - 28 - 29 September 2003

Materi :

• Dasar-dasar Video Editing
• Capture video ke komputer
• Membuat VCD
• Tip & Trik video editing dengan
  Adobe Premiere 6.0

KIT workshop •
Modul materi workshop •

Coffee Break •
Sertifikat •

Fasilitas:

Pendaftaran:
- Sdr. Oesep Kurniadi - Tlp: (0274) 563172
- Sdr. Aris - Hp. 08179409911

Biaya: Rp. 200.000,- (umum)
           Rp. 150.000,- (mahasiswa)

Fakultas MIPA - Jurusan Fisika
(Prog.Studi Elektronika & Instrumentasi)

TEMPAT TERBATAS

Daftar Harga Komputer &
Periferal yang dihimpun dari
berbagai toko & distributor

komputer di Jakarta.
Harga Dalam Dolar AS

MOTHERBOARD

VIA P4PB-Ultra+RAID  P4X400,
ATX, FSB533, DDR333/400,
RAID 103
VIA P4PB400-L  P4X400, ATX,
FSB533, DDR333/400 68
VIA P4PB266EN, P4X266, ATX,
FSB 533, 3 DDR 68
VIA P4MA-Pro, Via P4M266,
M-ATX, FSB 400, VGA, LAN 59

Asus P4S800, SiS648FX, 5 PCI,
AGP 8X, USB 2.0, HTT 105
Asus P4PE/L 1394, i845PE, AGP4X,
DDR, 6PCI, USB2.0,
Hyper-threading 133
Asus P4PE/L , i845PE, AGP4X, DDR,
6PCI, USB2.0, Hyper-threading 100
Asus P4C800 Deluxe, Intel 875,
FSB800, ATA100, RAID, AGP Pro 236
Asus P4P800 Deluxe, i865, FSB 800,
ATA100, 4DDR 174
Asus P4T-CM, i850, soket 423,
FSB400, ATA100, 2RDRAM 63
Asus P4P800, i865, FSB800, 4DDR,
RAID, LAN, audio 158
Asus P4C800, i875, FSB800, 4DDR,
RAID, Audio, Gigabit LAN 210
Asus P4B533, i845E, FSB533,
ATA100, 3DDR, audio 84
Asus P4S533-MX, SiS651 FSB533,
ATA133, 2DDR+ 2SDR, audio,
VGA onboard 74
Asus P4S8X/L 1394, SiS648, FSB533,
3DDR, AGP8x, audio,
Serial ATA, 1394 131
Asus P4S8X-X , SiS648, FSB533,
ATA133, AGP8x, 3DDR, audio,
Gigabit LAN 89
Asus P4S533-X, SiS645dx, FSB533,
2DDR, audio, VGA onboard 70
Asus A7V8X/L 1394, KT400, ATA133,
AGP8x, FSB266, 3DDR, audio,
LAN, 1394 126
Asus A7V600, VIA KT600, 6 PCI,
3DDR, AGP8x 112
Asus A7N8X-X, NForce2, ATA133,
5 PCI, 3DDR, audio dolby, AGP8x 107
Asus A7V8X/L, VIA KT400, 6 PCI,
3DDR, SATA, ATA133 116

APLUS AP973, i845G, FSB 533MHz,
2DDR, Intel Graphic, ATX, AC97 76
APLUS AP981,i845GE, FSB 533MHz,
2DDR, ATX, AC’97 76
APLUS AP978 Ii845GL, ATX, 400FSB,
SOUND AC97, 2 SDRAM 54

APLUS AP971A+ VIA P4M266, ATX,
400FSB, SOUND AC97, 2 SDRAM,
S3 Savage4 4XAGP 50
APLUS AP976E2, VIA P4X266E,
FSB 533MHz, 2DDR,M- ATX, AC’97 50
APLUS AP976, VIAP4X266E,
FSB 400MHz, 2DDR, M-ATX, AC’97 48
APLUS AP972A2 VIA P4M266A, ATX,
533FSB, SOUND AC97, 2DDR 52
APLUS AP971A VIA  P4M266A, M.ATX,
533FSB, SOUND AC97, 2SDRAM 50
APLUS AP982 VIA KT400, ATX,
266FSB, SOUND AC97, 3DDR 62
APLUS AP975 VIA KT333, ATX,
266FSB, SOUND AC97, DDR333 60

MSI 645Combo, SiS 645, ATX,
FSB533, 2DIMM, ATA133, AGP4X, 6PCI 66
MSI 645E MAX-U, SiS645DX, ATX,
FSB533, 3DIMM, ATA133, AGP4X, 6PCI 73
MSI 651M COMBO-L, SiS 651, m-ATX,
FSB533, 2DIMM, ATA133, AGP4X 76
MSI 648 MAX, SiS 648x, ATX, FSB533,
3DIMM, ATA133, AGP8X, 6PCI 88
MSI 655 MAX FISR, SiS655, ATX,
FSB533, 4DIMM, ATA133, SATA, AGP8X 160
MSI 655 MAX LS, SiS655, ATX,
FSB533, 4DIMM, ATA133, SATA, AGP8X 110
MSI 645GLM, I845gl, Matx, FSB400,
2DIMM, ATA100, AGP4X, 3PCI 73
MSI 845PE Max, I845PE, ATX, FSB533,
2DIMM, ATA100, AGP4X, 6PCI 96
MSI 865PE Neo2, I865pe, ATX, FSB800,
2GBDDR, ATA133, AGP8X, 5PCI 130
MSI 845PE Max2-FISR, i845PE,ATX,
FSB533, 2GBDDR, ATA133, AGP4X 163
MSI K7N2-L, nForce2, ATX, FSB400,
3GB DDR, ATA133, AGP8X, 5PCI 115
K7N2G-L, nForce2, ATX, FSB333,
3GBDDR, ATA133, AGP8X, 5 PCI 130
KT4V, Via KT400, ATX, FSB333,
3GBDDR, ATA133, AGP8X, 6PCI 85
KT4V Ultra FISR, Via KT400, ATX,
FSB333, 3GBDDRR, ATA133, SATA 158

Gigabyte GA-7VKMP-P, VIA AKM266,
ATX, Soket A, ATA133, LAN 77
Gigabyte GA-7VA, VIA KT400, ATX,
Soket A, ATA133 89
Gigabyte GA-7N400-L1, nForce2 ultra,
ATX, Soket A, ATA133, Raid, Firewire 112
Gigabyte GA-7N400 Pro,
nForce2 ultra, ATX, Soket A 150
Gigabyte GA-7NNXP, nForce2 Ultra,
FSB400, 4DDR, 5 PCI 212
Gigabyte GA-7NNXPV, nForce2,
FSB333, 4DDR, 5PCI 242
Gigabyte GA-8SG800,  SiS 648,
ATX, FSB800, ATA133, AGP8X, 5PCI 82

Gigabyte GA-8ST800, SiS 645DX,
ATX, FSB800, ATA133 73
Gigabyte GA-SINXP 1392 DDR400,
SiS655, ATX, FSB533, ATA133 187
Gigabyte GA-8IE800, i845E,ATX,
FSB533, ATA100 87
Gigabyte GA-8IPE1000, i865PE,
ATX, FSB800, 4DDR, 5PCI 132
Gigabyte GA-8PE800Ultra+Raid,
i845PE, ATX, FSB800, ATA133 107
Gigabyte GA-8KNXP+Raid+ SATA,
i875P, ATX, FSB800, ATA133, AGP pro 242

Jetway J-603TCF, VIA PLE33,
soket 370, M-ATX, FSB100, ATA100 52
Jetway J-P4XFBU, VIA P4X266E,
soket 478, ATX, FSB533, ATA133 62
Jetwat J-615TCS, i845E, soket 370,
M-ATX, FSB133, ATA133 56
Jetway J-615TCF, I845e, M-ATX,
soket 370, FSB133, ATA133 81
Jetway J-830CH, SiS730SE, ATX,
soket 462, FSB266, ATA100 63
Jetway J-P4MDPT, VIA P4M266A,
M-ATX, soket 478, FSB533, ATA133 64
Jetway J-S446, SiS645/961, ATX,
soket 478, FSB400, ATA100 66
Jetway J-845EPRO+ RAID, i845E,
ATX, soket 478, FSB400/533, ATA133 90
Jetway J-845GLM, i845GL, M-ATX,
soket 478, FSB/400, ATA100 67

Iwill mP4G2S, i845GL, soket 478,
FSB400, LAN, DDR, 65
Iwill mP4G2, i845GV, soket 478,
FSB533, DDR, 68
Iwill P4G, i865PE, soket 478,
FSB800, LAN, DDR, serial ATA 69
Iwill P4HT2, i845PE, soket 478,
FSB 533, DDR, Audio, 80
Iwill P4E, i845PE, soket 478,
FSB 400/533, DDR, Audio, F1 series,
ATA133 & 100 76
Iwill DX400-SN, ii860, soket 603,
RDRAM, Dual Pro include casing, SCSI 999

Soyo K7V Dragon Ultra. VIA KT333,
6ch audio, AGP Pro, LAN10/100 145
Soyo K7V Dragon Lite. VIA KT333,
6ch audio, AGP 4x 85
Soyo P4X400, VIA P4X400, RAID,
6ch audio, AGP PRO, 6 PCI 155
Soyo P4I Fire Dragon, i845D,
DDR266, RAID, 6ch audio,
AGP PRO, 6 PCI 120
Soyo P4S Dragon Ultra, Sis645A2+961,
RAID, 6ch audio, AGP PRO, 6 PCI 140
Soyo P4IS2, i845, SDRAM, AC97,
6PCI, AGP4X 60

Abit IC7  i875P, FSB800MHz, 4 DDR,
AGP 8X, 5 PCI 145
Abit BE7, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 103
Abit BE7-G, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 127
Abit BE7-S, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 117
Abit BD7, i845D, FSB 533MHz,
2DDR, AGP 4X, 5 PCI 85
Abit BG7E, i845GE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 100
Abit IC7G i875/ICH5-R,
FSB 800MHz,
4 RIMM, AGP 8X, 5 PCI 194
Abit SR7-8X, SiS 648, FSB 533MHz,
3 DDR, AGP 8X, 5 PCI 95
Abit IS7, i865PE, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 135

Abit BD7E, i845DDX, FSB 533MHz,
2 DDR, AGP 8X,  5 PCI 75
Abit KV7, Via KT600/8235,
FSB 400MHz, 4 DDR, AGP 8x, 6 PCI 94
Abit NF7S, nVidia nForce2,
FSB 333MHz, 3 DDR, AGP 8X, 3 PCI 119
Abit KD7-A, Via KT400, FSB 333MHz,
4DDR, AGP 8X, 6 PCI 86
Abit NF7, nForce 2, FSB 333MHz,
3 DDR, AGP 8X, 3 PCI 97
Abit NF7-M, nForce 2, FSB 333MHz,
3DDR, AGP 8X, 3 PCI 113

MEMORI

Visipro 128MB (4 IC) PC 133 25
Visipro 128MB (8 IC) PC 133 33
Visipro 256MB (8 IC) PC-133 45
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KURSUS

DIKLAT KOMPUTER BERSERTIFIKAT Rp.100.000,-
1.Teknik Komputer+MoBo+Hardisk+Copy Bios
2. Network LAN + EDP + Admin + PC Kloning
3. Design Grafis 4. Private 5. Jarak jauh OK
GRATIS: CD-Modul-Sertifikat-Drink-Konsultasi

DIKLAT JARINGAN PC KLONING TANPA HARDISK
Komp lama bisa secepat P.4 - RAM 8 jadi 64
BELAJAR JARAK JAUH BISA - BERGARANSI
EXSYSCOM : 021.78889003 - 0815.997.1234
Jl.Raya Depok - Depan UI - Blk.Halte - Jakarta 12640

*   LINUX   *   LINUX   *   LINUX   *
CD LINUX (Distro,Games,Themes,Appl)

Privat Linux, Panduan Visual Linux,
PC/Komputer Linux - 0813 1065 0590

http://pclinux.2ya.com/

LAIN-LAIN

LENGKAP & MEMUASKAN
-Bubuk TONER MURNI dari pabrik
-OPC drum, blades, mag-roller, dll

-Larutan kimia untuk rekondisi
-Tinta literan INKJET MURNI

-Refill tool,resetter,accessories,dll
TERSEDIA BAGI PEMULA :

Paket bisnis isi ulang & Training
www.ecoprintlution.com

(031) 501 6088, 504 0150

WWW.RAJANOTEBOOK.COM
(021 )  5689393  -  08129283447
Pusa t  No tebook  Bekas  Berkua l i t as
Ready  s tok  Se t iap  Har i
Te rsed ia  IBM,  Tosh iba ,  De l l

IKLAN BARIS

HARDDISK

Maxtor 6L020L 20,4GB 7200rpm
ATA133, 2MB Cache, dual processor 53
Maxtor 6E030L 30GB 7200rpm ATA133,
2MB Cache, dual processor 55
Maxtor6E040L/6E040 40GB 7200rpm
ATA133, 2MB Cache, dual processor 64
Maxtor 6Y060L 60GB 7200rpm ATA133,
8MB Cache, dual processor 75
Maxtor 6Y080L 80GB 7200rpm ATA133,
8mb cache, dual processor 83
Maxtor 6Y120L, 120GB, 7200rpm,
8,5ms, uDMA133, 8MB cache 110
Maxtor 6Y160PO, 160GB, 7200rpm,
ATA 133/serial ATA, 8MB cache 180
Maxtor 6Y200PO, 200GB, 7200rpm,
ATA 133/serial ATA, 8MB cache 265
Maxtor 2F020J/L, 20GB 5400rpm,
ATA-133, 2MB cache 52
Maxtor 2F030J/L, 30GB, 5400rpm,
ATA-133, 2MB cache 54
Maxtor 2F040J/L, 40GB, 5400rpm,
ATA-133, 2MB cache 59
Maxtor 4R060J/4D060H,
60GB 5400rpm, ATA-133, 2MB cache 66
Maxtor 4D080H/4K080H, 80GB,
ATA-100, 2MB cache 80

Seagate Ux/Cuda 5400.1 20GB
ATA 100 51
Seagate Ux/Cuda 5400.1 40GB
ATA 100 59
Seagate Barracuda ATA IV /V 80GB
7200RPM ATA100 80
Seagate Barracuda 7200.7 40GB
ATA100 62
Seagate Barracuda 7200.7 80GB
ATA100 80
Seagate Barracuda 7200.7 120GB
ATA V/100 108
Seagate Barracuda 7200.7 Plus
160GB ATA V/100
(8MB cache) 165
Seagate Barracuda SATA 80GB,
ATA100 125
Seagate Barracuda SATA 120GB,
ATA100 143

SCSI HARD-DISK 7200RPM
& 10K RPM

Maxtor KU018L/J 18 GB ORCA,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 160
Maxtor 8B036L/J 36 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 185
Maxtor 8B073 73 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 455

Seagate Medalist Pro 4,5GB U2W,
M Pro, 9,5ms 54
Seagate Cheetah 10Krpm,
36,7GB U320, 36ES,
63,2ms, 4MB 190
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Pemenang Kuis Edisi 139/III/2002:
HADIAH SOUVENIR PCplus

1. Elizabeth Hendradi
Puren Gg. Lada No.6 Condongcatur
Depok, Sleman - Jogjakarta 55283

2. Dadiet
Jl. Bukit Permata V, Blok G-23 No.9
Permata Pamulang - Serpong 15310

3. Putut Bayuaji
Sendowo Blok F-139
Jogjakarta 55284

4. Wahyu Wardana
Kantor Pos
Tangerang 15000

5. Kurnain Afandi
Jl. Ki Hajar Dewantoro No.85 RT.001/01
Kec. Cipondoh - Tangerang 15147

KUIS "Plus, kamu udah pernah coba fasilitas koneksi instan
ke internet 0809 yang baru belom?", tanya Febi pada si
Ciplus. "Loh, memang ada? Bukannya cuma ada dari Telkomnet?",

pikir si Ciplus. Tolong dong si Ciplus, sebutkan operator baru yang membuka layanan
ini! Tuliskan jawaban tersebut di sehelai kartu pos dengan mencantumkan alamat yang
jelas dan sudah dibubuhi Kupon Kuis asli (di pojok kanan). Jangan menunda-nunda,
karena jawaban sudah harus masuk ke meja Redaksi PCplus paling lambat tanggal 06
Oktober 2003. PCplus akan memberikan 5 buah kaos PCplus untuk 5 orang pemenang
yang menjawab dengan benar dan beruntung! Buruan!!!

Para pemenang tidak dibebani pungutan atau biaya apapun atas undian ini
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Jawaban Kuis No. 139/III/2002: HP, Samsung, Canon, Brother, Lexmark

Seagate Cheetah 10Krpm, 73GB,
U320, 36ES, 63,2ms, 4MB 530
Seagate Cheetah 15Krpm 18,4GB,
U160, x 3,9ms, 8MB cache 219
Seagate Cheetah 15Krpm 36,7GB,
U320, x 3,9ms, 8MB cache 397

MAGNETIC OPTICAL DRIVE

Fujitsu MCC-3064ATAPI, 640MB,
ATAPI internal, 3,5" 230
Fujitsu MCE-3130AP, 1,3GB,
ATAPI internal, 3,5" 325
Fujitsu MSS-3064S, 640MB,
SCSI internal, 3,5" 250
Fujitsu Dynamo 640/EE,
external firewire 1394 350
Fujitsu Dynamo 1300, 1300MB,
external firewire 450

PROSESOR

Athlon Xp 1800+ (Thoroughbred A) 48
Athlon XP 1900+ (Palomino) 52
Athlon Xp 2000+ (Thoroughbred A) 55
Athlon Xp 2100+ (Thoroughbred A) 58
Athlon XP 2200+ ((Thoroughbred A) 63
AthlonXP 2400+ fan
(Thoroughbred A) 75
AthlonXP 2600+ (FSB333) + fan 90
AthlonXP 2800+ (Barton FSB333) 182
AthlonXP 3000+ (Barton FSB333) 266

Intel Pentium-4 1,6GHz)-423 126
Intel Pentium-4 1,8GHz, box, 478 138
Intel Pentium-4 3,06GHz, box), 478 Call
Intel Pentium-4 1,8AGHz,
512KB cache L2, 478 Call

Intel Pentium-4 2,0AGHz,
512KB cache L2, 478 Call
Intel Pentium-4 2,4BGHz,
512KB cache L2, FSB 533, 478 180
Intel Pentium-4 2,53GHz,
512KB cache L2, FSB 533, 478 Call
Intel Pentium-4 2,66GHz,
(512) FSB 533 211
Intel Pentium-4 2,8GHz
(512) FSB 533 280
Intel Pentium-4 2,4GHz,
512KB, FSB800, 478 196
Intel Pentium-4 3.0GHz,
512KB, FSB800, 478 Call
Intel Celeron 1,7GHz, c/128 64
Intel Celeron 1,8GHz, c/128 73
Intel Xeon Pentium-4 1,8GHz
512KB cache L2, MPGA 194
Intel Xeon Pentium-4 2,0AGHz,
512KB cache L2, MPGA 239
Intel Xeon Pentium-4 2,4AGHz,
512KB cache L2,FSB 533, MPGA 250
Intel Xeon Pentium-4 3,06
512KB cache L2, 533MHz 756

HEATSINK FAN

Coolermaster HAC-V81 (X-Dream) 21
Coolermaster HSC-V83 30
Coolermaster HHC-001 28
Coolermaster IHC-L71 32

Zalman CNPS-2005 15
Zalman CNPS-3000 18
Zalman CNPS3100 24
Zalman CNPS3100 G 35
Zalman CNPS5001 AL 19
Zalman CNPS 5001CU 26
Zalman CNPS-5700D-CU 32
Zalman CNPS 7000 CU 42
Zalman CNPS 7000 ALCU 35

VGA CARD

Asus V9280 SuperFast 128MB 221
Asus V9180 Magic/T 64MB
MX440-8X 84

Asus V9950 Ultra/ DLX,
GeForceFX 5900, AGP 8x, 128MB DDR 620
Asus V9520 Magic/T GeForceFX 5200,
128MB, AGP8X 95
Asus V9520 Home Theater-128MB 195
Asus V9280 SuperFast/TVD,
Ti4200-128MB 221
Asus V9950 Ultra/TVD,
GeForce FX5900, 256MB 583
Asus V9180 SE/T 64MB, MX-440-8X 55

Abit GF3 Ti 200, 64MB DDR 120
Abit GF2 T400, AGP 4X,
64MB SDRAM, TV-out, 64
Abit GF2 MX400, AGP 4X,
64MB SDRAM 59
Abit GF2 T200, AGP4X,
32MB SDRAM, TV-out 56
Abit GF2 MX200, AGP 4X,
32MB SDRAM 49

PixelView GF4 Ti4200-8x, GPU 250MHz,
RAM Clock 500MHz, 128MB DDR,
TV-out & Video In, DVI Port 130
PixelView GF4 MX440-8x, GPU 250MHz,
128MB DDR 5ns,  RAM Clock 400MHz,
TV out, video in, DVI 72
PixelView GF4 MX440-8x/64,
GPU 250, 64MB DDR 5ns, RAM clock
400MHz TV-out,in, DVI 53
PixelView GF4 MX440SE/DDR, GPU
250MHz, 64MB DDR 4ns, TV out 48
PixelView GeForce FX 5900
256MB DDR II, 2,2ns, GPU 400Mhz 475
PixelView FX5800, AGP8X, DDRII,
VIVO, DVI 355
PixelView FX5600H, AGP8X,
DDR 3,5ns, VIVO, DVI 195
PixelView FX5600, AGP8X,
128MB DDR, 3,6ns, DVI, VIVO 175
PixelView FX5200ut, AGP8X,
128MB DDR, TV OUT, DVI 88

MSI G4 MX440SES-T, AGP4X,
64MB SDR, TV OUT 58
MSI G4MX440 SET, AGP4X,
64MB SDR, TV OUT 64
MSI MX440-TD8X, AGP8X,
64MB DDR, DVI, TV OUT, DUAL CRT 91

MSI MX440-VTD8X, AGP 8X,
64MB DDR, DVI, VIDEO IN, TV OUT 110
MSI Ti4200-TD8X64, AGP8X,
64MB DDR, DVI 165
MSI TI4200-VTD8X, AGP8X,
128MB DDR, DVI, VIDEO IN, TV OUT 185
MSI FX5200-TDR128, 128MB DDR,
DVI, VIDEO IN, TV OUT 135
MSI FX5600-VTDR, AGP8X,
128MB DDR, DVI, VIDEO IN,
TV OUT 215

Elsa Gloria4 980XGL nVidia Quadro4
900XGL, 128MB DDR, 650MHz DVI-I 802
Elsa Gloria4 750XGL nVidia Quadro4
750XGL, 128MB DDR, 650MHz DVI-I 475
Elsa Synergy4, nVidia Quadro4
550XGL, 128MB DDR, 500MHz, DVI-I 301
Elsa Gladiac 518, nVidia GF4 MX440,
64MB DDRTV 83
Elsa Gladiac 517SEP nVidia GF4
MX440, 64MB DDR, video out, DVD 59
Elsa Gladiac 511, nVidia GF2 mx00,
64MB DDRAM, 47

Sapphire Radeon 9700 Atlantis,
128MB DDR, DVI VO 276
Sapphire Radeon 9500 Atlantis,
128MB DDR,DVI TVO 170
Sapphire Radeon 9000 Pro,
128MB DDR, VIVO (PAL) 106
Sapphire Radeon 7000,SDR,
TV-OUT(PAL),128MB 276
Sapphire Radeon 9800Pro
128MB DDR, DVI, AGP8X 470

DigiColor TNT2/M64 nVIDIA,
32 MB SDR, CRT 24
DigiColor GF2 MX400 nVidia,
64 MB SDR, CRT 34
DigiColor GF4 MX440se nVidia LMA II,
64 MB 128-bit DDR 350 Mhz,
CRT+TV out 49
DigiColor GeForce FX5200,
nVidia LMA II, 64 MB 128-bit,
CRT, TV out                               80
DigiColor GeForce FX5600
nVidia LMA II, 128 MB 128-bit DDR,
Tv- out 165

DigiColor GeForce FX5600
nVidia LMA II 256MB 128-bit DDR,
TV-out                                     198

Impact mx440 64mb DDR,
AGP8X tv out 47
Impact Ti4200 64mb, tv out,dvi 130
Impact Ti4200 128mb, AGP 8X,
128ddr tv out,dvi,vivo 155
Impact GeForceFX5200 128MB DDR,
tv out,dvi,vivo, AGP8X 80

Gigabyte R9700 Pro, radeon 9700pro,
TV-out S/RCA, DVI port DVI-I 342
Gigabyte R9500 , radeon 9500,
TV-out S/RCA, DVI port DVI-I 167
Gigabyte R9000 Pro,
ATI Radeon 9000Pro, 64MB DDR,
TV-out, S-Video, Twin View, DVI Port 97
Gigabyte R9000, ATI Radeon 9000,
64MB,  DDR, TV-out 73
Gigabyte R9600 Pro, ATI Radeon
9600 Pro, 128MB DDR 212
Gigabyte R-9800 Pro, Radeon
9800Pro, 380MHz/ 680MHz, 256MB 547
Gigabyte R-9200 (VIVO),
Radeon 9200, 250MHz/ 400MHz,
128MB 117

Gigacube Radeon 9800 Pro 256MB 550
Gigacube Radeon 9800 Pro 128MB 440
Gigacube Radeon 9700 Pro 128MB 340
Gigacube Radeon 9600 Pro 128MB 185
Gigacube Radeon 9600  128MB 160
Gigacube Radeon 9200  128MB 98
Gigacube Radeon 9100  128MB 85
Gigacube Radeon 9000  64MB 60

VIDEO EDITING CARD

Matrox RTX.10 550
Matrox RTX.100 960

Pinnacle Studio PCTV USB 200
Pinnacle Studio DC10 plus ver 8.0 165
Pinnacle Studio Deluxe ver 8.0 285
Pinnacle MP20 VCD/SVCD/DVD 195
Pinnacle DV500DVD 470
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